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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle TeleService User Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle TeleService

If you have never used Oracle TeleService, Oracle suggests you attend one or 
more of the Oracle TeleService training classes available through Oracle 
University.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to use Oracle TeleService. 
Chapters 2 through 7 describe procedures of interest primarily to Tier-1 call center 
agents. Chapters 9 through 13 cover those primarily of interest to Tier-2 agents.

■ Chapter 1 provides a brief overview of the application and the functionality 
provided through key integrations with other Oracle E-Business Suite 
application modules.

■ Chapter 2 details the user procedures required to search and display customer 
and contact records.
vii



■ Chapter 3 describes procedures for creating, updating, and managing customer 
records. This includes procedures for creating and assigning tasks.

■ Chapter 4 describes procedures for creating, updating, and managing customer 
contact records.

■ Chapter 5 describes how Tier-1 agents can resolve customer problems by 
searching the knowledge base, checking entitlements, and how they can quickly 
create service requests.

■ Chapter 6 describes how agents can manage the status of customers that have 
been flagged as critical by the application.

■ Chapter 7 describes how agents can view and modify relationship plans for a 
particular customer. Relationship plans monitor customer statistics, such as the 
number of escalated service requests, and alert agents with messages or scripts 
whenever a customer has a reached a predetermined level.

■ Chapter 8 describes the different ways agents communicate with customers via 
the telephone, e-mail, and Web.

■ Chapter 9 describes how Tier-2 agents can use service requests to manage the 
resolution of customer problems from the time a customer contacts the 
organization through resolution.

■ Chapter 10 describes useful utilities for service request management, including 
procedures for escalating and auditing service requests.

■ Chapter 11 describes how agents can charge for services, review and submit 
field service charges, and create different kinds of returns.

■ Appendix A describes a few basic procedures for manipulating data in dynamic 
tables and using Oracle Forms folder tools.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
viii



visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle TeleService.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on OracleMetaLink.

Related Documentation
Oracle TeleService relies on other Oracle Applications products and modules for 
much of its functionality. Therefore, you must refer to other product documentation 
to effectively use Oracle TeleService.

You can read these documents online by choosing Library from the expandable 
menu on your HTML help window, by reading from the Oracle Applications 
Document Library CD included in your media pack, or by using a Web browser 
with a URL that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle TeleService (and 
any other Oracle Applications products). This guide also includes information on 
ix



setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing, “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle TeleService Implementation Guide
Many of the topics in this guide can be used for application administration on an 
ongoing basis. These include instructions on how to set up customer profiles, the 
dashboard, relationship plans, and the automatic assignment of service requests.

Oracle Common Application Components User’s Guide
This guide explains how to use the Assignment Manager, Resource Manager, Task 
Manager, Notes, Escalation Management, and other common application 
components.

Oracle Universal Work Queue User Guide
This guide explains how agents can use the work queue to manage their work and 
handle customer calls using the icWork Controller and Softphone.

Oracle Knowledge Management User Guide
This guide explains the different ways agents can search the knowledge base to 
resolve customer problems and how they can author new knowledge base 
solutions.

Oracle Contracts Core Concepts and Procedures
This guide explains how to author and administer contracts. This guide is a 
prerequisite for understanding Oracle Service Contracts.

Oracle Service Contracts Concepts and Procedures
This guide explains how to understand and manage service contracts.

Oracle Install Base Concepts and Procedures
This guide describes how to use the installed base for tracking customer products 
and record product usage using counters.
x



Oracle Enterprise Install Base Concepts and Procedures
This guide describes how to use the installed base for tracking your organization’s 
internal assets.

Oracle iSupport User Guide
This guide is useful for agents to understand how customers interact with the 
service organization via a self-service Web-portal.

Oracle Field Service User Guide
This guide can help Oracle TeleService agents understand how field service agents 
create debriefs which can be reviewed in the Charges module.

Oracle Order Management Users Guide
This guide explains how to book orders that have been submitted through Oracle 
TeleService’s Charges module. Booking is required for an order to be processed.

Oracle Scheduler User Guide
This guide describes how to use the Oracle Advanced Scheduler to schedule 
field-service tasks.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle TeleService 
and reach full productivity quickly. You have a choice of educational environments. 
You can attend courses offered by Oracle University at any one of our many 
Education Centers, you can arrange for our trainers to teach at your facility, or you 
can use Oracle Learning Network (OLN), Oracle University's online education 
utility. In addition, Oracle training professionals can tailor standard courses or 
develop custom courses to meet your needs. For example, you may want to use 
your organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle TeleService working for 
you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
xi



business area, managing an Oracle9i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with Web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use OracleMetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
xii



track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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                                                            About Oracle TeleSe
1

About Oracle TeleService

This section provides an overview of Oracle TeleService, its components, and key 
integrations. It covers:

■ About Oracle TeleService on page 1-1

■ Key Integrations on page 1-6

1.1 About Oracle TeleService
Oracle TeleService makes it possible for service organizations to lower support costs 
and deliver superior personalized service at the same time. It does so by automating 
not just the call center but the whole problem resolution process from the time a 
customer calls in, sends an e-mail, or enters a service request on the Web. Agents 
can use Oracle TeleService to update customer records, validate product ownership 
and contract coverage, provide proactive and personalized customer service, and 
resolve many problems during the initial contact using a knowledge base.

Oracle TeleService is composed of the following modules:

■ Customer Care

■ Service Request

■ Charges

1.1.1 Customer Information Management Through Customer Care
The Customer Care module is designed to help Tier-1 customer service agents 
manage customer information and quickly enter service requests.
rvice 1-1



About Oracle TeleService
Agents can use it to identify customers, enter and modify customer information, 
view the history of the organization’s past interactions with the customer, and 
manage the customer relationship.

Because Oracle TeleService uses the same data repository for customer information 
as the rest of the Oracle E-Business Suite, any notes or changes agents make to 
customer data are automatically reflected in all other applications.

The module makes it possible for agents to:

■ Manage customer information using the Contact Center

■ View key information about a customer

■ Receive automatic alerts about customer status via Relationship Plans

■ Manage customer criticality 

■ Resolve customer problems by searching the organization’s knowledge base

■ Quickly create service requests

■ Handle customer inquiries through multiple media

1.1.1.1 Managing Customer Information Using the Contact Center
Customer Care’s Contact Center window provides the central place for Tier-1 
agents to view and update customer information that has been collected by the 
entire Oracle E-Business Suite of applications.

Agents can access not only addresses, contacts, and information about the 
relationships the customer has with other customers, but also a record of all past 
interactions your organization has had with that customer, including e-mails, phone 
calls, and site visits. Agents can read notes posted by the entire organization about a 
customer and know which products the customer has purchased, their service 
history, and any contractual agreements that apply. 

Putting all the information about customers at agents’ fingertips not only speeds up 
issue resolution but also eliminates the need for customers to repeat the same 
information over and over again as their problem gets passed through your 
organization.

The flexible customer model used by the Oracle E-business Suite captures 
information about the whole range of business and personal relationships, making 
it possible for agents to know that a caller belongs to a subsidiary of a major 
customer and so is entitled to the same level of service and the same discounts as 
the parent company, for example. Or that the person on the line is the brother of the 
CEO of an important customer.
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1.1.1.2 Viewing Key Information About a Customer
The Dashboard tab of the Contact Center window provides agents with a 
color-coded graphical display of key customer information so they know the 
customer they are helping. 

What is the level of customer satisfaction, high or low? Is the customer loyal or 
critical? The credit rating good or bad?

At a glance agents can see how many escalated service requests a customer has, for 
example, how much they purchased, and if they are behind on their payments. 

The summaries are hyperlinked to the underlying information, so agents can 
display the details of the individual escalated service requests or purchases with a 
couple of clicks of the mouse.

The application administrator can configure different summaries of key customer 
information, called Customer Profiles, for different roles in your organization to 
give everyone an overview of the information that is most critical to them. 
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1.1.1.3  Receiving Automatic Alerts About Customer Status via Relationship 
Plans
Your organization does not have to rely on agents to view the Dashboard and make 
the judgment calls on what information about a customer is important. The 
organization can set up business rules, called Relationship Plans, which 
automatically alert agents whenever the customer meets certain conditions. That 
way agents know they are talking to customer has a contract about to expire, a 
product needs upgrading, or when the customer would be better off purchasing a 
new product entirely because the old one no longer meets their needs. Relationship 
Plans, which monitor customer information behind the scenes, can even pop up a 
script so an agent knows what to say when talking with the customer.

1.1.1.4 Managing Customer Criticality
Your service organization can define rules that automatically flag a customer as 
critical. Agents can over-ride the criticality designation, escalate the problem, or 
initiate proper action to resolve it.

1.1.1.5 Resolving Customer Problems by Searching the Organization’s 
Knowledge Base
Agents can resolve many customer requests by searching the organization’s 
knowledge base. This can include structured solutions, FAQs, and documents on 
internal Web sites.

1.1.1.6 Quickly Creating Service Requests
For requests that cannot be resolved through knowledge base searches, agents can 
quickly create simple service requests using the same window where they verify 
customer information. Or they can enter a service request for follow-up by Tier-2 
agents.   

1.1.1.7 Handling Customer Inquiries Through Multiple Media
Oracle TeleService makes it possible for agents to handle customer inquiries via 
phone, e-mail, and the Web. 

1.1.2 Service Request Management
The Service Request module (in previous releases known as Oracle Support) is 
designed to permit Tier-2 agents create and manage customer or employee requests 
for service from the time the customer contacts the organization or logs a service 
request on the Web until the problem is resolved. 
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All operations can be performed in or initiated from the Service Request window. 

Organizations can define different business processes for handling different request 
types such as complaints, product breakdowns, and accounting questions. 

The module makes it possible for agents to: 

■ Search the organization’s knowledge base and suggest solutions

■ Manually or automatically assign the service request to the group or person 
most appropriate to handle it

■ Flag service requests as duplicates of others

■ Make related documents available for other agents working on the service 
request at the click of the mouse

■ Check contracts, apply entitlements, and have the application automatically 
enter resolution times to ensure your organization meets its contractual 
obligations

■ Create, assign, and schedule tasks required to resolve the problem
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■ Keep customer contacts and other member of the team informed through 
automatic notifications

■ E-mail customers about the service request or communicate with them via their 
Oracle iSupport self-service Web portal

1.1.3 Managing Returns and Service Billing Through Charges
Using the Charges module, which occupies a tab of the Service Request window, 
agents can bill customers for their services, review and submit bills for labor and 
material costs incurred in the field, and create product returns for repair, loan, or 
replacement. The application automatically applies discounts and contractual terms 
and the charges are ready for processing by Oracle Order Management.

Here is the Charges tab on the Service Request window:

1.2 Key Integrations 
What level of functionality agents receive from the Oracle TeleService application 
depends on implementation of different components of the Oracle E-Business Suite. 
This section explains the functionality added by:

■ Common application components

■ Service suite foundation

■ Key integrated applications
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1.2.0.1 Common Application Components 
Oracle TeleService makes use of common Oracle E-Business Suite application 
modules. Key functionality is delivered by:

■ Oracle Universal Work Queue (UWQ): This is where agents obtain their work 
assignments, including service requests, tasks, and Web callbacks. The UWQ 
also provides the interface for handling calls. Agents receive inbound calls via 
their icWork Controller (Softphone) by logging into a work queue. 

■ Assignment Manager: Provides agents with the ability to assign resources to a 
task or a service request based on service territories, qualification, availability, 
and geographic location.

■ Resource Manager: This module stores the skill levels of your organization’s 
field technicians and agents. Agents use this information to assign the right 
technician for the job either manually or automatically.

■ Notes: This module makes it possible for all employees of the company to share 
notes on customer and customer issues and to communicate with customers 
through the Oracle iSupport Web portal.

■ Task Manager: The task manager makes it possible to assign, reassign, and 
prioritize tasks needed to deliver service to the customer. Assigned tasks appear 
as work items in the assignee work queues. Tasks can also be synchronized with 
Microsoft Outlook and Palm devices through functionality provided by this 
module.

■ Territory Manager: Your organization can use the territory manager to set up 
service territories that the service suite uses to automatically assign tasks to 
employees based on their skill, geographical location, and other criteria. Your 
organizations runs concurrent programs to make the work assignments 
themselves. 

■ Escalation Management and Business Rule Monitor: Using Escalation 
Management and the Business Rule Monitor, agents can re-prioritize, reassign, 
and monitor a situation to a satisfactory completion. 

■ Oracle One to One Fulfillment: This module makes it possible for you to e-mail 
or fax copies of service requests to customers.

1.2.1 Service Suite Foundation 
Three applications provide key functionality for Oracle TeleService and form the 
foundation for all service suite applications:
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■ Oracle Knowledge Management

■ Oracle Install Base

■ Oracle Enterprise Install Base 

Oracle Knowledge Management
The integration with Oracle Knowledge Management makes it possible for agents 
using Oracle TeleService to search for solutions to customer problems. 

Oracle bundles knowledge management tools with all service suite applications. 
The tools make it possible for your organization to build and maintain an 
enterprise-wide repository of knowledge ranging from office procedures to 
technical troubleshooting solutions. Your organization can develop solution 
templates in a wide variety of formats from simple questions and answers to 
product bulletins, FAQs, troubleshooting guides, and product documentation. The 
organization can make different knowledge management solutions available to 
different audiences: to call center agents, field engineers, and customers logging in 
on the Web portal.   

Oracle Install Base and Oracle Enterprise Install Base
Integration with the installed base applications makes it possible for Oracle 
TeleService agents to log service requests against items owned by either customers 
or employees.

Oracle Enterprise Install base tracks the internal assets of an organization.Oracle 
Install Base tracks customer assets. Both products center on a repository of product 
data recording the location, configuration, status, ownership, account(s), change 
history, and party relationship(s) for products, software licenses, and other assets. 

The repository tracks an asset from the time it is received in inventory, in WIP 
(Work in Process), in projects, at the customer site, or in for repair. Cradle-to-grave 
tracking follows the asset as it passes through the various divisions of a company 
(inventory, purchasing, orders, shipping, and service). 

An instance record describes the set of parts constituting a specific physical unit. 
Knowing the exact composition of the product to be serviced enables the service 
provider to ensure that the needed parts are available before dispatching an 
engineer; makes it unnecessary for the support agent to ask customers questions 
about the product's makeup; and makes it possible for an in-house repair center to 
have a customer ship back to the service center only those parts needed for the 
repair.
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The installed base instance record is the foundation for after-market service, 
including regularly scheduled maintenance tasks and unplanned maintenance, and 
it tracks contract and warranty entitlements for the asset it represents. The 
organization can track the usage of a product or service via the Counters module. 
For example, a copying machine service company can use counters to record the 
number of copies made by a particular machine and bill customers based on usage. 
Usage data can trigger service business processes such as the scheduling of 
preventive maintenance or overhauls; the renegotiating of service, rental, and 
leasing contracts; the reordering or shipping parts; and for calculating product 
reliability.

1.2.2 Key Integrations with Other E-Business Suite Applications
Because Oracle TeleService is fully integrated with the Oracle E-Business Suite each 
additional application you implement provides additional functionality for your 
service organization. To get the most out of Oracle TeleService your organization 
must implement at least the applications listed in this section.

Oracle iSupport
Self-service Web portals built with Oracle iSupport make it possible for customers 
and employees to log and monitor their service requests. Oracle TeleService agents 
can publish service requests for the customers to view, suggest knowledge base 
solutions, and communicate with customers through notes.

Oracle iSupport provides a secure self-service Web portal your customers can use to 
get immediate help 24 hours a day, seven days a week from anywhere in the world. 
Your customers can come online to view the status of their orders with your 
company, review service agreements, update their contact information, and more. 
Online they can find answers to many of their questions on their own by searching 
a knowledge base or by participating in online forums. If they need assistance, 
customers create service requests and monitor their resolution. Integration with 
Oracle TeleService makes it possible for an agent to step in and help any customers 
that cannot resolve problems on their own. Your organization can extend the 
customer support benefits to your employees by deploying Oracle iSupport as a 
self-service help desk.

Oracle Field Service
Oracle TeleService agents can review and submit for billing the charges entered by 
field service technicians using Oracle Field Service. 
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Oracle Field Service automates the process of dispatching field technicians. The 
application's Dispatch Center provides a central point from which dispatchers can 
monitor and control the prioritizing, scheduling, and dispatching of field activities. 
It combines a graphical overview of planned activities for engineers with a calendar 
or Gantt view, and it uses maps to show engineers' current locations. A dispatcher 
can change a resource assignment directly on the Gantt chart simply by dragging 
and dropping a task symbol from one engineer to another. Dispatchers also can 
access statistical overviews of their organizations in order to assess representatives' 
performances.

An escalation process alerts dispatchers when an agreed response-time threshold is 
exceeded. Automated processes guided by customer-specific escalations and 
tracking help to ensure progress on each task, allowing call takers, dispatchers, and 
managers to focus on exceptions.

Building on core functionality found in Oracle Inventory, the application's spares 
management functionality provides the additional logistics and planning features 
required to effectively manage a field service parts inventory. Using the spares 
management, a field service organization can automate and streamline all aspects of 
managing spare parts inventory in the field including ordering, tracking, 
forecasting and creating reports to name just a few. Oracle Inventory is the only 
prerequisite product specifically required for implementation of spares 
management. Oracle Inventory provides the core foundation functionality for the 
item master, stocking locations, inventory balance tracking, and so on. 

Oracle Service Contracts
Oracle Service Contracts automatically applies the terms of a contract to the service 
request agents are working on and ensures that your service organization meet its 
contractual obligations. 

This application makes it possible for agents and technicians providing customer 
support, field service, or in-house repair service, to review both warranty and 
service contract details with a customer. Contract details available may include 
coverage schedules, response and resolution times by severity, preferred resources, 
billing rates for labor, relevant discount provisions, and expenses for each type of 
service on offer. 

Oracle Service Contracts not only makes the provisions available for review, but it 
supports the billing process by pushing, labor, materials, and expenses incurred to 
TeleService's Charges module, which consolidates the information into a single 
charge with multiple lines. Before the customer is charged, Service Contracts guides 
the application of customer entitlements to the charges so that discounts and labor 
rates are applied accurately in calculating the final charge.
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Oracle Advanced Inbound
It is this application that makes it possible for Oracle TeleService to assign a call to 
an agent most qualified and available to handle the call and to display information 
about a caller.

Oracle Advanced Inbound is designed to channel a customer call to the right 
call-center agent simultaneously reducing expenses and increasing customer 
satisfaction.

Oracle Advanced Inbound offers Web integration, connectivity to the most popular 
Integrated Voice Response (IVR) equipment, intelligent routing, screen pops, virtual 
interaction center, and VoIP support. Oracle Advanced Inbound's easy-to-use rules 
engine weighs agent skills as well as business rules and data to make complex 
routing decisions. Oracle Advanced Inbound provides Oracle TeleSales, Oracle 
TeleService, and Oracle E-Commerce and Oracle Interaction Center applications 
with screen-pop support that spans all channels-telephony/IVR, e-mail (in Oracle 
eMail Center), and the Web (in Oracle iStore and Oracle iSupport).

Oracle eMail Center
The Oracle eMail Center provides Oracle TeleService with the ability to send e-mail 
to customers. Templates that automatically fill in relevant information about the 
service request are provided by the Oracle TeleService application administrator.

Oracle eMail Center helps businesses manage increasing volumes of e-mail through 
the use of automated analyses and automatic responses to standard or routine 
e-mail. Oracle eMail Center offers the ability to analyze the body of the e-mail and 
its attachments and provide suggested responses for interaction center agents. It 
matches the general themes of e-mails against a knowledge base of appropriately 
managed answers (either from previously used responses or responses that are 
continually updated). The best suggested response could be used to automatically 
respond to the sender, thereby eliminating the need for agent contact. When an 
automated response is not appropriate, Oracle eMail Center coupled with Oracle 
TeleService can route the e-mail to an agent and display a screen pop with customer 
information. The user interface for Oracle eMail Center contains suggested 
responses that an e-mail agent can use to respond to the issues in the original 
e-mail.

Oracle Scripting
Oracle Scripting makes it possible for your organization to author scripts that can 
guide agents through customer interactions. 
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Oracle Scripting provides call guides, or scripts, for interaction center agents. When 
agents use Oracle TeleService, scripts guide them through the call flow needed as 
they interact with the customer. A script leads an agent through appropriate sales 
and/or troubleshooting queries, prompts for cross-sell and up-sell opportunities at 
the right time within the context of the call, and provides detailed information to 
help the agent resolve customer questions. Scripts also help reduce agent-training 
time in the high-turnover interaction center industry, because they provide simple 
navigation through complex customer interactions.

Oracle Scripting also includes iSurvey, a module designed to support the collection 
of data through Web-based surveys.

Oracle Advanced Scheduler
The Oracle Advanced Scheduler, an optional module for Oracle Field Service, 
makes it possible for agents to schedule field service tasks directly from the Oracle 
TeleService user interface.

Used in the "Intelligent" mode, the Oracle Advanced Scheduler weighs a number of 
variables when assigning a task to a field service engineer. These include costs, 
travel time, and availability of spare parts. 

This module also makes it possible for you to provide the customer with a time 
frame within which the field service technician is to arrive at the customer site. This 
assignment mode is called "Window to Promise." It further provides automatic 
background assignment of one or more tasks to engineers, obviating dispatcher 
involvement. Oracle Advanced Scheduler is invaluable when it comes to assigning 
very complex tasks in large volumes, arranging highly optimized and cost-effective 
schedules. 

Oracle Depot Repair
Oracle Depot Repair automates and streamlines the in-house repair process 
providing enterprises with the flexibility to manage multiple types of returns so 
that a customer does not lose valuable work time while an item is being repaired. It 
allows repair centers to manage the entire life cycle of repairs including the creation 
and tracking of repair orders, generation of Return Material Authorizations 
(RMAs), assignment of repair work orders to the appropriate technicians, 
capturing/processing the repair activity, shipping repaired/refurbished products to 
their respective destinations, and then invoicing the customer for the work 
delivered based on contractual entitlements.
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Oracle Order Management
Using Oracle Order Management, an agent can book the order placed through 
Oracle TeleService and bill the customer for services.

Oracle Order Management provides a complete order to cash solution and enables 
global order promising integrated to shipment execution.

Oracle Quality
Your organization can set up collection plans in Oracle Quality that capture relevant 
data as service requests are logged by customer support personnel. Collection plans 
may capture data related to a customer, product, product line, etc. Your 
organization can then analyze this data in Oracle Quality to answer questions about 
common problems faced by users, or products which cause the most problems. The 
captured data can be exported to perform detailed statistical analyses.
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Searching and Displaying Customer

Information

If you wish to update customer information, you must first display the customer 
record in the Contact Center. You must also perform a search before you create a 
new customer record to ensure that you are not creating a duplicate.

This chapter explains how to search for and display information about your 
customers. It covers:

■ Displaying Customer and Contact Information  on page 2-1

■ Displaying Customer Information From a Service Request on page 2-2

■ Displaying Customers Automatically Via Telephony Integration on page 2-2

■ Displaying Customers and Contacts Using Lists Of Values on page 2-3

■ Searching for Customers and Contacts Using the Search Window on page 2-4

■ Searching for Customers Using Multiple Search Criteria on page 2-4

■ Searching for Customers Using Ranges of Values and Other Complex Criteria 
on page 2-6

■ Searching for Customers Using a Product Serial Number and Other Service 
Keys on page 2-8

■ Setting Defaults for Searches in the Customer Search Window on page 2-9

2.1  Displaying Customer and Contact Information
This topic covers the multiple ways of displaying customer and contact information 
in the Contact Center. Which method you use depends on where you are in the 
application and what information you know about the customer. If you know 
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information that uniquely identifies the customer, such as the customer number, a 
phone number, or an account number, then you can display the customer record 
with one entry. At other times you must use the Customer Search window. If you 
are viewing a customer’s service request in the Service Request window, then 
displaying customer information is as simple as clicking the Customer button. 

This topic covers:

■ Displaying Customer Information From a Service Request on page 2-2

■ Displaying Customers Automatically Via Telephony Integration on page 2-2

■ Displaying Customers and Contacts Using Lists Of Values on page 2-3

■ Searching for Customers and Contacts Using the Search Window on page 2-4

2.1.1 Displaying Customer Information From a Service Request
If you are viewing a service request, you can display customer information in the 
Contact Center by clicking the Customer button at the top right hand corner of the 
Service Request window.

2.1.2 Displaying Customers Automatically Via Inbound Telephony 
If your implementation of Oracle TeleService is telephony enabled and you receive a 
call from a customer, then the application automatically displays customer and 
contact information if the available caller information identifies a unique record. 

If the application finds multiple matches based on the information the caller has 
provided, then you must select the appropriate customer or contact you wish to 
view from a list.

If your implementation is not telephony enabled or the application does not find a 
match automatically, then you must search for possible matching customer records 
by using the Customer Search Window or by using the Lists of Values (LOVs) in the 
Contact Center. 
   

Note: You cannot use the standard Oracle Forms query by 
example method for customer searches in this application.
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2.1.3 Displaying Customers and Contacts Using the Lists of Values
Use the Lists of Values (LOVs) in the Contact Center to display customers and 
contacts if you know information that uniquely identifies the customer, such as the 
customer number, account number, URL, or phone number. You can also use the 
lists of values to search for a customer record if your search is not likely to yield a 
large number of results. 

If the identifying information you know about the customer is related to a service 
request or a product the customer has purchased, such as a serial number or 
contract number, then use the Service Request window to display the customer 
instead.

To display a customer and contact using lists of values:
1. Navigate to the Contact Center.

2. If you know information that uniquely identifies the customer, such as the 
customer number, account number, or phone number, then you can display the 
customer record by entering that information in the Contact Center header 
using a list of values. 

3. If you do not know information that uniquely identifies the customer, then:

a. In the Customer Region, select the type of customer you wish to display 
from the Type drop-down list:

* Organization: If your customer is a business or an organization.

* Person: If your customer is an individual consumer

Note 2: The application administrator can set defaults for the 
Customer Search Window to speed up searches. See Setting 
Defaults for Searches in the Customer Search Window  on page 2-9 
for more information.

Note: If you select a phone number and customer information is 
not populated automatically, this means that the phone number is 
used by multiple customers. 
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b. If you know the country where the customer’s identifying address is 
located, then enter it using the Country LOV. This restricts your search to 
customers in that country.

c.  Use the Name LOV to enter the organization’s or person’s name.

4. If you wish to display contact information, then use the lists of values in the 
Contact region to enter the contact. 

2.2 Searching for Customers and Contacts Using the Customer Search 
Window

You can use the Customer Search Window, available by clicking Find (the flashlight 
icon) in the toolbar, to search for customer information using multiple search 
criteria. You can search in three different ways: 

■ Using a combination of customer attributes including name, phone, and 
address (Basic tab)

Any search criteria you enter on the Basic tab are used together in combination 
in your search (the logical AND operator). This means that if you search for a 
customer using the First Name and Address fields, for example, your search 
returns only those customers who have both that first name and that same 
address.

■ Using a combination of customer attributes combined in logical expressions 
(Advanced tab)

This type of search lets you find customers within a certain range of values or 
with multiple logical operators. You can search for customers within a range of 
postal codes, for example, or for customers with a particular last name or a 
particular address.

■ Using a unique customer identifier, called a service key, such as the serial 
number of the product the customer is calling about. (Service Key tab)

2.2.1 Searching for Customers Using Multiple Search Criteria
Use this procedure to search for customers and contacts using a combination of 
customer attributes including name, phone, and address.

To search for customers using multiple search criteria:
1. Click Find (the flashlight icon) in the toolbar. 
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The Customer Search window appears. 

2. Select the Basic tab.

3. Enter one or more customer attributes you wish to search for. Use the (%) 
percent sign to indicate any missing characters.

■ If you are searching for a business or an organization by name, enter a full 
or partial name in the Organization field.

■ If you are searching for a customer who is a consumer, then make entries in 
the First Name and Last Name fields in the Customer region.

■ If you are searching for a contact at an organization, then enter the contact’s 
name in the Contact region and, optionally, the name of the organization in 
the Organization field.
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4. Click Search.

5. If only one customer fits your search criteria, the customer information is 
automatically displayed in the Contact Center. 

6. If multiple customers are found, then:

a. The results of your search appear in the Results region. 

b. If you find the customer you are looking for among the results, then select 
the record and click OK to display the customer information in the Contact 
Center where you can make your modifications. 

c. If the search does not return the correct result, then you can either clear the 
search window by clicking Clear, or create a new customer record by 
clicking Create.

2.2.2 Searching for Customers Using Ranges of Values and Other Complex Criteria
Use this procedure to search for customers using a range of values or complex 
logical expressions.

To search for customers using complex search criteria:
1. Click Find (the flashlight icon) in the toolbar. 

The Customer Search window appears. 

1. Select the Advanced tab.

Note: Searching for a person using the Contact and Customer 
regions yields different results. Entering the name in the Customer 
region, finds only that individual’s personal record as a consumer 
(party of Person.) Searching for that same person using the Contact 
region, finds the same personal record and also all of the 
relationships that individual has with any organizations or 
individuals in the database. 

Note: You can sort the results, if necessary, by clicking on different 
column headings. For other ways of manipulating results see 
Manipulating Data in Dynamic Tables.
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2. Enter one or more logical expressions for your search. For each expression

a. Select an open parenthesis from the first drop-down list. 

b. Select the field you wish to search from the Item drop-down list.

c. Type in or select the value using the Value LOV.

d. Select the closed parenthesis.

e. Select the logical operator.

For example, if you wish to search for all customers within a range of postal 
codes (10028 and 10035), then your expression will look like this:

(Postal Code > 10028) AND
(Postal Code < 1035)

I

3. Click Search.

4. If only one customer fits your search criteria, the customer information is 
automatically displayed in the Contact Center. 

5. If multiple customers are found, then:

a. The results of your search appear in the Results region. 

b. If you find the customer you are looking for among the results, then select 
the record and click OK to display the customer information in the Contact 
Center where you can make your modifications. 

c. If the search does not return the correct result, then you can either clear the 
search window by clicking Clear, or create a new customer record by 
clicking Create.

Note: If you are entering just one search criterion, you can omit 
the parentheses and logical operator.

Note: You can sort the results, if necessary, by clicking on different 
column headings. For other ways of manipulating results see 
Manipulating Data in Your Work Queue and Other Dynamic Tables 
on page A-1.
                                                                    Searching and Displaying Customer Information 2-7



Searching for Customers and Contacts Using the Customer Search Window
2.2.3 Searching for Customers Using Unique Identifiers or Service Keys
Use this procedure to search for customers using a unique identifier such as a 
customer number or a product serial number.

To search for customers using unique identifiers or service keys:
1. Click Find (the flashlight icon) in the toolbar. 

The Customer Search window appears. 

2. Select the Service Key tab.

3. Select the search criteria from the Key drop-down list.

4. Enter the value you wish to search for.

5. Click Search.

6. If only one customer fits your search criteria, the customer information is 
automatically displayed in the Contact Center. 

7. If multiple customers are found, then the results of your search appear in the 
Results region. 

a.  Search for the customer among the results and select the record.

b. Click OK to display the customer information in the Contact Center. 

8. If the search does not return a customer or the correct customer, then you can:

■ Broaden your search criteria and click Search.

■ Start a new search by clicking Clear and entering new criteria.

■ Create a new customer record by clicking Create.

Note: You can sort the results by clicking on different column 
headings. For other ways of manipulating results see Manipulating 
Data in Your Work Queue and Other Dynamic Tables on page A-1.

Note: Oracle TeleService does not support fuzzy searches, so you 
must take care to account for different possible spellings or 
abbreviations in your search to make sure you do not create 
duplicate customer records.
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2.2.4 Setting Defaults for Searches
To speed up searches for customer information using the Customer Search Window, 
application administrators can:

■ Set Customer Search window to appear by default whenever you navigate to 
the Contact Center by setting the profile Customer Care: Default Search 
Window to Y. 

■ Specify which of the three tabs (Basic, Advanced, Service Key) in the Customer 
Search Window will appear by default by setting Customer Care: Default 
Contact Center Search Tab.

■ Specify which of the Service Key values in the Customer Search Window 
(External Reference, Serial Number, System) in the Service Key Search tab using 
the profile option Customer Care: Default Contact Center Service Key.
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Managing Customer Records

This chapter explains how to create and update customer records, including 
addresses, phone numbers, and other contact points. The customers you can 
manage include consumers, businesses, and even internal organizations. 

This chapter covers:

■ Viewing Key Information About a Customer Using the Dashboard on page 3-2

■ Updating Customer Addresses and Contact Points on page 3-4.

■ Removing an Individual from the List of Contacts for a Customer on page 3-13

■ Creating a New Customer on page 3-14

■ Entering Details About a Customer on page 3-15

■ Removing a Customer Record from Use on page 3-17

■ Restricting Contact with a Customer on page 3-17

■ Entering Interests for an Organization on page 3-18

■ Entering Employment, Education, and Other Personal Details on page 3-19

■ Capturing Customer Relationships on page 3-20

■ Viewing a Customer’s Accounts on page 3-21

■ Making a Customer Account Inactive on page 3-22

■ Creating a New Account for a Customer on page 3-23

■ Updating and Viewing Details of a Customer’s Account on page 3-23

■ Managing a Customer’s Account Details in Oracle TeleService on page 3-24

■ Granting Contacts Access to Account Information on page 3-25
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Viewing Key Information About a Customer Using the Dashboard
■ Selecting a Billing or a Shipping Address for an Account on page 3-26

■ Creating a New Relationship Between Accounts on page 3-28

■ Viewing Notes About a Customer on page 3-29

■ Creating Notes About a Customer on page 3-30

■ Managing Customer-Related Tasks on page 3-31

■ Assigning Customer-Related Tasks on page 3-33

3.1 Viewing Key Information About a Customer Using the Dashboard
The Dashboard tab of the Contact Center window provides you with a summary of 
important customer information, such as the number of escalated service requests 
or expiring contracts, and permits you to view the individual records being 
summarized. 

Prerequisites
The dashboard must be set up by the application administrator. See the Setting Up 
Customer Profiles section in the Oracle TeleService Implementation Guide. 

To view key information about a customer:
1. Display the customer in the Contact Center.

2. Select the Dashboard tab. 
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3. Select Customer or Account from the View by drop-down list depending on 
whether or not you wish to restrict the dashboard view by the account entered 
in the Acct Num field. 

The Last Refresh Date field tells you when the data you view was last refreshed.

4. If you wish to update the data in the view, then click Refresh.

5. A check mark in the Critical check box indicates the customer is critical. If you 
wish to make a customer critical or remove the critical designation, you can do 
so by following procedures described in the Managing Critical Customers 
chapter.

By default, the application flags any customer as critical if that customer has 
five or more open service requests.

You application administrator can change the criteria for flagging a customer as 
critical by modifying the seeded Critical Customers profile or by creating a new 
one. A profile can be associated with this flag via the system profile option 
Customer Care: Critical Customer Check. See Setting Up Customer Profiles in 
the Oracle TeleService Implementation Guide.
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6. You can view details of any of the summarized information by either: 

■ Selecting an item and clicking View Details.

■ Double-clicking on the item.

The application displays the Drilldown List window listing all of the individual 
items. For example, double-clicking on the Accepted Tasks item displays a list 
of accepted tasks for this customer.

7. Double-clicking on any item in the list displays the item. For example, 
double-clicking on a task, displays the task in the Tasks window.

3.2 Updating Customer Addresses and Contact Points
You can use the Contact Center to enter and update the address and contact points 
used by the entire Oracle E-Business Suite of applications. This topic covers:

■ Updating a Customer’s Identifying Address and Contact Points on page 3-5

Use this procedure to update the main customer address and contact 
information which displays in the header of the Contact Center.

■ Selecting a Different Address as the Identifying Address for a Customer on 
page 3-7

Follow this procedure if you wish to select a different customer address as the 
identifying address.

■  Adding a New Address and Site for a Customer on page 3-8

Follow this procedure to add a new address. Each address you add 
automatically becomes a new site for the customer. 

■  Specifying Uses Of An Address on page 3-9.

A single address can have many uses. Follow this procedure to indicate an 
address is used as a billing and shipping address, for example.

■  Indicating a Primary Address for a Particular Use on page 3-10

If a customer has many addresses for a particular use, then follow this 
procedure to indicate the primary address for that use.

For example, if a customer has many billing addresses, you must indicate which 
of those addresses is the primary billing address.

■ Adding Contact Points for a Customer on page 3-11
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Use this procedure to enter phone numbers, e-mail addresses, and other contact 
information for a customer. 

■ Adding Contact Points for a Customer Site on page 3-12

A customer site may have its own independent phone or fax number. Follow 
this procedure to enter a phone information specific to a customer site. 

3.2.1 Updating a Customer’s Identifying Address and Primary Contact Points
Use this procedure to update a customer’s existing identifying address and primary 
contact points. A customer can have many addresses, phone numbers, and e-mail 
addresses, but only one address, phone number, and e-mail address appear by 
default in the Contact Center and in the interfaces of other Oracle E-Business Suite 
applications. 

This main address is called the customer’s identifying address. The contact points 
are the customer’s primary contact points.

To modify identifying address and primary contact information:
1. Display the customer in the Contact Center.

2. Click Edit in the Customer region. 

The Edit Customer window appears displaying the same customer information 
which appears in the Customer region of the Contact Center.

Note: You can only use this procedure to modify the existing 
identifying information. If you wish to create new addresses or 
contact points or specify other addresses and contact points as the 
identifying information, then you must use the tabs of the Contact 
Center.
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You can make changes to all the information displayed except the Party number 
and Account number fields, which are disabled. 

3. If you wish to modify the identifying address, then:

a. Make sure the correct country is specified in the Country field.

b. Click on the address in the Address field.

The Address window appears.

c. Modify the address. 

d. Click OK.

4. If you wish to modify the primary phone number, then:

a. Enter the phone number as in the Phone fields.

b. Select the phone type from the Type drop-down list.

Note: Your customer record may already have multiple addresses 
entered for your customer, but only the identifying address 
displays in this window. To avoid duplication, you may wish to 
check customer addresses in the Addresses tab and make your 
changes there.

Note: The address appears in a format specific to the country 
selected. The formats are set up by your application administrator.
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5. If you wish to modify the primary e-mail address, then make your modification 
in the Email field. 

6. Click Save. 

Clicking Reset before you save returns the information back to the original 
values. 

3.2.2 Selecting an Identifying Address for a Customer
You can select any existing address as the identifying address for a customer. A 
customer can have many addresses, but only one identifying address which 
appears by default whenever agents display the customer record. Use this 
procedure to select an existing address as the Identifying Address.

Prerequisites
You must create an address before you can select it as the identifying address. See 
Adding a New Address and Site for a Customer on page 3-8.

To select an address as the identifying address:
1. Display the customer in the Contact Center.

2. Select the Address tab. 

3. From the View by drop-down box, select Customer: <your customer name>.

4. Click Identifying Address.

 The Identifying Address window appears.

5. Click Details (the button to the right of the Address field identified with an 
ellipsis).

The Address Search window appears.

Note: Your customer may have more than one e-mail address and 
phone number already entered as part of their record. This field 
shows only the e-mail address and phone designated as primary in 
the Contact Points tab of the Contact Center. If you are not sure 
what e-mail addresses and phone numbers are entered for your 
customer, please use the Contacts Points tab instead to avoid 
duplication. See Adding Contact Points for a Customer on 
page 3-11 for details.
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6. Search for the address you wish to use and select it. 

7. Click OK.

8. If you do not find the address you wish to use as the identifying address, then 
add the address first by following the procedure outlined in Adding a New 
Address and Site for a Customer on page 3-8.

3.2.3 Adding a New Address and Site for a Customer
Use this procedure to add a new address for a customer. When you add an address 
you automatically create a new site for the customer. Each address and site you 
create can be used for multiple purposes. For example, a shipping address can be 
used both for shipping and for billing.

To add a new address and site for a customer:
1. Display the customer in the Contact Center.

2. Select the Address tab.

3. From the View by drop-down box, select Customer: <your customer name>.

4. If no empty address record exists, then click New in the toolbar to create one.

5. Select the country for the address using the Address LOV.

6. Click on the Address field.

The Address window appears.

7. Click OK.

8. Specify the different uses for this address in the Site Usages region. See 
Specifying Uses Of An Address on page 3-9 for details.

9. Optionally, in the Primary Sites region, you can specify that this address is the 
primary address for a specific use. See Indicating a Primary Address for a 
Particular Use on page 3-10.

10. If you wish to select the address you have just created as the identifying address 
for the customer, then:

Note: The address format changes depending on the country. The 
address formats are set up by your application administrator.
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a. Click Identifying Address.

 The Identifying Address window appears.

b. Click Details (the button to the right of the Address field identified with an 
ellipsis).

The Address search window appears.

c. Search for the address to become the new identifying address. 

d. Click OK.

11. Click Save.

3.2.4 Specifying Uses for an Address
A single customer address and site can have multiple uses. For example, the same 
address can be both the shipping and billing address as well the address where the 
equipment to be serviced resides. Use this procedure to specify the different uses of 
an address.

Prerequisites
You must first add the address to the customer record.

To specify different uses for an address:
1. Display the customer in the Contact Center.

2. Select the Address tab.

3. From the View by drop-down box, select Customer: <your customer name>.

4. Select the address.

5. Select each use for this address using the Usage LOV in the Site Usages region. 
You can specify additional usages, by using the New icon in the toolbar, if 
required.

Note: The first address an agent enters for a customer 
automatically becomes the identifying address. 
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6. Click Save.

7. If you have entered multiple addresses for a particular use, you are now ready 
to specify which one is the primary address for that use. See Indicating a 
Primary Address for a Particular Use on page 3-10.

3.2.5 Indicating a Primary Address for a Particular Use
A customer may have multiple addresses for the same use. Use this procedure to 
specify which of these is primary.

For example, a customer with ten offices may have a separate billing address for 
each site. Using this procedure, you can specify which of these billing addresses is 
the primary address that appears on invoices and other documents by default. 

Prerequisites
You must specify uses of an address in the Site Usages region before you can specify 
which of these addresses are primary.

To indicate a primary address for a particular use:
1. Display the customer in the Contact Center.

2. Select the Address tab.

3. From the View by drop-down box, select Customer: <your customer name>.

4. In the Primary Sites region, use the Usage LOV to select the use.

Note: Specifying a billing address for a customer does not 
automatically enable this address to be used by Oracle Receivable's 
as a a billing address. For this address to be used for billing, you 
must associate it to a customer account. 

Oracle TeleService creates this association for you automatically 
when you use this address as the billing address for a customer 
charge in the Charges tab, otherwise you must associate the 
customer address with that account in the Account Details window. 
For information on how to create the association, see Selecting a 
Billing or a Shipping Address for an Account  on page 3-26 for 
details.
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5. Use the Address LOV to select the address you wish to specify as the primary 
address for this use.

6. Click Save.

3.2.6 Adding Contact Points for a Customer
Use this procedure to add the contact points for a customer and to indicate which of 
these contact points is primary. A customer can have multiple phone numbers, 
e-mail addresses, and Web sites. Specifying a contact point as primary determines 
what agents see when they bring up the customer record. 

If you wish to add contact points specific to an employee of a customer or a contact 
working on behalf of a consumer, then add the contact points to the contact instead. 
See Adding Contact Points for a Contact on page 4-8.

To add contact points for a customer:
1. Display the customer in the Contact Center.

2. Select the Contact Points tab.

3. From the View by drop-down box, select Customer: <your customer name>.

4. Select a contact method from the Contact Method list of values. 

The remaining fields vary depending on the contact method you select.

5. If you selected Phone, then enter the phone number in the fields provided. The 
Value field is for the main phone number and the Ext field is for the phone 
extension.

6. If you selected Web, then enter the URL in the Value field.

7. If you selected Email as the contact method, then enter the e-mail address in the 
Value field.

8. If you selected EDI, then enter the appropriate value in the Value field.

9. If you selected Telex, then enter the telex number in the Value field.

10. Optionally, enter the best times to use this contact method in the Best Time 
From and Best Time To fields.

11. If you do not want a contact method to be used, then select the Do Not Contact 
check box.

12. If you wish to indicate the contact point is primary, then make the following 
entries in the Primary Contact Point region:
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a. Select the contact method using the Contact Method LOV.

b. Use the Value LOV to select the primary contact point for that contact 
method. 

3.2.7 Adding Contact Points for a Customer Site
Use this procedure to add contact information tied to a specific site rather than to a 
contact or the company as a whole. You may wish to do so if your organization 
services equipment installed in a room with its own phone number which is not 
tied to any specific individual customer contact, for example. 

Prerequisites
You must first create the site by adding an address to the customer record.

To add contact points for a customer site:
1. Display the customer in the Contact Center.

2. Select the Address tab.

3. From the View by drop-down box, select Customer: <your customer name>.

4. Select the address/site.

5. Click Site Contact Points.

The Party Site Contact Points window appears.

Note: Other agents can view the contact information you enter 
here only when viewing site information. Whatever you enter here 
does not appear among the contact points for the customer as a 
whole. If you want contact information to be more generally visible 
then enter it instead as a contact point for the customer. 
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6. Select a contact method from the Contact Method list of values. 

The remaining fields vary depending on the contact method you select.

7. If you selected Phone, then enter the phone number in the fields provided. The 
Value field is for the main phone number and the Ext field is for the phone 
extension.

8. If you select Web, then enter the URL.

9. If you select Email as the contact method, then enter the e-mail address in the 
Value field.

10. If you select EDI, then enter the appropriate value in the Value field.

11. If you select Telex, enter the telex number in the Value field.

12. Optionally, enter the best times to use this contact method in the Best Time 
From and Best Time To.

13. If you do not want a contact method to be used, then select the Do Not check 
box.

14. Save your work to return to the Addresses tab.

3.3 Removing an Individual from the List of Contacts for a Customer
Use this procedure to indicate an individual is no longer a contact for a customer. 
Doing so removes them from the contact List of Values for the customer. It does not 
remove them from your database.

To remove an individual from the list of contacts for a customer:
1. Display the customer and contact in the Contact Center.
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2. Select the Relationship tab.

3. Select the contact from the View By drop-down list.

4. If you wish to remove an individual from the list of contacts for the customer, 
then select Inactive from the Status field for every relationship the contact has 
with the Customer. 

5. Click Save in the toolbar to save your changes.

3.4 Creating a New Customer
Use this procedure to create a new customer in your database.

To create a new customer:
1. Search for the customer using the Customer Search window to make sure the 

customer is not already in your database. See Searching for Customers and 
Contacts Using the Customer Search Window on page 2-4.

2. Click Create in the Customer region. 

3. The Create Customer window appears. 

4. Select the type of your customer using the Type drop-down list:

Note: Oracle TeleService does not support fuzzy search, so you 
may wish to search for any alternate spellings and abbreviations of 
a customer name to make sure you are not creating a duplicate.
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■ Person: if you are creating a customer that is a consumer.

■ Organization: if your customer is an organization.

5. Optionally, enter an e-mail address and phone number. The entries you make 
here automatically become the primary contact points for the customer.

6. If you wish to name the site which is automatically created when you enter the 
customer address, then enter a site name in the Site Name field.

7. Enter the country for your customer address using the Country LOV. This 
determines the address format.

8. Enter an address for the customer:

a. Click on the address in the Address field.

The Address window appears.

b. Enter the address. 

c. Click OK.

9. Select the Account check box if you want the application to create an account 
for this customer.

10. Click Save.

The application displays a note informing you of any new party number and 
account number that has been created and enters the new customer information in 
the Customer region of the Contact Center. You are now ready to enter more 
customer details. See Entering Details About a Customer on page 3-15.

Guidelines
The application automatically generates a Party Number if the application 
administrator sets the profile options HZ: Generate Party Number to Yes. It 
automatically creates an account if you selected the Account check box and if the 
application administrator set the Oracle Receivables system option AR: Automatic 
Customer Numbering to Yes.

Please refer to the Oracle TeleService Implementation Guide for more information about 
these profile options.

3.5 Entering Details About a Customer
Use this procedure to enter details about the customer in the Party Information tab 
of the Contact Center window. The details you enter are different depending on 
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whether your customer is an individual or an organization. For organizations, you 
enter details such as the number of employees. For consumers, you enter the 
pronunciation and their language proficiency and employment history.

Prerequisites
You must create a customer before you can enter details.

To enter details about customers:
1. Display the customer in the Contact Center.

2. Select the Party Information tab.

3. Select the customer, Customer: <customer name>, from the View By 
drop-down list.

4. If your customer is an organization, then:

a. Select the type of customer in the Type region:

* Internal for internal organizations

* External for external customers

b. Enter any details about the customer in the fields provided. The fields 
include the number of employees, and the SIC code.

c. If you wish to classify the organization by its purchasing interests then click 
Details and follow the procedure for Entering Interests for an Organization 
on page 3-18.

5. If your customer is a consumer, then:

a. Select the type of customer in the Type region:

* Internal for an employee

* External for external customers

b. Enter information about the customer in the fields provided. All fields are 
free-text fields except for Preferred Language, Marital Status, and Residence 
Status.

c. If you wish to enter additional details, such as the customer’s interests and 
educational and employment history, then click Details and follow the 
procedure for Entering Employment, Education, and Other Personal Details 
on page 3-19.
3-16 Oracle TeleService User Guide                              



Restricting Contact with a Customer
6. If you wish to restrict contact with the customer, then click Restrict Contact and 
enter the restrictions. See Restricting Contact with the Customer on page 3-17 
for more details.

7. Click Save.

3.6 Removing a Customer Record from Use
Use this procedure for removing a customer record from use by making it inactive. 
This action removes the customer in all lists of values for all new transactions.

To remove a customer record from use:
1. Display the customer in the Contact Center.

2. Select the Party Information tab.

3. Select the customer, Customer: <customer name>, from the View By 
drop-down list.

4. Select Inactive from the Status list of values (LOV).

5. Click Save.

3.7 Restricting Contact with a Customer
Use this procedure to restrict contact with a customer. The restrictions you place on 
phone, e-mail, visits, and other contacts apply through your organization. 

If your customer is an organization and you wish to restrict contact with that 
organization’s employees, then you must instead set up restrictions at the 

Note: Before you remove a customer record from use by making it 
inactive, be aware of the consequences this may have in other 
applications. Customer records are visible across the entire Oracle 
E-Business Suite. Some applications: 

■ Exclude inactive party records from their user interfaces. 

■ Prevent users from creating records or business transactions for 
inactive parties.

Consider these possible consequences before you set a party status 
to inactive.
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individual employee level. Restricting contacts with a customer does not 
automatically restrict contacts with individuals who are contacts for that customer.

To restrict contacts with a customer:
1. Display the customer and contact in the Contact Center.

2. Select the Party Information tab.

3. Select the customer, Customer: <customer name>, from the View By 
drop-down list.

4. Click Contact Restrictions.

The Contact Restriction window appears.

5. Select the contact method you wish to restrict using the Contact Method LOV.

6. Enter the start and end dates for the restriction in the From and To fields. If you 
wish to restrict the contact permanently, then choose an end date far off in the 
future.

7. Optionally, enter a reason for the restriction using the Reason LOV.

8. Click OK.

9. Click Save.

3.8 Entering Interests for an Organization
Use this procedure to classify the interests of an organization using a classification 
scheme set up by your application administrator. 

To enter interests for an organization:
1. Display the customer in the Contact Center.

2. Select the Party Information tab.

3. Click Details.

The Organization Details window appears displaying any current interests.

4. If you wish to add an interest:

a. Click New in the toolbar.

b. Select the interest type using the Interest Type LOV.

c. Optionally, enter a further classification using the Subinterest type LOVs.
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d. Enter an optional comment. 

e. Click Save on the toolbar.

5. If you wish to change an existing interest, then:

a. Select the interest you wish to change in the table.

b. Select a different interest type using the Interest Type LOV.

c. Optionally, enter a further classification using the Subinterest type LOVs.

d. Enter an optional comment. 

e. Click Save on the toolbar.

6. When you have completed entering interests, then click OK.

3.9 Entering Employment, Education, and Other Personal Details
Use this procedure to enter educational and employment histories and other 
personal information about consumers. Your organization may track this 
information for marketing campaigns and other sales activities. 

To enter personal customer details:
1. Display the customer in the Contact Center.

2. Select the Party Information tab.

3. Click Details.

The Person Details window appears.

4. If you wish to add employment history for this customer, then select the 
Job/Military History tab.

5. If you wish to add educational history, then select the Education tab.

6. If you wish to classify your customer’s interests, then select the interests tab.

7. If you wish to add an item then:

a. Click New in the toolbar.

b. Make your entries. 

c. Click Save on the toolbar.

8. If you wish to change an item, then:
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a. Select the item you wish to change in the table.

b. Make your modifications. 

c. Click Save on the toolbar.

9. When you have completed entering personal details, click OK.

3.10 Capturing Customer Relationships
Use this procedure to capture the relationships a customer has with other 
individuals and organizations. 

If your customer is an organization, then you can use this procedure to capture:

■ The customer’s relationship with other organizations already in your database, 
for example, that customer A is a competitor of customer B and a subsidiary of 
customer C.

■ The customer’s relationships with individuals already in your database, for 
example, that person A is an employee or CEO of your customer.

If your customer is a consumer, then you can use this procedure to capture:

■ Relationships this consumer has with other consumers, for example, that person 
A is the parent of person B or that person A is a contact for person B. 

■ Capture that consumer’s relationships with organizations they work for or 
belong to, for example, that person A is an employee of Organization A or a 
board member of Organization B. 

To capture a relationship for a customer
1. Display the customer in the Contact Center.

2. Select the Relationships tab.

3. Select the customer, Customer: <customer name>, from the View By 
drop-down list.

4. If your customer is an organization, then:

Note: The list of values you use to select the individual or 
organization for the relationship, includes all of the parties in your 
database, so make sure that you know the exact name to minimize 
long searches.
3-20 Oracle TeleService User Guide                              



Viewing a Customer’s Accounts
a. Click New in the toolbar (this is the icon with the green plus sign).

The object field is already populated with the name of your customer.

b. Use the Subject LOV to select the individual or organization for the 
relationship. Restrict your search by entering at least a partial name.

c. Use the Relation LOV to select the relationship type.

d. If you are entering a person, then you can enter that person’s title using the 
Title LOV.

e. Enter an end date if you wish this relationship to expire sometime in the 
future.

5. If your customer is consumer, then:

a. If no blank record is available, click New in the toolbar (this is the icon with 
the green plus sign).

The Subject field is pre-populated with the name of your customer.

b. Use the Relation LOV to select the relationship type.

c. Use the Object LOV to select the individual or organization for your 
customer’s relationship. Restrict your search by entering at least a partial 
name.

d. Enter an end date if you wish this relationship to expire sometime in the 
future.

6. Click Save.

3.11 Viewing a Customer’s Accounts
Use this procedure to view a customer’s accounts.

To view a customer’s accounts:
1. Display the customer in the Contact Center.

Note: The list of objects is restricted by the relationship you have 
chosen. For example, if you have chosen "Contact of", then you can 
only select organizations. If you have selected "Child of", then you 
can only select other persons.
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2. Select the Accounts tab.

The left side of the tab displays your customer’s existing accounts.

3. If you wish to view inactive accounts, then select the Inactive check box.

For details about updating accounts, see Updating and Viewing Details of a 
Customer’s Account on page 3-23.

3.12 Making a Customer Account Inactive
Use this procedure to remove an account from use in all E-Business Suite 
applications, including Oracle Receivables.

To make a customer’s account inactive:
1. Display the customer in the Contact Center.

2. Select the Accounts tab.

The existing accounts are displayed in the table on the left section of the tab.

3. Select the account you wish to inactivate.

4. Select Inactive using the Account Status list of values.

Note: The Suspension Date and Current Balance fields are being 
made obsolete and so may not appear in your version of the 
application.
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5. Click Save.

3.13 Creating a New Account for a Customer
Use this procedure to create a new customer account. The application automatically 
creates the account number. If you are using Oracle financial applications, the 
account number is the same as the customer number in Oracle Receivables. 

To create a new account for a customer:
1. Display the customer in the Contact Center.

2. Select the Accounts tab.

The existing accounts are displayed in the table on the left section of the tab.

3. Click New.

4. Enter an account name in the Account Name field.

5. Click Save.

The application creates the account number automatically. This number is also 
the Customer Number used in Oracle financial applications.

You are now ready to enter details about the account according to the procedure 
outlined in Updating and Viewing Details of a Customer’s Account on 
page 3-23.

3.14 Updating and Viewing Details of a Customer’s Account
Use this procedure to view and update details of a customer’s account. 

To view and update the details of a customer’s account:
1. Display the customer in the Contact Center.

2. Select the Accounts tab.

The tab displays the existing accounts in a table on the left.

Note: When you are creating a new customer record, you can 
instead have the application automatically create an account for 
your customer by selecting the Create Account check box.
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3. Select the account in the table.

4. You can use the fields on the tab to rename an account or to make an account 
inactive, for example.

5. You can also:

■ View and update the account in Oracle Receivables by clicking Customer 
Standard. This option is available to you only if your organization is using 
Oracle Receivables and you have been assigned the appropriate Oracle 
Receivables responsibility. 

■ Manage the basic details, such as account relationships, contacts, and 
account billing and shipping addresses, by clicking Details. See Managing a 
Customer’s Account Details in Oracle TeleService on page 3-24.

3.15 Managing a Customer’s Account Details in Oracle TeleService
While you must use financial applications to manage accounts, Oracle TeleService 
makes it possible for you to view and update some of the basic details about a 
customer’s account. 

Prerequisites
Familiarity with Oracle Receivables terminology and your organization’s 
accounting procedures.

To view and update details of a customer’s account:
1. Display the customer in the Contact Center.

2. Select the Accounts tab.

The existing accounts are displayed in the table on the left section of the tab.

3. Select the account in the table.

4. Click Details.

Customer Account Details window appears.
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5. You can:

■ View the credit status of the account on the Credit tab.

■ Grant customer contacts access to account information on the Roles tab. See 
Granting Contacts Access to Account Information on page 3-25.

■ View any suspensions for the account on the Suspensions tab.

■ Select a customer address as the billing or shipping address for the account 
on the Sites tab. See Selecting a Billing or a Shipping Address for an 
Account  on page 3-26.

■ View and create new relationships between accounts on the Relationships 
tab. See Creating a New Relationship Between Accounts on page 3-28.

3.16 Granting Contacts Access to Account Information
Use this procedure to specify who can access a customer account. By selecting an 
individual as a contact for an account, you make it possible for them to view 
account information on the Web in Oracle iSupport, for example.

Prerequisites
The persons you wish to grant access to the account must already have a 
relationship with the customer.
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To grant contacts access to account information:
1. Display the account in the Customer Account Details window by clicking 

Details on the Accounts tab of the Contact Center. (See Managing a Customer’s 
Account Details in Oracle TeleService on page 3-24 for details.)

2. Select the Roles tab.

The table displays existing customer contacts with relationships to the account.

3. Click New.

4. Select the contact using the Party Name list of values (LOV).

5. Select the relationship this individual will have to this account using the Role 
Type LOV.

6. Select Active from the Role Status LOV.

7. Optionally select the Primary check box to indicate this is a primary contact for 
this account.

8. Click Save on the toolbar.

3.17 Selecting a Billing or a Shipping Address for an Account
Use this procedure to make an existing customer address available as a billing or 
shipping address for an account in Oracle financial applications. If you are billing a 
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customer for work performed on a service request, then the application creates this 
link for you automatically. Until you do use a specific address for a transaction, 
however, that address remains unavailable for use in financial applications unless 
you create a link using the procedure below. 

Prerequisites
You must create the customer address first. See Adding a New Address and Site for 
a Customer on page 3-8.

To select a billing or a shipping address for an account:
1. Display the account in the Customer Account Details window by clicking 

Details on the Accounts tab of the Contact Center. (See Managing a Customer’s 
Account Details in Oracle TeleService on page 3-24 for details.)

2. Select the Sites tab.

3. Click New.

4. If the address has a site name, then select it using the Site Name list of values 
(LOV).

5. If the address does not have a site name, then you can search for it using the 
Address LOV.
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6. Using the Site Use LOV, select the use. For example, if you wish this address to 
be the billing address for the account, then select Bill To.

7. Click Save.

3.18 Creating a New Relationship Between Accounts
Use this procedure to create a relationship between two accounts, if, for example, 
one account is to be used as payment for a second account.

To create a relationship between two accounts:
1. Display the first account in the Customer Account Details window by clicking 

Details on the Accounts tab of the Contact Center. (See Managing a Customer’s 
Account Details in Oracle TeleService on page 3-24 for details.)

2. Select the Relationships tab.

The tab displays existing relationships with other accounts in a table. 

3. Click New.

4. Use the list of values in either the Account Name or Account Number fields to 
enter the account you wish to relate.

5. Select the status of the account.
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6. If you wish the new link to be reciprocal, select the Reciprocal check box. 

7. Click Save.

3.19 Viewing Notes About a Customer
Use this procedure to search for and view notes your organizations has entered on a 
customer.

To view notes about a customer:
1. Display the customer in the Contact Center.

2. Select the Notes tab.

3. The table on the left side of the tab displays the notes for this customer.

4. You can sort the list by any column in the table by clicking on the column 
heading. 

5. If you wish to search the text of the displayed notes, then:

a. Right-click with the mouse on a description in the list.

b. Select Find in Table in the pop-up window.

The Find Contact Center Notes and Knowledge Management Link window 
appears.

c. Enter the text you wish to find and click Find.

The application takes you to the first matching record.
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3.20 Creating Notes About a Customer
Use this procedure to create a note about a customer. 

To create a customer note:
1. Display the customer in the Contact Center.

1. Select the Notes tab. 

2. Click New.

3. Optionally, select the type of note you want to create in the Type field.

4. Select a status for the note using the Status field LOV. The choices are:

■ Private: This note can be viewed only by you. 

■ Public: Viewable by all Oracle E-Business Suite application users. 

■ Publish: Viewable by all Oracle E-Business Suite application users as well as 
external customers.

5. Enter a short note in the Note text box. 

6. If you want to enter additional note text, then:

a. Click Details.

The Note Details window appears. 

b. Enter text of up to 32,000 characters in length. 

c. Click OK to return to the Notes tab. 

7. Click Save to save the note you have created.

Note: Customers cannot view published notes you enter here on 
the Oracle iSupport Web portal. They can only view notes entered 
on a specific service request.

Note: The additional text you enter in the Note Details window is 
not visible in the notes log or notes summaries, and is not used by 
the application for knowledge base solution searches. You cannot 
search on this text.
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3.21 Managing Customer-Related Tasks
This group of topics describes how to create and assign simple customer-related 
tasks such call-backs, customer meetings, and visits using the Tasks tab of the 
Contact Center. 

The task functionality in Oracle TeleService is provided by the Tasks module which 
is a part of the Oracle E-Business Suite foundation. The Tasks tab is designed to 
provide you with an easy way to create and view tasks related to customer 
activities.

You can find more information about using tasks in the Oracle Common Application 
Components User’s Guide.

The task-related topics covered here include:

■ Creating a Task Manually on page 3-31

■ Assigning Customer-Related Tasks on page 3-33

3.21.1 Creating a Task Manually
Use this procedure to create a task manually.

To create a task manually:
1. Display the customer in the Contact Center.

2. Select the Tasks tab.

Note: The tasks you create in the Contact Center are tied to the 
customer and not to any service request you create on the Service 
Request tab. If you are creating tasks for a service request, then use 
instead the procedures described in Managing Service Request 
Tasks on page 9-38.
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3. Use the Type list of values to select a task type. 

4. Select a task status using the Status LOV. 

5. Enter a name for the task in the Subject field.

6. In the Desc. field, enter a brief description of the task.

7. If needed, in the Parent field, select a task to which this task is to be linked. 
Normally, you would select a parent task if the task you are creating is a follow 
up on another task.

8. Assign task ownership to a group or person who will be responsible for the 
completion of the task (Owner Type and Owner fields) and to the individuals or 
teams who will complete the tasks (Assignee Type and Assignee). See 
Assigning Customer-Related Tasks on page 3-33 for details.

9. Select the Planned Start and End Dates.

Note: Do not use the Restrict Closure check box for customer 
tasks, this check box is for tasks related to a service request.
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10. If you wish to display the task for the customer to see on their Oracle iSupport 
Web portal, then select the Publish check box.

11. Click Save on the toolbar. A system generated task number is displayed in the 
Num field.

12. If you wish to create a note related to the task, then click Notes to open the 
Notes window where you can create it.

13. If an Oracle Workflow process is available with this task type, then you can 
launch it by clicking Launch Workflow. The application displays a confirmation 
message. 

14. If you wish to enter additional assignees and other details such as 
dependencies, references, and contacts, click More. See Entering Task Details  
on page 9-44 and the Tasks section of the Oracle Common Application Components 
User’s Guide for more information.

3.21.2 Assigning Customer-Related Tasks
This topic explains how to assign customer-related tasks such as customer 
call-backs or customer visits, to an owner, the individual or group responsible for its 
completion, and one or more assignees, the individuals or teams that carry out the 
work. It covers: 

■ Task Assignment Concepts on page 3-33

■ Selecting Task Owners and Assignees on page 3-34

3.21.2.1 Task Assignment Concepts
You can assign a task to an owner, an assignee, or both. An owner can be an 
individual employee, such as a dispatcher, or a group that is responsible for 
ensuring the task is completed. An assignee can be either an individual employee or 
a team of employees who complete the task. In many cases the owner and assignee 
will be the same person.

You can either use the lists of values to select the owner and assignee or have the 
Assignment Manager suggest one based on service territories, availability, and 
other factors.

Selecting an assignee or owner puts that task into that individual’s and group’s 
work queue in the Oracle Universal Work Queue under the Tasks heading.

For task ownership:
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■ All members of a group see a task assigned to that group under the Group 
Owned heading regardless whether that task has also been assigned to an 
individual in that group or not.

■ An individual who has been assigned the ownership of the task, sees task both 
under My Owner and Group Owned headings. 

For task assignees:

■ All members of a team that has been assigned the task see the task in the Group 
Assigned heading regardless whether that task has also been assigned to an 
individual in that group or not.

■ An individual who has been assigned the task, sees task both under My 
Assigned and Group Assigned headings. 

3.21.2.2 Selecting Task Owners and Assignees
Use this procedure to assign a task to owners and assignees. 

To select owners and assignees for a task:
1. Display the task you wish to assign in the Tasks tab.

2. If you wish to assign ownership to a group then select Group Resource from the 
Owner Type list of values (LOV). 

3. If you wish to assign ownership to an individual employee, then instead select 
Employee Resource from the Owner Type LOV.

4. Use the Owner LOV to select the group or individual or click Assignment 
Manager to assist you. This is the icon to the right of the field.

5. If you clicked Assignment Manager, then the Assignment Manager window 
appears:

a. On the left side of the window, select the check boxes for the criteria you 
wish for selecting possible owners. If you select to use service territories, 
then select which criteria you wish to use.

b. Click Search.

The application returns the list of qualified owners in the grid on the right 
side of the window. If no resources are suggested, then repeat the search 
with different search criteria.

c. Select a resource from the list.

d. Click OK.
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6. If you wish to assign the task to a team for execution, then select Team Resource 
from the Assignee Type LOV. For individuals, select Employee Resource.

7. Use the Assignee LOV to select the team or employee assignee or click 
Assignment Manager to get assistance from the Assignment Manager as 
described above.
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Managing Customer Contacts

This chapter explains how to use the Contact Center to manage customer contacts. 
It covers:

■ About Customer Contacts on page 4-1

■ Updating Addresses and Contact Points for Customer Contacts on page 4-2

■ Removing an Individual from the List of Contacts for a Customer on page 4-9

■ Creating a New Contact on page 4-10

■ Entering Details About a Contact on page 4-13

■ Removing a Contact Record from Use on page 4-13

■ Restricting Contacts with a Customer Contact on page 4-14

■ Capturing a Contact’s Relationship with Another Organization or Individual on 
page 4-15

4.1 About Customer Contacts
A customer contact can be any individual who has a relationship with your 
customer.

If your customer is a business or an organization, then a contact may be an 
employee of that business or a consultant from a third company, for example. If 
your customer is a consumer, then the contact can be any other person such a 
relative, friend, or a representative of a company acting on behalf of that consumer.
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The procedures for creating and updating contact records are almost identical to 
those used for customer records. 

However, contact records are designed to maintain only a subset of the information 
you enter for customers. Use them to enter only contact-specific information such as 
direct phone extensions, business e-mail addresses, addresses with mail stops, and 
job titles. Contacts are a separate entity in the database (party type of Party 
Relationship) and so cannot have their own accounts, personal profiles, 
employment histories, or product interests. 

Each time you do create a brand new contact, the application automatically creates 
a second record for the contact as a customer (party of Person), however. If you do 
want to enter personal information about contacts, such as their education, 
employment history, and interests, you must display the same individual as a 
customer and make your entry while viewing their customer records.

All contact information you enter about a contact is stored in your database with 
the contact record. This means that if you enter an address or a phone number for a 
customer contact, this address remains with the contact and is not visible when 
viewing customer information. For example, if you enter 100 Main Street as the 
address for a Jim Jones, employee of Business World, then this address remains in 
the contact record for Jim Jones and does not display as an address for Business 
World or for any other Business World contact record. 

4.2 Updating Addresses and Contact Points for Customer Contacts
You can use the Contact Center to enter and update the address and contact points 
used by the entire Oracle E-Business Suite of applications. This topic covers:

■ Updating a Contact’s Identifying Address and Contact Points on page 4-3

Use this procedure to update the main address and contact information for a 
contact.

■ Selecting a Different Address as the Identifying Address for a Contact on 
page 4-5

Follow this procedure if you wish to select a different contact address as the 
identifying address.

Note: While you can select your organization’s employees 
(registered in Oracle HRMS) as contacts for a service request, you 
cannot enter them as customer contacts. 
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■  Adding a New Address and Site for a Contact on page 4-6

Follow this procedure to add a new address for your contact. Each address you 
add automatically becomes a new site for the contact. 

■  Specifying Uses Of An Address on page 4-7.

Classify the uses of each address if you maintain many addresses for a contact.

■  Indicating a Primary Address for a Particular Use on page 4-8

If a contact has many addresses for a particular use, then follow this procedure 
to indicate the primary address for that use. 

■ Adding Contact Points for a Contact on page 4-8

Use this procedure to enter phone numbers, e-mail addresses and other contact 
information for a contact. 

■ Adding Contact Points for a Contact Site on page 4-8

A contact site may have its own independent phone or fax number.

4.2.1 Updating a Contact’s Identifying Address and Primary Contact Points
Use this procedure to update a contact’s existing identifying address and primary 
contact points. A contact can have many addresses, phone numbers, and e-mail 
addresses, but only one address, phone number, and e-mail appears by default in 
the Contact Center and in the interfaces of other Oracle E-Business Suite 
applications. 

This main address is called the contact’s identifying address. The contact points are 
the contact’s primary contact points.

To modify identifying address and primary contact information:
1. Display the customer and contact in the Contact Center.

2. Click Edit in the Contact region. 

Note: You can only use this procedure to modify the existing 
identifying information. If you wish to create new addresses or 
contact points or specify other addresses and contact points as the 
identifying information, then you must use the tabs of the Contact 
Center.
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The Edit Contact window appears displaying the same information which 
appears in the Contact region of the Contact Center header.

You can make changes to all the information displayed except the Party number 
and Account number fields, which are disabled. 

3. If you wish to enter a title, then select a title from the Title drop-down list. The 
title you enter here is the title abbreviation used in front of a name in a letter. 
You enter a job title on the Party Information tab.

4. If you wish to modify the identifying address, then:

a. Make sure the correct country is specified in the Country field.

b. Click on the address in the Address field.

The Address window appears.

c. Modify the address. 

d. Click OK.

Note: Your contact record may already have multiple addresses 
entered, but only the identifying address displays in this window. 
To avoid duplication, you may wish to check all contact addresses 
in the Addresses tab and make your changes there.

Note: The address appears in a format specific to the country 
selected. The formats are set up by your application administrator.
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5. If you wish to modify the primary phone number, then:

a. Enter the phone number as in the Phone fields.

b. Select the phone type from the Type drop-down list.

6. If you wish to modify the primary e-mail address, then make your modification 
in the Email field. 

7. Click Save. 

Clicking Reset before you save returns the information back to the original 
defaulted values. 

4.2.2 Selecting an Identifying Address for a Contact
You can select any existing address as the identifying address for a contact. A 
contact can have many addresses, but only one identifying address which appears 
by default whenever agents display the contact record. Use this procedure to select 
an existing address as the identifying address.

Prerequisites
You must create an address before you can select it as the identifying address. See 
Adding a New Address and Site for a Contact on page 4-6.

To select an address as the identifying address:
1. Display the customer and contact in the Contact Center.

2. Select the Address tab. 

3. From the View By drop-down list, select Contact: <your contact name>.

4. Click Identifying Address.

Note: Your contact may have more than one e-mail address and 
phone number already entered as part of their record. This field 
displays only the e-mail address and phone designated as primary 
in the Contact Points tab of the Contact Center. If you are not sure 
what e-mail addresses and phone numbers are entered for the 
contact, please use the Contacts Points tab instead to avoid 
duplication. See Adding Contact Points for a Contact on page 4-8 
for details.
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 The Identifying Address window appears.

5. Click Details (the button to the right of the Address field identified with an 
ellipsis).

The Address Search window appears.

6. Search for the address you wish to use and select it. 

7. Click OK.

8. If you do not find the address you wish to use as the identifying address, then 
add the address by following the procedure outlined in Adding a New Address 
and Site for a Contact on page 4-6.

4.2.3 Adding a New Address and Site for a Contact
Use this procedure to add a new address for a contact. When you add an address, 
you automatically create a new site for the contact. 

To add a new address and site for a contact:
1. Display the customer and contact in the Contact Center.

2. Select the Address tab.

3. From the View By drop-down list, select Contact: <your contact name>.

4. If no empty address record exists, then click New in the toolbar to create one.

5. Select the country for the address using the Address LOV.

6. Click on the Address field.

The Address window appears.

7. Click OK.

8. If this address is used for multiple uses, then specify those uses in the Site 
Usages region. See Specifying Uses Of An Address on page 4-7 for details.

9. Optionally, in the Primary Sites region, you can specify that this address is the 
primary address for a specific use. See Indicating a Primary Address for a 
Particular Use on page 4-8.

Note: The address format changes depending on the country. The 
address formats are set up by your application administrator.
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10. If you want to use this address as the identifying address for the contact, then:

a. Click Identifying Address.

 The Identifying Address window appears.

b. Click Details (the button to the right of the Address field identified with an 
ellipsis).

The Address search window appears.

c. Search for the address you just entered. 

d. Click OK.

11. Click Save.

4.2.4 Specify Uses for an Address
Use this procedure to specify the different uses of a contact address.

Prerequisites
You must first add the address to the contact record.

To specify different uses for an address:
1. Display the customer and contact in the Contact Center.

2. Select the Address tab.

3. From the View By drop-down list, select Contact: <your contact name>.

4. Select the address.

5. Select each use for this address using the Usage LOV in the Site Usages region. 
You can specify additional usages, by using the New icon in the toolbar, if 
required.

6. Click Save.

Note: Do not specify contact addresses as billing addresses or 
other uses related to customer orders. Contact records are not 
associated with accounts, so any addresses you specify here are not 
passed on to your financial applications. If you wish to specify a 
billing address, enter it in the customer record instead. 
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7. If you have entered multiple addresses for a particular use, you are now ready 
to specify which one is the primary address for that use. See Indicating a 
Primary Address for a Particular Use on page 4-8.

4.2.5 Indicating a Primary Address for a Particular Use
In the unlikely case that a contact has multiple addresses for the same use, you can 
use this procedure to specify which of these is the primary address for this use.

Prerequisites
You must specify uses of an address in the Site Usages region before you can specify 
which of these addresses are primary.

To indicate a primary address for a particular use:
1. Display the customer and contact in the Contact Center.

2. Select the Address tab.

3. From the View By drop-down list, select Contact: <your contact name>.

4. In the Primary Sites region, use the Usage LOV to select the use.

5. Use the Address LOV to select the address you wish to specify as the primary 
address for this use.

6. Click Save.

4.2.6 Adding Contact Points for a Contact
Use this procedure to add the contact points for a contact and to indicate which of 
these contact points is primary. A contact can have multiple phone numbers and 
e-mail addresses. Specifying a contact point as primary will set the default agents 
see when they bring up the contact record. 

To add contact points for a contact:
1. Display the customer and contact in the Contact Center.

2. Select the Contact Points tab.

3. From the View By drop-down list, select Contact: <your contact name>.

4. Select a contact method from the Contact Method list of values. 

The remaining fields vary depending on the contact method you select.
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5. If you selected Phone, then enter the phone number in the fields provided. The 
Value field is for the main phone number and the Ext field is for the phone 
extension.

6. If you select Web, then enter the URL in the Value field.

7. If you select Email as the contact method, then enter the e-mail address in the 
Value field.

8. If you select EDI, then enter the appropriate value in the Value field.

9. If you select Telex, then enter the telex number in the Value field.

10. Optionally, enter the best times to use this contact method in the Best Time 
From and Best Time To.

11. If you do not want a contact method to be used, then select the Do Not check 
box.

12. If you wish to indicate the contact point is primary, then make the following 
entries in the Primary Contact Point region:

a. Select the contact method using the Contact Method LOV.

b. Use the Value LOV to select the primary contact point for that contact 
method. 

4.3 Removing an Individual from the List of Contacts for a Customer
Use this procedure to indicate an individual is no longer a contact for a customer. 
Doing so removes them from the contact List of Values for customer contacts. It 
does not remove them from your database.

To remove an individual from the list of contacts for a customer:
1. Display the customer and contact in the Contact Center.

2. Select the Relationship tab.

3. Select the contact from the View By drop-down list.

4. If you wish to remove an individual from the list of contacts for the customer, 
then select Inactive from the Status field for every relationship the contact has 
with the Customer. 

5. Click Save in the toolbar to save your changes.
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4.4 Creating a New Contact
Use this procedure to create a new contact in your database.

Prerequisites
You must create the customer before you can create a contact. See Creating a 
Customer on page 3-14.

To create a new contact:
1. Display the customer in the Contact Center.

2. To avoid duplication, you may wish to search for the contact using the 
Customer Search window to make sure the contact is not already in your 
database. See Searching for Customers and Contacts Using the Customer Search 
Window on page 2-4.

3. Click Create in the Contact region. (If this button is disabled, then clear the 
region by clicking the Clear Record icon in the toolbar.)

The Create Contact window appears displaying the customer and defaulting 
customer information in the Contact Info region.

Note: Oracle TeleService does not support fuzzy search, so you 
may wish to search for any alternate spellings and abbreviations of 
a contact name to make sure you are not creating a duplicate.
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4. Select the title from the Title drop-down list. The title you select here is the title 
abbreviation used in front of a name in a letter. To enter a job title, use the Party 
Information tab on the Contact Center instead.

5. Enter the name in the First and Last fields.

6. Enter the phone number in the Phone fields. The first field is the country code 
which you can select using the list of values (LOV).

7. Optionally, select the address type using the Address Usage LOV.

8. If you know the contact’s address is already entered in your database, then:

a. Click Select Address to the right of the Address field. (This button displays 
the numbers 1,2, and 3, and a blue arrow pointing downwards.)

The Address window appears.

b. Search for the address using a partial address with the % sign to indicate 
any missing characters.

c. Click Find.

d. Select the address.
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e. Click OK.

9. If you wish to enter a new address for the contact, then: 

a. Enter the country for your customer address using the Country LOV. This 
determines the address format.

b. If you would like to create a site name to identify the contact’s address, then 
enter a site name. Each address you enter automatically becomes a site for 
that customer. 

c. Click anywhere within the Address field.

The Address window appears.

d. Enter the address. 

e. Click OK.

10. If you wish to enter personal address and contact information for the contact, 
you can do so in the Personal Info region. This is useful if your organization 
sells or services individual consumers or tracks personal information about 
contacts.

The information you enter here is saved under the customer record (party type 
of Person) that is automatically created along with the contact record. It is 
visible only when viewing the individual as a customer. 

If you do want to enter personal information about the contact, such as 
education, employment history, and interests, you must display the same 
individual as a customer and follow the procedure outlined in Entering 
Employment, Education, and Other Personal Details on page 3-19.

11. Click Save.

The application displays a note informing you of any new party number that has 
been created and enters the new contact information in the Contact region of the 
Contact Center. You are now ready to enter more details about the contact such as 
the contact’s job title and department. See Entering Details About a Contact on 
page 4-13.

The application automatically generates a Party Number if the application 
administrator sets the profile options HZ: Generate Party Number to Yes. 

Note: The address appears in a format specific to the country 
selected. The formats are set up by your application administrator.
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4.5 Entering Details About a Contact
Use this procedure to enter details about a contact in the Party Information tab of 
the Contact Center window. 

Prerequisites
You must create a contact before you can enter the details.

To enter details about a contact:
1. Display the customer and contact in the Contact Center.

2. Select the Party Information tab.

3. Select the contact, Contact: <contact name>, from the View By drop-down list.

4. If your customer is a contact at an organization, you can enter information 
about the contact’s role including the contact’s job title and job code.

5. Enter the pronunciation of the person’s name in the Phonetic First Name, 
Phonetic Last Name, and Phonetic Middle Name fields. These fields are 
especially useful for Japanese customers entering names using Kanji.

6. You can select the contact’s language using the Preferred Language list of 
values.

7. You can indicate if the person is a decision maker and if they can provide 
customer references by selecting the Decision Maker and Reference check boxes.

8. If you wish to restrict contact with the contact, then click Restrict Contact and 
enter the restrictions. See Restricting Contact with the Contact on page 4-14 for 
more details.

9. Click Save.

4.6 Removing a Contact Record from Use
Use this procedure for removing a contact record from use by making it inactive. 
This action removes the contact in all lists of values of contacts for all new 
transactions for the current customer only. Your action does not affect the 
availability of this contact for other customers.
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To remove a customer record from use:
1. Display the customer and contact in the Contact Center.

2. Select the Party Information tab.

3. Select the customer, Contact: <customer name>, from the View By drop-down 
list.

4. Select Inactive from the Status list of values. 

5. Click Save.

4.7 Restricting Contacts with a Customer Contact
Use this procedure to restrict contact with a customer’s contact. The restrictions you 
place on phone, e-mail, visits, and other contacts apply throughout your 
organization. 

To restrict contacts with a customer contact:
1. Display the customer and contact in the Contact Center.

2. Select the Party Information tab.

3. Select the contact, Contact: <contact name>, from the View By drop-down list.

4. Click Contact Restrictions.

The Contact Restriction window appears.

5. Select the contact method you wish to restrict using the Contact Method LOV.

Note: Before you remove a contact record from use by making it 
inactive, be aware of the consequences this may have in other 
applications. Contact and customer records are visible across the 
entire Oracle E-Business Suite. Some applications: 

■ Exclude inactive party records from their user interfaces. 

■ Prevent users from creating records or business transactions for 
inactive parties.

 Consider these possible consequences before you set a party status 
to inactive.
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6. Enter the start and end dates for the restriction in the From and To fields. If you 
wish to restrict the contact permanently, then choose an end date far off in the 
future.

7. Optionally, enter a reason for the restriction using the Reason LOV.

8. Click OK.

9. Click Save.

4.8 Capturing a Contact’s Relationship with Another Organization or 
Individual

Use this procedure to capture a relationship the contact has with other 
organizations or individuals, for example, that the contact is the parent of person A 
or a board member of Organization B. 

To capture a relationship for a contact:
1. Display the customer and contact in the Contact Center.

2. Select the Relationships tab.

3. Select the contact, Contact: <contact name>, from the View By drop-down list.

4. If no blank record is available, click New in the toolbar. (This is the icon with 
the green plus sign.)

5. The Subject field is pre-populated with the name of your contact.

6. Use the Relation LOV to select the relationship type.

Note 1: The relationships you enter for your contact are stored 
with the customer record for the individual (the party of Person) 
and not with the contact record. This is because a party of Party 
Relationship cannot have relationships with another party in the 
customer model.

Note 2: The list of values you use to select the individual or 
organization for the relationship, includes all of the parties in your 
database, so make sure that you know the exact name to minimize 
long searches.
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7. Use the Object LOV to select the individual or organization for your contact’s 
relationship. Restrict your search by entering at least a partial name.

8. If the relationship you are capturing is with an organization, then enter a title. 
Entry is optional.

9. Enter an end date if you wish this relationship to expire sometime in the future.

10. Click Save.

Note: The list of objects is restricted by the relationship you have 
chosen. For example, if you have chosen "Board member of", then 
you can only select organizations. If you have selected "Child of", 
then you can only select other persons.
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Quick Service Requests

This chapter describes how Tier-1 customer support agents can resolve simple 
customer requests for service by searching the organization’s knowledge base, how 
they can check entitlements, and how they can quickly create service requests for 
follow-up by Tier-2 agents. This chapter covers:

■ Creating a Quick Service Request on page 5-1

■ Checking Entitlements on page 5-4

■ Searching the Knowledge Base for Solutions on page 5-7

5.1 Creating a Quick Service Request
This procedure describes the steps Tier-1 agents can use to quickly create a service 
request on the Service Request tab of the Contact Center for follow-up by Tier-2 
agents.

This quick method does not permit the modification of a service request after it has 
been submitted. Agents who wish to modify or add additional information to a 
service request must use the Service Request window.

To create a quick service request:
1. Display the customer in the Contact Center.

2. Navigate to the Service Request tab.

3. Enter a summary of the customer problem in the Summary field.
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4. Select the type of service request you are creating using the Type list of values 
(LOV). Depending on your implementation, selecting a service request type 
may:

■ Restrict the problem codes you can use to describe the problem

■ Determine the available status settings

For example, for "Accounting Problem" type service requests, you may specify a 
problem code of "Billing Error" and a status of "Under Review." For "Equipment 
Failure", the selections would change instead be "Defective Hard Drive" and 
"Working".

After you submit the service request, a service request type can also:

■ Launch an Oracle Workflow process

■ Automatically assign tasks to individuals in your organization

5. If you know the problem code for the problem your customer is calling about, 
enter it using the Problem LOV.

Problem codes provide a standard way for organizations to describe customer 
problems.

6. If the customer is calling about an item they have purchased, then:

a. If you know the item’s serial number or its Oracle Install Base instance 
number, then enter one or the other using the list of values (LOV) in the 
Serial or Instance fields.

b. If you do not know either number or the item is not registered in the 
customer’s install base, then you can search for the item either by inventory 
item number (using the Item LOV) or by the item’s description (the LOV in 
the field to the right of Item).

7. If the problem requires you to record an incident address, for example, if your 
organization has to dispatch an agent to the customer site to solve the problem, 
then:

a. Some contracts cover only specific customer locations, so check with the 
customer if the incident address in the Address field is correct. You may 

Note: The summary is the only field you must fill in to create a 
service request. You can click Submit at any time after you have 
entered the summary.
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have to scroll down within the tab to view the address which defaults from 
the identifying (main) customer address or from the Installed At address in 
Oracle Install Base. 

b. If the address is incorrect or blank, then make sure the check box to the 
right of the Address field is selected and search for the address using the 
LOV. 

c. If the incident address does not exist and you wish to record this address as 
a customer address, then create it on the Address tab first. (See Adding a 
New Address and Site for a Customer on page 3-8). You can also enter an 
incident address as text as you would a non-postal location as described in 
the next step.

8. If the incident takes place at a location without a postal address, for example, if 
you must send an agent to GIS or GPS coordinates or to the intersection of two 
roads, then enter the location as text:

a. Deselect the check box to the right of the Address field.

b. Enter the location in any of the address fields.

9. Select a severity of the problem using the Severity LOV. The severity you choose 
here may determine how quickly your organization is contractually bound to 
respond and resolve the customer problem. 

10. If the customer is calling for service that may be covered by a warranty or a 
service contract, then:

a. Check the customer’s entitlements as described in Checking Entitlements 
on page 5-4. 

b. If a contract applies, then select it using the check box to the left.

Note: The list of values permits you to select any address in your 
database as the incident address.

Note: Entering a location as free text, does not store the address in 
your database as a valid address. Any address you enter in this 
way does not appear in lists of values and is not available for any 
other business functions such as billing or shipping.
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Selecting a contract populates the service request with information 
designed to help your organization meet its contractual obligations. This 
may include the required time by which your organization must resolve the 
issue (displayed in the Resolution By field), and the preferred resources 
who are to help the customer.   

11. If you would like to enter a note for the service request, then:

a. Type in your note in the Note field located on the right of the tab.

b. Optionally, select a Note Type.

c. If you wish the customer to see this note when they review the service 
request on their Oracle iSupport Web site, then select Publish from the 
Status drop-down list. 

Setting a status to Public, makes the note visible to all other agents with 
access to the service request. A status of Private, keeps the note private.

12. Click Submit to save the service request.

13. Search the knowledge base to look for solutions to the customer problem by 
clicking Knowledge Base (the button to the right of the Submit). See Searching 
the Knowledge Base for Solutions to a Service Request on page 5-7.

5.2 Checking Entitlements
You can check to see if the service the customer is requesting is covered by a 
warranty or a contract on the Service Request tab of the Contact Center.

This topic covers:

■ What entitlements are checked on page 5-5

Note: If your organization has mapped note types to Oracle 
Knowledge Management statement types, then you can use specific 
note types to search your organization’s knowledge base or even 
contribute solutions of your own.

Note: After you click Submit, you cannot modify the service 
request on this tab, but you can do so using the Service Request 
window available by clicking Details.
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■ Procedure for checking entitlements on page 5-5

5.2.1 What Entitlements Are Checked
You can check for all valid warranties and contracts that cover any of the following:

■ An individual item as it is registered in the customer’s installed base

■ The item (as defined in the item master in inventory)

■ A system as it is defined in the customer’s installed base

■ A customer site

■ A customer account

■ The customer

The search starts from the most specific level up the contracts hierarchy to return all 
available contracts arranged from the most specific to the most general.

For example, if you enter a serial number of a product the customer owns, the 
application checks the customer’s installed base to see if any warranty or contracts 
cover:

■ The product itself

■ The site where the product is installed

■ The customer account

■ The customer who owns it

The application returns all valid contracts listed from the most specific (the 
warranties or service level agreements for the individual product) to the most 
general (contracts your organization has with your customer).

You can select a contract to apply to the service request or let the application supply 
the most specific contract automatically. This populates the service request with 
information designed to help your organization meet its contractual obligations 
including resolution time and preferred resources. 

5.2.2 Checking a Customer’s Entitlements
Use this procedure to check a customer’s entitlements.

To check a customer’s entitlements:
1. Display the customer in the Contact Center.
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2. If a customer has multiple accounts, then enter the account number in the Acct 
Num field in the Customer region of the Contact Center header. This entry is 
important if a customer chooses different contracts to cover different accounts.

3. Navigate to the Service Request tab.

4. If the customer is calling about an item they have purchased, then:

a. If you know item’s serial number or its Oracle Installed Base instance 
number, then enter either in the Serial or Instance fields using the list of 
values (LOV).

b. If you do not know either number, then you can search for the item either 
by its inventory item number (using the Item LOV) or by the item’s 
description (the LOV in the field to the right of Item).

5. Check with the customer if the incident address in the Address field is correct. 
This address defaults from the main customer address or from the Installed At 
address in Oracle Install Base. If it is not correct, then enter it using the Address 
LOV.

6. To search only contracts in effect, make sure the Active Contracts radio button 
is selected. If you wish to search all contracts, including those no longer in force, 
then instead select the All Contracts radio button.

7. Click Get Contracts.

The contracts are displayed in the Contracts region of the tab. 

Warranties display a check mark in the Warranty check box.

The tab displays only two contracts at a time. You can scroll to view additional 
contracts using the scroll bar to the right.

8. If you wish to view coverage details about any contract, then select the contract 
and click View Details (the button with the eyeglasses icon to the right of the 
Coverage column).

Details of the contact appear in the Service Contracts Coverage window. These 
include the hours of coverage, the resolution times, and billing rates. 

Note: Make sure the check box next to the Address field is 
selected. 
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5.3 Searching the Knowledge Base for Solutions
You can search your organization’s knowledge base from the Contact Center for 
potential solutions to customer problems either before or after you create a service 
request. This topic covers:

■ Searching the Knowledge Base Without Logging a Service Request on page 5-7

■ Searching the Knowledge Base for Solutions to a Service Request on page 5-7

5.3.1 Searching the Knowledge Base Without Logging a Service Request
Use this procedure to perform a simple search of your organization’s knowledge 
base without entering a service request. For more details of different search 
methods please see the Oracle Knowledge Base User Guide. 

To search the knowledge base:
1. Navigate to Knowledge Base > Search Knowledge Base

The Oracle Knowledge Base’s Solution Advanced Search page opens in a 
browser window. 

2. Enter one or more problem statements in the Statements region of the page. 

3. Click Search Solutions.

4. The Results region of the page displays possible solutions to the customer 
problem.

5. To view any solution, click View (the glasses icon to the right of the solution).

The solution displays in the Solution Detail page.

6. If this solution solves the customer problem, then answer the question "Can this 
solve your problem?" by clicking Yes. Answering yes increases the ranking of a 
solution on subsequent searches. Clicking No decreases the ranking.

5.3.2 Searching the Knowledge Base for Solutions to a Quick Service Request
Use this procedure to perform simple searches of the knowledge base for solutions 
to a customer problem entered in a service request created on the Service Request 
tab of the Contact Center.

If your search is likely to involve multiple solutions, then instead follow the 
procedure outlined in Searching the Knowledge Base and Suggesting Solutions on 
page 9-30.
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Prerequisites
You must create a service request first.

To search the knowledge base for solutions to a service request:
1. After you saved the service request by clicking Submit, click Knowledge Base. 

(This is the button located to the left of the Details button at the button of the 
tab).

The application searches for solutions using the entries you made in the 
following service request fields: 

■ Summary

■ Notes (of types mapped to knowledge management statement types)

■ Product

■ Platform

The Oracle Knowledge Base’s Solution Advanced Search page opens in a 
browser window displaying the possible solutions to the problem in the Results 
region.

2. To view any solution:

a. Click View (the glasses icon to the right of the solution).

The solution displays in the Solution Detail page.

b. If you are troubleshooting the problem with the customer, then indicate the 
usefulness of the solution by clicking one of the buttons below the question 
"Can this solve your problem?" at the bottom of the page:

* Yes: Indicates the solution helped you to solve the problem. This 
selection increases the ranking of a solution on subsequent searches. 

* No: The solution did not help you. This decreases the ranking of this 
solution on subsequent searches. 

* Maybe: You or the customer has not tried the solution, but you want to 
suggest it as a potential solution. Clicking this button links the solution 
to the service request and makes it visible to customers on their Oracle 
iSupport Web portals.

c. If you or the customer have not tried the solution, but you would like to 
suggest it as a potential solution, then click Maybe. 
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Any solution you label as a potential solution is linked to the service 
request and can be viewed by customers on their Oracle iSupport Web 
portal and by other agents in the Service Request window.
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Managing Critical Customers

The application automatically flags a customer as critical whenever a customer 
meets conditions defined in a customer profile.

The predefined customer profile, called Critical Customer, flags a customer as 
critical if the customer has more than five open service requests. 

You application administrator can change the criteria by modifying the profile or by 
creating a new one altogether as described in the Setting Up Customer Profiles 
section of the Oracle TeleService Implementation Guide. The administrator must select 
any new profile to be used for criticality checking in the system profile option 
Customer Care: Critical Customer Check. 

Agents can manually reset the criticality of a customer making a non-critical 
customer critical or vice versa and they can view the audit history of such manual 
over-rides.

Topics discussed in this chapter are:

■ Finding Critical Customers on page 6-1

■ Overriding the Criticality of a Customer on page 6-2

■ Viewing Customer Criticality History on page 6-3

6.1 Finding Critical Customers
Use this procedure to find a critical customer.

To find a critical customer:
1. From the Customer Support responsibility, open the Find Criticality Overridden 

Customers window using the following navigation path:
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Customer Management > Critical Customer Management

2. Enter either the customer name or number.

3. Click Find. 

If the customer is flagged as being critical, details are displayed in the Override 
Customer Criticality window. If the customer is not flagged as being critical, the 
query returns no rows.

6.2 Overriding the Criticality of a Customer
You may have situations when the profile engine does not determine a customer as 
being critical based on the rules setup, but the customer still needs to be flagged as 
critical. You can override the system-determined criticality in order to deal with 
temporary or exceptional situations.

To override the criticality of a customer:
1. From the Customer Support responsibility, open the Find Criticality Overridden 

Customers window using the following navigation path:

Customer Management > Critical Customer Management

2. If a customer has not previously been considered to be critical, click New to 
open the Override Customer Criticality window. Otherwise, query the 
customer.

3. In the Override Criticality section, select Yes in the Override field to make the 
customer critical. Select No to remove the critical designation. 

4. Select an appropriate reason from the list of values in the Reason field.

5. Enter additional notes about this override in the Notes window. To open the 
Notes window, click Notes.

6. Enter the text of the note to further describe the customer situation.

7. Optionally select a note type from the Type list of values.

8. Select a status of Internal, External or Private.

9. Close the Notes window. 

10. Save the changes you made. The changes you have made are recorded in the 
History region of the window.
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6.3 Viewing Customer Criticality History
Use the Override Customer Criticality window to view historical audit information 
about whether the system determined criticality was overridden. You can view the 
reason for the override, the user name of the person who changed the criticality, the 
date when it was changed and the original system determined criticality. The 
history region displays only manual overrides of criticality.
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Using Relationship Plans

Relationship plans make it possible for your organization to deliver personalized 
and proactive customer service by alerting agents to customer needs.

This chapter covers:

■ About Relationship Plans on page 7-1

■ What You Can Modify on page 7-3

■ Choosing Which Relationship Plan to Display on page 7-4

■ Searching for Relationship Plans and Portfolios on page 7-5

■ Adding and Removing Relationship Plans for a Customer on page 7-8

■ Viewing an Audit of a Relationship Plan on page 7-9

■ Modifying a Relationship Plan on page 7-10

■ Finding All Customers Assigned to a Relationship Plan on page 7-11

■ Disabling a Relationship Plan for One or More Customers on page 7-12

■ Customizing a Relationship Plan for a Specific Customer on page 7-13

7.1 About Relationship Plans
A relationship plan is a process which runs in the background while you work, 
periodically checking which customers meet one or more conditions. 

Whenever you are working on a customer record that meets these conditions, the 
relationship plan automatically displays an alert message or launches a script that 
guides you through the interaction with the customer.
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A simple relationship plan, such as Plan A described below, checks customers 
against only one condition. More complex plans, such as Plan B, evaluate customer 
records using multiple conditions. If customers satisfy the main condition of the 
plan they qualify for the plan and the plan is added to their portfolio:

■ Plan A

If a customer contract is to expire in five or more days, then alert the agent with 
a message.

All customers that satisfy the main condition (have at least one contract that is 
to expire in five or more days) qualify for the plan.

All agents working on the records of qualified customers automatically get the 
alert.

■ Plan B

If a customer has ten or more open high-priority service requests, then check if 
the customer has orders of $1 million or more. 

For customers with orders above $1 million, launch a script that guides the 
agent in handling the customer call. 

For customers below that threshold, alert the agent with a message that the 
customer is a high-priority customer. 

All customers with ten or more open high-priority service requests qualify for 
the plan. Of the qualified customers those that have orders of $1 million or 
more display a script. Those that have orders below that amount display a 
message.

The relationship plan determines what action to take in two steps:

1. It evaluates the main condition of the plan to see if a customer qualifies for the 
plan. If a customer qualifies, then the plan gets added to their plan portfolio.

2. The plan then evaluates the qualifying customers based on any additional 
conditions to determine what action to take. Plans with only the main condition 
take the same action for all qualifying customers.

As Plan A includes only one condition, it alerts agents whenever a customer has a 
contract that will expire in five days.

Plan B takes different actions for different subsets of the customers who qualify. 
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7.2 What You Can Modify
Creating and modifying relationship plans requires knowledge of programming, 
concurrent processes, as well as the internal structure of the Oracle E-Business Suite 
applications and is described in the Setting Up Relationship Plans section of the 
Oracle TeleService Implementation Guide. 

However, you can modify relationship plans without specialized knowledge as 
described in this section. You can:

■ Add a relationship plan to a customer’s portfolio.

This qualifies the customer for the plan even if they do not meet the qualifying 
condition. For example, if you know a customer is critical, you may wish to 
alert other agents regardless of whether the customer has the five escalated 
service requests normally required to trigger the plan. The plan still evaluates 
any additional conditions to decide what action to take. For instructions, see 
Adding and Removing Relationship Plans for a Customer on page 7-8.

■ Remove a plan from a customer’s portfolio.

Use this option if you wish to disable one or more plans for a specific customer.

The customer no longer qualifies for the plan even if they satisfy the qualifying 
condition. Agents in your organization no longer receive alerts or scripts from 
the plan for this customer. For instructions, see Adding and Removing 
Relationship Plans for a Customer on page 7-8.

■ Disable a plan for one or more customers. 

Use this option if you wish to disable a plan for one or more customers. The 
effect is the same as removing a plan from a customer’s portfolio. For 
instructions, see Disabling a Relationship Plan for One or More Customers on 
page 7-12.

■ Create a customized plan for a customer. 

Agents can create a customized plan for the customer by modifying the value of 
the qualifying condition. Suppose, for example, that a plan specifies that 
customers must have five escalated service requests before they are considered 
critical, but you know that Business World is a sensitive customer that should 
be considered critical even with one escalated service request. You can create a 
customized plan for Business World and change the value for the qualifying 
condition from greater than four to greater than zero. See Customizing a 
Relationship Plan for a Specific Customer on page 7-13.
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■ Modify the plan.

You can change the value of the qualifying condition for all customers. If you 
decide that all customers should be considered critical and agents warned when 
a customer has just one escalated service request instead of five, then you can 
modify the qualifying condition for the plan. See Modifying a Relationship Plan 
on page 7-10.

7.3 Choosing Which Relationship Plan to Display
Use this procedure only if the Relationship Plans - Outcomes window displays on 
your screen indicating that the customer meets the criteria of more than one 
relationship plan.

Relationship plans monitor customer statistics while you work and alert you with a 
message or display a script whenever the customer you are working on meets the 
conditions specified in the plan. If a customer meets the criteria of more than one 
plan at the same time, you must choose which relationship plan you wish to 
execute. This is because the application cannot display more than one script or 
message at the same time.

To select which relationship plan message or script to display:
1. In the Relationship Plans - Outcomes window, select which plan you wish to 

execute. 

The Outcome Type field tells you whether a plan displays an alert or a script.

2. Click Execute.

After you have completed viewing the message or script, you can select another 
plan to execute.

3. Click Cancel to close the window.
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7.4 Searching for Relationship Plans and Portfolios
Use this procedure to:

■ Search for and display a list of the relationship plans assigned to a customer’s 
portfolio. 

■ Search for a relationship plan you with to modify or customize. 

To search for relationship plans and portfolios:
1. Navigate to Customer Management > Relationship Plans Management.

The Relationship Plans Search window appears.

2. Enter your search criteria:

■ If you wish to view the plan portfolio for a customer, then enter a customer 
name or other customer search criteria.

■ If you wish to search for a specific plan to modify, disable, or customize, 
then enter the plan name using the Plan Name list of values. 
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3. Relationship plans can be set up for parties or specific accounts. If you wish to 
restrict your search, then select the Party or Account radio buttons. Otherwise, 
select Both.

4. You have the option of restricting your search by selecting one of the radio 
buttons in the Plan Type region:

■ Template: Search all general plans.

■ Custom: Search for all customized plans.

■ Both: Search both.

5. Click Search.

Search results are displayed at the bottom of the Relationship Plans Search 
window.

If you are searching by customer name or other customer attributes only, the 
search returns the customer record even if the customer has no plans in the 
portfolio (the Plan field is blank).

If you are searching for a relationship plan to modify it, the search results 
display all of the customers with that plan. You can select any of the customer 
records to display the plan. If you wish to customize the plan for a particular 
customer, then select that customer.

6. Select the customer and click OK.

The Plans Summary window appears. The left part of the window displays the 
customer’s portfolio of relationship plans. 
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You can:

■ Expand the hierarchy to view a list of all the plans for the customer. 

■ Select a plan from the hierarchy to view its details in the right section of the 
window. 

■ View all the customers who have been assigned to a plan by selecting the plan 
in the hierarchy and selecting the Inquiry tab.

From the Plans Summary window, you can also:

■ Remove or add plans for the customer by clicking Add/Remove and following 
the procedure described in Adding and Removing Relationship Plans for a 
Customer on page 7-8.

■ If you are an application administrator you can also create a relationship plan 
by clicking New and following the steps described in the Setting Up 
Relationship Plans section of the Oracle TeleService Implementation Guide. 

■ View an audit of the usage of the plan by clicking Audit. 

■ View and modify details of a plan by clicking Details/Modify. See Modifying a 
Relationship Plan on page 7-10.
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From the Plans Inquiry tab, you can:

■ Disable the relationship plan for a customer by selecting the customer and 
clicking Disable. See Disabling a Relationship Plan for One or More Customers 
on page 7-12.

■ Customize a relationship plan by clicking Customize and following the 
procedure described in Customizing a Relationship Plan for a Specific 
Customer on page 7-13

7.5 Adding or Removing Relationship Plans for a Customer
Use this procedure to add or remove plans for a customer. Adding a plan to a 
customer’s portfolio qualifies the customer for the plan whether or not they satisfy 
the plan’s qualifying condition. Removing a plan from the portfolio for a customer 
disables the plan for this individual customer even if they satisfy the qualifying 
condition. 

If you wish to remove the relationship plan from the portfolios of multiple 
customers, then instead follow the procedure for Disabling a Relationship Plan for 
One or More Customers on page 7-12.

To add or remove relationship plans for a customer:
1. View the relationship plans for a customer in the Plans Summary window. See 

Searching for Relationship Plans and Portfolios on page 7-5 for details.

2. Click Add/Remove. 

The Add/Remove Plans window opens.

3. Click on the appropriate node on the hierarchy tree to view a list of available 
plans. For example, to list all customer-level plans, select the Customer Level 
Plans node. 

Plans currently assigned to the customer are listed below the selected node. 
Plans available to be assigned to the customer are listed in the right side of the 
window.

4. To assign a plan to the customer:

a. Select the plan you want to assign to the customer on the right side of the 
window.

b. Click the Left Arrow button.

The plan is listed under the current node.
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5. To remove a plan currently assigned to the customer:

a. In the hierarchy tree, select the plan you want to remove.

b. Click the Right Arrow button.

The plan is deleted from the node.

6. Click OK to save your work and return to the Plans Summary tab.

7.6 Viewing an Audit of a Relationship Plan
Use this procedure to view the history of a relationship plan in the Audit History 
window, including information on when a plan was added or removed for a 
customer. 

To view an audit of a relationship plan:
1. Search for the relationship plan and display it in the Plans Summary window as 

describe in Searching for Relationship Plans and Portfolios on page 7-5.

2. Select the plan in the navigation tree in the left side of the window.

3. Click Audit.

The Audit History window appears.

4. Click OK when you are done reviewing the history.
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7.7 Modifying a Relationship Plan
Use this procedure to modify the condition used by the relationship plan to qualify 
customers. Any changes you make affect all customers. 

To view and modify a relationship plan:
1. View the relationship plans for a customer in the Plans Summary window. See 

Searching for Relationship Plans and Portfolios on page 7-5 for details.

2. Select the plan whose details you want to view or modify.

3. Click Details/Modify. 

The Modify Plan window appears displaying the details of the plan.

4. You can modify the Plan Criteria region which specifies the qualifying 
condition for the plan:

a. The Profile Check field displays what name of the setup that collects data 
about your customer. Profile checks are set up by the application 
administrator, so do not change the value here without an understanding of 
the profile checks set up for your organization. 
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b. You can modify the operator by selecting a different one using the Operator 
drop-down list.

c. Depending on the operator you chose, you can modify the Low value, the 
High value, or both.

5. If you have the prerequisite programming and applications knowledge for 
creating relationship plans, then select the Plan Details tab and modify other 
plan conditions or actions according to the procedures described in the in the 
Setting Up Relationship Plans section of the Oracle TeleService Implementation 
Guide.

6. Save the changes you have made.

7.8 Finding All Customers Assigned to a Relationship Plan
Use the Relationship Plans Inquiry tab to find all customers who are assigned to a 
relationship plan.

To find all customers assigned to a relationship plan:
1. View the relationship plans for a customer in the Plans Summary window. See 

Searching for Relationship Plans and Portfolios on page 7-5 for details.

2. Select a specific relationship plan.

3. Select the Inquiry tab. It displays all of the customers assigned to this 
relationship plan.

Note: You can remove a relationship plan from use by entering a 
date in the End Date field. You cannot delete relationship plans.
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4. If you wish to disable this plan for one or more customers then select the 
customer and click Disable. See Disabling a Relationship Plan for One or More 
Customers on page 7-12 for more details.

5. To create a customized version of the plan for a customer, select the customer 
and click Customize. See Customizing a Relationship Plan for a Specific 
Customer on page 7-13.

7.9 Disabling a Relationship Plan for One or More Customers
You can disable the relationship plan for one or more customers in the Disabling a 
relationship plan from the Plan Inquiry tab has the same effect as removing a 
relationship plan from a customer’s plan portfolio.

To disable a relationship plan:
6. View the relationship plans for a customer in the Plans Summary window. See 

Searching for Relationship Plans and Portfolios on page 7-5 for details.

7. Select the relationship plan you wish to disable.
7-12 Oracle TeleService User Guide                              



Customizing a Relationship Plan for a Specific Customer
8. Select the Inquiry tab. All customers assigned to this relationship plan are 
displayed.

9. Select the customer.

10. Click Disable to disable this relationship plan for the selected customer. The 
Status of this relationship plan for this customer changes from Assigned to 
Disabled. This action is automatically recorded in the Relationship Audit 
History.

The Disable button changes to Enable.

11. Click Save on the toolbar.

7.10 Customizing a Relationship Plan for a Specific Customer
Use this procedure to create a customized version of a relationship for an individual 
customer. 

To customize a relationship plan for a specific customer:
1. Display the relationship plan in the Plans Summary tab. See Finding 

Relationship Plans for a Customer for details.

2. Select a relationship plan.

3. Select the Inquiry tab. It displays all customers assigned to this relationship 
plan.

4. Select a customer.

5. Click Customize. 
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The Customize Plan window appears.

6. Enter a unique name in the Plan Name field.

7. In the Plan Type region, make sure the Custom radio button is selected.

8. You can modify the Plan Criteria region which specifies the qualifying 
condition for the plan:

a. The Profile Check field displays the name of the profile check that collects 
data about your customer. Profile checks are set up by the application’s 
administrator, so do not change the value here without an understanding of 
the profile checks set up for your organization. 

b. You can modify the operator by selecting a different one using the Operator 
drop-down list.

c. Depending on the operator you chose, you can modify the Low value, the 
High value, or both.

9. If you have the prerequisite programming and applications knowledge for 
creating relationship plans, then select the Plan Details tab and modify other 
plan conditions or actions according to the procedures described in the in the 
Setting Up Relationship Plans section of the Oracle TeleService Implementation 
Guide.
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10. Click Save on the toolbar to save your new plan.
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Communicating With Your Customers

This chapter discusses the different ways you can use Oracle TeleService to 
communicate with your customers via telephone, e-mail, and Web and how to end a 
customer interaction.

The overview section explains what functionality Oracle TeleService provides for 
each communication channel. The remaining topics provide details about each:

■ Using Telephony in Oracle TeleService  on page 8-3

■ Communicating Via E-mail on page 8-8

■ Communicating Through the Web on page 8-16.

■ Wrapping Up a Call on page 8-18

■ Ending an Interaction Without Entering Call Wrap Up Information on page 8-20

8.1 Overview
Oracle TeleService makes it possible for you to interact with your customers via:

■ Telephone 

■ E-mail

■ Web

8.1.1 Telephone
Oracle TeleService telephony integration helps you to:

■ Handle inbound calls

■ Call customers who have requested a call back on the Web
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■ Call customers directly

Handling Inbound Calls
Integration with Oracle Advanced Inbound, and the Oracle Universal Work Queue, 
makes it possible for agents to automatically receive customer calls together with 
information about the callers and the service requests they are calling about.

While you are talking to the customer, you can transfer the call together with the 
customer information to other agents or queues or conference other agents into the 
call to help you.

Calling Customers Who Have Requested Assistance on the Web
The application also makes it possible for you to call customers who have requested 
an agent to call them back by filling in the Oracle iSupport Web Callback page. The 
application dials the number and displays information about the customer, 
including the question they are asking on the Note tab of the Contact Center 
window.

Calling Customers Directly
While Oracle TeleService does not dial outgoing calls for you, you can enter 
customer numbers manually into the icWork Controller (Softphone) to make 
outgoing calls.

8.1.2 E-mail
Oracle TeleService integration with Oracle eMail Center makes it possible for you to 
compose an e-mail with the click of a mouse button. Depending on where you 
launch the Oracle e-mail Center’s Compose window, the application automatically 
fills in the addressees and context about a service request you are e-mailing about. 

The e-mails you send are recorded in Oracle E-Business Suite’s Interaction History. 
This makes it possible for you to review any e-mails sent to a customer about a 
service request directly from the Service Request window or you can use the 
extensive full-text search capabilities of the Oracle eMail Center itself to find the 
e-mail you are looking for.

8.1.3 Web
You can use the notes functionality provided by the Oracle E-Business Suite to 
communicate with your customer about a service request. Both you and the 
customer can view notes the other has entered when reviewing the service request.
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Your administrator can set up notifications that notify either party when the service 
request has been updated.

8.2 Using Telephony in Oracle TeleService
Oracle TeleService relies on the Oracle Universal Work Queue and its icWork 
Controller (Softphone) for its telephony functionality, so you must understand and 
follow the detailed user procedures described in the Oracle Universal Work Queue 
User Guide.

The topics and procedures in this section a highlight a few aspects of telephony 
important to Oracle TeleService.

■ Receiving Inbound Calls  on page 8-3

■ Sharing Customer Information While Conferencing or Transferring Calls on 
page 8-5

■ Handling a Web Callback on page 8-7

■ Switching Between Web Callback and Inbound Queues on page 8-8.

■ Quitting the Application When Telephony Is Enabled on page 8-8.

8.2.1 Receiving Inbound Calls
When someone calls your organization, Oracle Advanced Inbound tries to 
determine the caller’s identity based on the phone number and on the information 
the caller has provided to the Interactive Voice Response (IVR) system. This can 
include the service request number, account number, contact number, customer 
number, and party number. 

The application behaves differently depending on whether the information 
provided by the customer matches:

■ A unique customer or contact

■ Multiple customers or contacts

■ No customers or contacts

■ A valid service request number

No matter what information the application displays about the customer, the agent 
must always verify that it is correct. The caller may be calling from someone else’s 
phone or about someone else’s service request, or has made a mistake in entering 
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the service request number that just happens to match an existing service request 
number.

8.2.1.1 Unique Customer or Contact
When the caller’s phone number matches a unique customer or contact phone 
number, the application displays that party’s record in the Contact Center.

8.2.1.2 Multiple Customers and Contacts
When the caller’s phone number matches the phone number of more than one 
customer or contact, the application displays the Customer Search window 
populated with all the matching records.

This can happen, for example, when a number of people share the same phone line 
or when the contact’s phone number is the same as the phone number of the 
organization that the contact works for.

You must select one of the parties listed and click OK.

Which party you select depends on the context of the call.

For example, suppose the number the caller is calling from matches:
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■ The main phone number of your customer General Technologies (a party of 
Organization)

■ The personal phone number of Mel Bordeaux (a party of Person)

■ The work number of Mel Bordeaux who works for General Technologies. 
(Contact for General Technologies)

You select different party types depending on what the caller is calling about:

8.2.1.3 When No Customer or Contact Records Match
When the application does not find any matches for the caller’s phone number or 
the other information the caller has provided, you receive a blank Contact Center 
window. In this case, you must search for customer record manually by using the 
lists of values in the Contact Center header or the Customer Search window which 
is available by clicking Search on the toolbar. See Displaying Customer and Contact 
Information  on page 2-1 for more details.

8.2.1.4 When a Caller Enters a Service Request Number
If the customer has entered a valid service request number, the application displays 
the appropriate service request in the Service Request window. 

The application displays the customer who owns the service request in the header 
of the service request, regardless of the identity of the caller or what phone number 
the caller is calling from. 

8.2.2 Sharing Customer Information While Conferencing or Transferring Calls
While working in the Contact Center, you can use the icWork Controller to transfer 
or conference a customer together with the customer information displayed on your 
screen.

If the caller: You select:

Is the person listed and is 
calling with a personal request

The party of Person. This is the individual listed without 
affiliation to any organization.

Is the person listed and is 
calling with a request on behalf 
of the organization

The person with a relationship to the organization. 

If you determine the caller is 
not the person listed. 

The organization itself.
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For example, if you are transferring or conferencing a call while working on a 
service request in the Contact Center’s Service Request tab, the application displays 
the same Service Request tab and Contact Center information for the second agent. 

If you have multiple windows open, the application displays the Contact Center for 
the second agent regardless if it is active. For example, if you are viewing a 
customer’s service request in the Service Request window and have the Contact 
Center in the background, the transfer or conference call shares the Contact Center 
window. 

Prerequisites
You must be on the phone with a customer.

To transfer customer information when conferencing or transferring a 
call:
1. Click Save on the toolbar to save any work you are doing. This ensures the 

second agent receives the latest information.

2. Transfer or conference the call using the Softphone as described in Using the 
icWork Controller section of the Oracle Universal Work Queue User Guide. This 
procedure is slightly different depending on the type of telephony hardware 
your organization uses.

3. Two agents cannot work on the same record at the same time, so if you do 
continue to work in the Contact Center after the conference or transfer is 
initiated, you must ensure that you are not both updating the same information. 

Note: Conferencing is not the same as screen sharing. Screen 
sharing permits two or more people to work together while sharing 
the same screen. This conferencing feature displays the same 
customer information to a second agent, but both of you continue 
to work in independent windows so you do not see what the other 
person is doing.

Note: If you transfer or conference the call from within the Service 
Request window, the application only provides for the second 
agent the customer context you were originally provided when you 
took the call. It does not transfer the information you are actually 
looking at.
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Both agents can create notes and tasks because these create separate records, for 
example, but they cannot modify the customer’s address or contact information 
at the same time. If you do attempt to modify the same record, only one of you 
will be able to save your work. 

4. End your interaction with the customer either by clicking the End Interaction or 
Call Wrap-up buttons.

8.2.3 Handling a Web Callback
Use this procedure to call a customer in response to question they have entered on 
the Web. Customers can request an agent to call them back by filling out a Web form 
with their phone number, the time they wish to be called, and their question. 

When you are logged into the Web Callback work queue in the Universal Work 
Queue, the application automatically dials the customer number for you and 
displays customer details in the Contact Center. The customer’s question appears 
on the Notes tab.    

Prerequisites:
You must log into the Web Callback queue in the Universal Work Queue.

To handle Web callbacks:
1. When you are assigned a Web callback, the Contact Center appears 

automatically showing the details of the customer who requested the callback. 
The application dials the customer number displayed in the icWork Controller 
(Softphone).

2. Click the flashing green line button on the Softphone to talk with the customer.

3. Select the Notes tab to view the customer’s question.

4. When you are done speaking with the customer, then close the interaction 
either by clicking End Interaction or Call Wrap-up icon on the toolbar to 
indicate you are ready for the next call back.

Note: If you wish to see the results of any work done by the 
second agent, you must requery the customer record. 
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8.2.4 Switching Between Web Callback and Inbound Queues
When you wish to switch media queues, from handling incoming calls to placing 
outbound Web callbacks or vice versa, you must remember to always click the Stop 
Media button before selecting the next queue. This ensures you are recognized by 
the application as ready to receive the next call.

To switch between Web Callback and Inbound queues:
1. Navigate to the Universal Work Queue.

2. Click Stop Media on the toolbar.

3. Select the next queue.

8.2.5 Quitting the Application When Telephony Is Enabled
Use the following procedure when you wish to close the application down at the 
end of the day or when you go on a break.

To quit the application:
1. Save your work.

2. Close any interactions.

3. Close the Contact Center and Service Request windows.

4. Navigate to the Universal Work Queue.

5. Click Stop Media in the toolbar.

6. Close the Universal Work Queue window. This closes the icWork Controller 
(Softphone) automatically.

8.3 Communicating Via E-mail
This topic provides an overview of the e-mail capabilities and covers the following 
user procedures:

■ Composing and Sending an E-mail to a Customer or Contact on page 8-10.

■ Finding and Viewing E-mail Communications with Customers on page 8-11.

■ Viewing E-mails Sent to Customers on page 8-11.

■ Viewing E-mails Sent Regarding Specific Service Requests on page 8-15.
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8.3.1 About Sending E-mails to Customers or Contacts
You can send an e-mail to a customer or a customer contact from the Contact Center 
and Service Request windows and from the Oracle applications’ toolbar whenever 
you see the Open E-mail Compose Window icon enabled:

The Service Request window does not display the icons on the window itself, but 
you can send an e-mail by double-clicking on any e-mail address. 

Both actions launch the Oracle eMail Center’s Compose page in your browser 
where you compose your e-mail.

The e-mail topics in this guide describe only the basic features of sending e-mail. 
For additional features and instructions, please see the Oracle eMail Center User 
Guide.

8.3.1.1 Automatic Prefill of E-mail Addresses and Service Request Context
The application fills in different information, including e-mail addresses and service 
request information, depending on where you launch the Compose window.

If you wish to send e-mails to both the contact and customer displayed in the 
Contact Center header, for example, you can click the Open Email Compose 
Window icon to get the application to fill in the customer’s primary e-mail address 
in the To: addressee field and the contact’s primary e-mail address in the Cc: field.

If you launch the same compose window by clicking the icon to the right of the 
contact’s E-Mail field, the application fills in the contact’s e-mail into the To: 
addressee field and leaves the Cc: field blank.

The following table lists some of the key launching points for the e-mail Compose 
window that take advantage of the automatic prefill feature:

To send: Where to Launch the Compose Window

A general e-mail to a 
customer and contact 

Navigate to the Contact Center and click Open Email Compose 
Window on the toolbar.

A general e-mail to a 
contact

Navigate to the Contact Center and click Open Email Compose 
Window next to the contact you wish to e-mail.
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8.3.2 Composing and Sending an E-mail to a Customer or Contact
Use this procedure to compose an e-mail to a customer or a contact. 

To compose an e-mail to a customer or contact:
1. If you are sending an e-mail regarding a service request, then:

a. Display the service request in the Service Request window.

b. Double-click on the e-mail address of a service request contact or customer. 

The Oracle eMail Center’s Compose page opens in a new browser. 

Information about the service request appears in the subject line. This 
includes a tag which makes it possible for the Oracle eMail Center to track 
any customer replies to your e-mail as part of the same thread.

2. If you are sending an e-mail to the customer that is not related to a specific 
service request, then:

a. Display the customer in the Contact Center window.

b. Click Open Email Compose Window next to any e-mail address field or on 
the toolbar. 

An e-mail about a 
specific service request to 
a service request contact 

Select the Contact tab in the Service Request window and 
double-click on the contact e-mail address. 

The subject line of the e-mail automatically populates with 
information about the service request. 

An e-mail about a 
specific service request to 
the customer’s primary 
e-mail address and the 
primary contact

Navigate to the Service Request window header and 
double-click on the customer’s e-mail address in the Customer 
column. The application populates the customer’s primary 
e-mail address in the To: field and the e-mail address of the 
primary contact in the Cc: field.

The subject line of the e-mail automatically populates with 
information about the service request.

Note: If you evoke the Compose window using the Open Email 
Compose Window icon in the toolbar, no information is pre-filled 
for you.

To send: Where to Launch the Compose Window
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The Oracle eMail Center’s Compose page opens in a new browser window. 

3. Compose your message in the Compose page.

Depending on your implementation, you may be able to use different e-mail 
templates displayed to the right of the compose area. For detailed information 
about how to use this and other Oracle eMail Center features see the Oracle 
eMail Center User Guide. 

4. Click Send.

8.3.3 Finding and Viewing E-mail Communications with Customers
Oracle TeleService makes it possible for you to find and view e-mail 
communications with customers by using the Interactions tabs in the Contact 
Center and Service Request windows:

■ To view all e-mails sent to a customer, display the customer in the Contact 
Center and follow the instructions in Viewing E-mails Sent to Customers on 
page 8-11.

■ To view e-mails to a customer regarding a specific service request as well as any 
follow-up replies from the customer, display the service request in the Service 
Request window, and follow the steps described in Viewing E-mails Sent 
Regarding Specific Service Requests on page 8-15.

For features such as full-text searching and the ability to view threads of e-mails on 
a particular topic, you must use the Oracle eMail Center. See Oracle eMail Center 
User Guide for more information.

8.3.4 Viewing E-mails Sent To Customers
Use this procedure to search for and view general e-mails sent to customers.

If the e-mail you wish to view is about a service request, then instead use the 
procedure described in Viewing E-mails Sent Regarding Specific Service Requests 
on page 8-15. 

Note: You can only view e-mails sent from Oracle TeleService. 
E-mails you send to customers using your own e-mail application 
cannot be viewed through either Oracle TeleService or Oracle eMail 
Center.
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To view e-mails sent to customers:
1. Display the customer in the Contact Center.

2. Select the Interactions tab.

The top half of the tab displays all of the interactions with the customer. 

Each time you send an e-mail through the Oracle eMail Center, the application 
records an interaction with an entry in the Outcome column of Email 
Composed.

Selecting an interaction in the top half of the tab, displays information about the 
e-mail, including its subject line, in the Activity Details region.

3. If you do not have a large number of interactions recorded for this customer, 
then you can look for the e-mail directly on the tab using the tools available by 
right-clicking with your mouse:

a. Place your cursor in the Outcome column.

b. Right-click on any of the records and select Find in Table.

The Find CSC Interactions window appears.

c. Enter Email and click Find. 

The table takes you to the first "Email Composed" interaction record.

Information about the e-mail displays in the Activity Details region (the 
bottom half of the tab). The e-mail subject appears in the Subject field. You 
may have to scroll to the right to see it.
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d. If this e-mail is the one you wish to view, then double-click on the e-mail 
record in the Activity Details region. Otherwise repeat the search.

The e-mail message appears in a browser window.

4. If you have a large number of interactions recorded for this customer, then click 
All Interactions and follow the procedure outlined in Finding Customer 
E-mails on page 8-13.

8.3.5 Finding Customer E-mails
Use this procedure to search for e-mails sent to or from a customer within Oracle 
TeleService. You can only use this procedure to search for e-mails recorded in 
Interaction History. This means only those e-mails sent from E-Business Suite 
applications and those sent by customers in response. 

To find customer e-mails:
1. Display the customer in the Contact Center.

2. Select the Interactions tab.

3. Click All Interactions.

The Customer Interaction search window appears.
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4. Select the Activities Filtering Criteria tab.

5. Select EMAIL from the Mode Type list of values.

6. If you know the approximate dates of the e-mail, then enter a date range in the 
Start Date and End Date fields.

7. Select either INCOMING or OUTGOING from the Direction drop-down list. 

8. Click Search.

9. The table below displays the results of your search. The subject line of the 
e-mail appears in the Media Data field.

10. You can search for the e-mail you want by any keyword in the subject line:

a. Place your cursor in the Media Data column.

b. Right-click on any of the records and select Find in Table.

The Find An MD Source for JTFIHGUI window appears.

c. Enter a key word from the subject line in the Find What field.

d. Click Find. 
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The table takes you to the first e-mail subject line that matches your search 
record. If this is not the e-mail you wish to review, then repeat the search.

11. If the e-mail was sent regarding a service request, you can display the service 
request in the Service Request window by clicking on the link in the Object 
Function column.

8.3.6 Viewing E-mails Sent Regarding Specific Service Requests
Use this procedure to view e-mails that have been sent regarding a specific service 
request.

To find and view e-mails regarding specific service requests:
1. Display the service request in the Service Request window.

2. Select the Interactions tab.

The top half of the tab displays all of the interactions regarding this service 
request. 

Each time you send an e-mail through the Oracle eMail Center from the Service 
Request window, the application records an interaction with an entry in the 
Outcome column of Email Composed.

Selecting an interaction in the top half of the tab, displays information about the 
e-mail, including its subject line, in the Activity Details region.

3. Search for an interaction of type Email Composed in the top half of the tab 
using the tools available by right-clicking with your mouse:

a. Place your cursor in the Outcome column.

b. Right-click on any of the records and select Find in Table.

The Find CSC Interactions window appears.

c. Enter Email and click Find. 

The table takes you to the first "Email Composed" interaction record.

Information about the e-mail displays in the Activity Details region (the 
bottom half of the tab). The e-mail subject appears in the Subject field. You 
may have to scroll to the right to see it.

d. If this e-mail is the one you wish to view, then double-click on the e-mail 
record in the Activity Details region. Otherwise repeat the search.

The e-mail message appears in a browser window.
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4. If you have a large number of interactions recorded for this customer, then click 
All Interactions and follow the procedure outlined in Finding Customer 
E-mails on page 8-13.

8.4 Communicating Through the Web
You and your customers can communicate via the Oracle E-Business Suite’s notes 
feature regarding a service request the customers are tracking in their Web portal.

This topic covers:

■ Overview on page 8-16

■ Displaying a Service Request on the Web  on page 8-16

■ Displaying a Note for the Customer About a Service Request on page 8-16.

■ Viewing Notes a Customer Has Added to a Service Request  on page 8-17.

8.4.1 Overview
Customers can see any service request note you create with the status of Publish 
when they view the service request on their Oracle iSupport Web portal. You can 
view any notes customers add to the service request in the Service Request 
window’s Log tab. 

To ensure the customer knows when you have added a note, your application’s 
administrator can have the application automatically notify the customer via e-mail 
whenever you publish such a note or otherwise update the service request.

The notification features can alert service request owners of any notes a customer 
enters, either via e-mail or through their Oracle Workflow Notifications page. For 
more information on notifications, please see the Setting Up Notifications section of 
the Oracle TeleService Implementation Guide.

8.4.2 Displaying a Service Request on the Web
If you wish to display a service request for customer review on the Web, then you 
must select the Publish Flag in the Service Request window header. 

8.4.3 Displaying a Note for the Customer About a Service Request
Use this procedure to enter a note for the customer about a service request.
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Prerequisites
You can only communicate with customers who are using Oracle iSupport to track 
their service requests.

To display a note for the customer about a service request:
1. Display the customer service request in the Service Request window.

2. Navigate to the Workbench tab.

3. Click New.

4. Optionally, select a Note Type to classify the note you are writing.

5. Select Publish from the Status drop-down list. 

6. Enter the note you wish your customer to see.

7. Click Save on the toolbar.

The customer can see your note in the Service Request Log section of the Service 
Request Detail page. If your application’s administrator has set up the appropriate 
notifications, your customer is alerted that you have added the note via e-mail.

8.4.4 Viewing Notes a Customer Has Added to a Service Request
Use this procedure to view any notes a customer has added to a service request.

Your application administrator can set up notifications to alert you automatically 
when a customer added a note to the service request on the Web.

Prerequisites
You can only communicate with customers who are using Oracle iSupport to track 
their service requests.

To view notes a customer has added to a service request: 
1. Display the customer service request in the Service Request window.

2. Select the Log tab.

3. Select the Notes check box. (Leave the others unselected.)

4. Click Refresh.

The log displays all of the notes for this service request, including any entered by 
the customer.
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8.5 Viewing Information About a Call
Use this procedure to view information about a call of a customer on the phone.

Prerequisites
Oracle Inbound telephony must be implemented and a customer must be on the 
phone.

To view information about a call:
1. Click the Call Information icon on the Toolbar. This is the icon with a telephone 

and the letter "i".

The Information Window appears displaying information about the call. This 
includes information gathered automatically by Oracle Inbound and that 
entered by callers themselves.

2. Close the window by clicking Close on the window’s title bar. This is the button 
in the upper right-hand corner that is standard in all applications.

8.6 Wrapping Up a Call
Use this procedure to record outcomes of your interaction with a customer and to 
review and update the activities recorded by the application.

Prerequisites
An interaction must be in progress. You can tell if an interaction is in progress when 
the End Interaction icon in the toolbar is enabled. This is the traffic light icon with a 
red light.

To wrap up a call:
1. Click Call Wrapup in the toolbar.

The Call Wrap Up window appears displaying the activities that will be 
recorded interaction history.
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2. If you wish to modify any of the listed activities, then make alternate selections 
using the list of values provided. Each activity can have its own outcome and 
result.

3. Not all customer-related activities are recorded automatically. If you wish to 
add additional activities to be recorded as part of your interaction, then:

a. Click New in the toolbar. 

b. Use the lists of values (LOVs) to record the Action, Action Item.

c. Enter the outcome of the activity using the Outcome LOV.

d. Optionally enter the Result and Reason.

4. Click OK. 

Clicking OK ends your interaction and signals your telephony application that 
you are ready to accept the next call.
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8.7 Ending an Interaction Without Entering Call Wrap Up Information
Use this procedure to end an interaction without entering call wrap-up information. 
The application automatically records the default outcome, result, and reason for 
the interaction. 

Prerequisites
An interaction must be in progress. You can tell if an interaction is in progress when 
the End Interaction icon in the toolbar is enabled. This is the traffic light icon with a 
red light.

To wrap up a call:
Click End Interaction in the toolbar. This is the stoplight icon with the red light.
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Managing Service Requests

This chapter provides Tier-2 customer service agents with process-oriented, 
task-based procedures for using Oracle TeleService to manage service requests.

It covers:

■ Creating a Service Request on page 9-2

■ Displaying a Service Request for You to Work On on page 9-5

■ Updating a Service Request on page 9-6

■ Entering the Incident Address or Location on page 9-8

■ Searching for a Service Request on page 9-8

■ Copying a Service Request on page 9-13

■ Selecting a Customer for a Service Request on page 9-15

■ Viewing a Profile of Your Customer on page 9-15

■ Viewing Item Details and Entering the Item in the Service Request on page 9-18

■ Checking a Customer’s Contract Coverage on page 9-19

■ Searching for and Displaying Installed Base Items on page 9-21

■ Assigning Ownership of Service Requests on page 9-23

■ Using Notes in Service Requests on page 9-26

■ Searching the Knowledge Base and Suggesting Solutions on page 9-30

■ Viewing the Service Request Log on page 9-34

■ Adding Service Request Contacts on page 9-36

■ Selecting Billing, Shipping, and Installed At Parties and Addresses on page 9-37
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■ Managing Service Request Tasks on page 9-38

■ Assigning Service Request Tasks on page 9-41

■ Creating a Task Using the Task Template on page 9-43

■ Entering Task Details on page 9-44

■ Viewing Interactions and Activities with the Customer on page 9-47

■ Specifying Relationships to Other Service Requests and Objects on page 9-48

■ Viewing a List of Service Requests by Customer or Item on page 9-55

■ Printing a Service Request on page 9-56

■ Closing a Service Request on page 9-57

■ Indicating You are Not Available to Receive Work on page 9-57

■ Setting Default Values to Speed Up Service Request Creation on page 9-58

9.1 Creating a Service Request
Oracle TeleService makes it possible for each service organization to create its own 
process for creating and managing service requests, so you can use this general 
procedure only as a guideline. 

To create a service request:
1. Navigate to Service Requests > Create Service Requests or, if you know of a 

similar service request, you can speed up the creation process by making a copy 
following the procedure described in Copying a Service Request  on page 9-13. 

2. Select a customer. You can select a customer by name or by entering a single 
piece of identifying information such as the serial number of an installed base 
item, the customer’s contract number, or the phone number. For details on the 
different service request entry points, see Selecting a Customer for a Service 
Request on page 9-15.

3. Select the Workbench tab and enter a summary of the customer problem in the 
Problem Summary field.
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4. In the Service Request window header, check the Type field to see if the 
defaulted service request type is correct. If not, use the list of values (LOV) to 
select one. Depending on your implementation, selecting a service request type 
may:

■ Restrict the problem codes you can use to describe the problem

■ Determine the available status settings

For example, "Accounting Problem" type service requests may include a 
problem code of "Billing Error" and a status of "Under Review." For "Equipment 
Failure", this would be "Defective Hard Drive" and "Being Repaired".

After you save the service request, the service request type you selected may 
also:

■ Launch an Oracle Workflow process

■ Automatically assign tasks to individuals in your organization

5. Select a severity for the service request using the Severity LOV. The severity 
represents your organization’s determination of the seriousness of the customer 
problem and determines how quickly your organization must respond. 
Selecting a different severity together with the service request type can affect 
the date and time a contract you select populates in the Respond by and 
Resolve by fields.

Note: A customer and a problem summary are the only two 
pieces of information you must enter to create a service request. 
The other mandatory fields, Type, Status, and Severity can be 
automatically defaulted from preferences stored in system profile 
options. You can set up your own default preferences by following 
the procedure outlined in Setting Your Personal Defaults to Speed 
Up Service Request Creation on page 9-58.

Note: You can tell if a workflow has been triggered by checking to 
see if the Active Workflow check box is selected. This check box is 
located at the bottom of the right-hand column of the service 
request header. To see it, you must view the entire header by 
clicking Maximize or Minimize the Header (the right-arrow 
button on the top right corner of the Service Request window).
                                                                    Managing Service Requests 9-3



Creating a Service Request
6. On the Workbench tab, you can optionally select an urgency using the Urgency 
LOV. The urgency represents the customer’s perception of the seriousness of the 
problem. 

7. If the customer is calling about an item in inventory or the installed base, then:

a. If you know the item is registered in the customer’s installed base, then you 
can enter it by Serial (Number), Tag (Number), or System (Number). Or you 
can search the installed base by clicking the Find (flashlight) icon next to the 
Item field. See Searching for and Displaying Installed Base Items on 
page 9-21.

b. If the item is not registered in the customer’s installed base, then you can 
search for the item either by inventory item number using the Item list of 
values or by the item’s description using the Desc LOV. (Do not use the 
Find icon to the right of the Item field as this searches the installed base.) 

8. If you know the problem code for the problem your customer is calling about, 
then enter it using the Problem LOV.

Problem codes provide a standard way for organizations to describe customer 
problems.

9. If the problem requires you to record an incident address, for example, if your 
organization must dispatch an agent to fix the problem, then enter the incident 
address using the Address field LOV or as free text. See Entering the Incident 
Address on page 9-8 for instructions.

10. If you wish to check a customer’s coverage by warranties and contracts, then 
select the Product Coverage tab and follow the procedure outlined in Checking 
a Customer’s Contract Coverage  on page 9-19.

Selecting a contract populates the service request with information designed to 
help your organization meet its contractual obligations. This may include the 
required time by which your organization must resolve the issue (displayed in 
the Resolution By field), and the preferred resources who are to help the 
customer.   

11. If you wish to search your organization’s knowledge base for a solution to the 
problem, then select the Workbench tab and follow the instructions for 
Searching the Knowledge Base and Suggesting Solutions on page 9-30.

12. You can also: 

■ Assign the service request to an individual or group in your organization 
using the Assign Owner and Assign Group buttons in the service request 
header. See Assigning Ownership of Service Requests on page 9-23.
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■ Enter a note. Using Notes in Service Requests on page 9-26.

■ Add or remove customer and employee contacts. See Adding Service 
Request Contacts on page 9-36.

■ Select addresses and parties for billing and shipping. See Selecting Billing, 
Shipping, and Installed At Parties and Addresses on page 9-37.

■ Create and manage the tasks required to resolve the service request. See 
Managing Tasks on page 9-38.

■ Provide links to related service requests and to other documents such as 
invoices or maintenance plans. See Specifying Relationships to Other 
Service Requests and Objects on page 9-48.

■ Charge the customer for services. See Creating a Charge Line on page 11-7.

13. Click Save on the toolbar to save your work.

9.2 Displaying a Service Request for You to Work On
Use this procedure to display a service request you wish to work on either by 
selecting it from your work queue or by searching for it.

To display a service request for you to work on:
1. If you wish to work on a service request a customer has logged on the Web 

using Oracle iSupport or a service request assigned to you by someone else in 
your organization or by the auto-assignment feature of the application, then: 

a. Navigate to Universal Work Queue.

b. Open the Service Requests type heading and select My Owned in the Work 
Type column. 

If your organization’s business practices assign ownership only to groups, 
you can select a service request under the Group Owned heading. If you do 
so, you must make sure nobody else is working on the same service request 

Note: Service requests owned by individuals appear both under 
My Owned and Group Owned headings. This means that the 
Group Owned heading includes unassigned service requests as 
well as those that have been assigned to others in your group.
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as the application does not prevent multiple individuals from accessing the 
service request at the same time.

c. Select the service request you wish to work on and double-click on it.

The service request displays in the Service Request window.

See the Oracle Universal Work Queue User Guide for more details.

2. If you know the service request number, then you can view the service request 
by entering the service request number using the Query by Example method:

a. Navigate to the Service Requests > Create Service Requests.

The Service Request window appears.

b. From the View menu, select Query by Example > Enter.

c. In the Number field on the top right hand side of the window, enter the 
service request number. 

d. From the View menu, select Query by Example > Run.

e. The window displays the service request. For further information on 
searching using this method see the Oracle Applications Users Guide.

3. If you wish to search for the service request using one or more criteria, 
including customer name, service request status, or note text, then:

a. Navigate to the Service Requests > View Service Requests.

The Search Service Request window appears.

b. Search for the service request as described in Searching For a Service 
Request  on page 9-9.

9.3 Updating a Service Request
This topic provides guidelines for updating service requests.

To update a service request:
1. Display the service request in the Service Request window by navigating to 

Service Requests > View Service Requests. See Displaying a Service Request for 
You to Work On on page 9-5.

2. If you wish to record a change in the status of a service request, then select the 
new status using the Status list of values.
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3. You can also: 

■ Enter the location of the customer problem in the Address field of the 
Service Request window header. See Entering the Incident Address or 
Location on page 9-8.

■ Select a contract on the Product Coverage tab. See Checking a Customer’s 
Contract Coverage on page 9-19.

■ Assign the service request to an individual or group in your organization 
using the Assign Owner and Assign Group buttons in the service request 
header. See Assigning Ownership of Service Requests on page 9-23.

■ Enter an installed base item using the fields in the service request header. 
See Searching for and Displaying Installed Base Items on page 9-21.

■ Enter an inventory item using the lists of values in the Item and Desc. fields 
in the service request header. See Viewing Item Details and Entering the 
Item in the Service Request on page 9-18.

■ Enter a note. Using Notes in Service Requests on page 9-26.

■ Search the knowledge base for possible solutions to the customer problem. 
Searching the Knowledge Base and Suggesting Solutions on page 9-30.

■ Add or remove customer and employee contacts. See Adding Service 
Request Contacts on page 9-36.

■ Select addresses and parties for billing and shipping. See Selecting Billing, 
Shipping, and Installed At Parties and Addresses on page 9-37.

■ Create and manage the tasks required to resolve the service request. See 
Managing Tasks on page 9-38.

■ Specify that the service request is a duplicate of an existing one. See 
Specifying One Service Request is a Duplicate of Another on page 9-53.

Note: If your organization has implemented status transition 
rules, your choice of statuses can affect how you can update the 
service request in the future. For example, if you change a status of 
a service request to "Closed", you or others in the organization may 
not be able to update the problem description.
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■ Provide links to related service requests and to other documents such as 
invoices or maintenance plans. See Specifying Relationships to Other 
Service Requests and Objects on page 9-48.

■ Charge customers for services. See Creating a Charge Line  on page 11-7.

9.4 Entering the Incident Address or Location
Use this procedure to enter the incident address or location of the customer 
problem. You can either select the address from those already in your database or 
enter it as text. Entering an incident address is important if you are sending out 
field service personnel to the site of the problem.

To enter an incident address or location:
1. If the incident occurred at a postal address, then:

a. Search for the address using the Address list of value (LOV). See Selecting 
an Incident Address Using the Address LOV on page 9-8.

b. If you cannot find the incident address, then you can either:

* Enter it as text. See Entering an Incident Address as Text  on page 9-9.

* Create it as a new address in the database. 

You will want to create a new address in the database if the address is a 
customer address your organization may wish to use in the future. (See 
Adding a New Address and Site for a Customer on page 3-8.)

2. If the incident takes place at a location without a postal address, for example, if 
you must send an agent to GIS or GPS coordinates or to the intersection of two 
roads, then enter the address as text according to the procedure outlined in 
Entering an Incident Address as Text  on page 9-9.

9.4.1 Selecting an Incident Address Using the Address LOV
Use this procedure to search for and select an incident address from addresses in 
your database.

Note: Fields in the service request header may be hidden from 
view. If the Address field is not visible, click the Maximize or 
Minimize the Header button located at the top right of the window. 
This is the right-arrow button to the right of the Profile button.
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To select an incident address: 
1. Make sure the check box to the right of the Address field is selected. This field is 

located in the second column from the right in the service request header.

2. Use the Address LOV to search for the address. 

9.4.2 Entering an Incident Address as Text
Use this procedure to enter an incident address or location as text. Entering an 
address as free text, does not store the address in your database as a valid address. 
It does not appear in lists of values and is not available for any other business 
functions such as billing or shipping.

Prerequisites
Display the service request in the Service Request window.

To enter an incident address as text:
1. Deselect the check box to the right of the Address field.

2. Enter the address or location in the Address, City, State, Country, and other 
address fields.

Additional fields for text addresses such as Cross Streets and Points of Interest 
are available using standard Oracle Forms applications folder tools. 

9.5 Searching For a Service Request 
You can search for service requests by:

■ One or more criteria

This includes service request number, customer name, problem summary key 
words, note text, products, and tasks.

Note: The list of values permits you to select any address in your 
database as the incident address.

Note: Entering a location as free text, does not store the address in 
your database as a valid address. Any address you enter in this 
way does not appear in lists of values and is not available for any 
other business functions such as billing or shipping.
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■ By ranges of values

You can search for all high-severity service requests you must respond to by the 
end of the month, for example.

9.5.1 Searching by One or More Criteria
Use this procedure to search for a service request by using one or more criteria, 
including service request number, customer name, problem summary key words, 
products, and tasks. If you enter multiple search criteria, all have to be satisfied by 
the service request. 

To find a service request using one or more criteria:
1. Display the Search Service Request window by one of the following methods:

■ From the Navigator, navigate to View Service Requests

■ If you already have the Service Request window open, click Find in the 
toolbar. This is the icon with a searchlight.
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2. If you wish to search by key words in the service request problem summary or 
in related notes, then:

a. In the Text Search region, select a search option:

* Any Word: Finds service requests with notes or problem summaries 
that contain any of the key words.

* All Words: Finds service requests with notes or problem summaries 
that contain all the key words in any order.

* Phrase: Finds service requests with notes or problem summaries that 
contain an exact match of the key words.

b. Select either the Summary or the Notes check box or both, depending on 
what you wish to search.

c. Enter the search terms in the Keywords field.

3. You can search by any combination of the search parameters:

■ To search by contact, select the contact type from the Type drop-down list 
before entering your search terms:

* Number (application-generated reference number)

* Last Name

* First Name

* Phone number

* Email address

■ To search by customer, select the customer type from the Type drop-down 
list and make entries in any of the following fields:

* Number (application-generated customer number)

* Name

* Account

Note: You can only search service requests that have been indexed 
by the Service Request Synchronize Index concurrent program. 
Your application administrator can set this program to run 
periodically. See the Oracle TeleService Implementation Guide for 
details.
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* Phone

* Country

■ If you wish to search by inventory or installed base item or by contract, then 
make entries in the Subject region:

* Item (inventory or installed base number)

* Instance

* Serial number

* System

* Contract

* Line

■ If you wish to search by service request attributes, then make entries in the 
Request region:

* Number (application-generated service request number)

* Type

* Status

* Group

* Group Type

* Owner

* Owner Type

■ If you wish to search by task, then make entries in the Task region:

* Number (application-generated reference number)

* Status

* Type

■ If you wish to find service requests by the individual or group assigned 
tasks, then make entries in the Task Assignee region:

* Type

* Name

4. Click Search to find matching service request(s) based on the parameters you 
have specified. 
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The results of your search are displayed below in the Results region. You can 
sort the service requests by date, severity, and other columns by clicking on the 

5. Select a service request and click 

9.5.2 Searching Using Ranges of Values
Use this procedure to search for service requests using ranges of one or more 
criteria. For example, you can use this method to search for all service requests of a 
particular severity you must respond to by the end of the month. 

To find a service request using ranges of values:
1. Display the Search Service Request window by one of the following methods:

■ From the Navigator, navigate to View Service Requests

■ If you already have the Service Request window open, click Find in the 
toolbar. This is the icon with a searchlight.

2. Select the Advanced tab.

3. Define the logical condition(s) to be satisfied for identifying and retrieving 
service request(s). You can build your arguments around customer number, 
contact name, or severity level. To define an argument:

a. Select the term. 

b. Select a logical operator.

c. Select the value.

4. Click Search to find matching service request(s) based on the arguments you 
specified.

9.6 Copying a Service Request
You can create a new service request by using the Copy Service Request function to 
copy the information from an existing service request.

Note: The AND operator is used in the background to create a 
complex argument if you define more than one condition. All the 
conditions must be satisfied.
                                                                    Managing Service Requests 9-13



Copying a Service Request
To copy a service request:
1. Navigate to the Service Request window.

2. Display an existing service request.

3. From the Tools menu, select Copy Request. 

The Copy Service Request window appears.

4. You can change any of the defaulted information for the new request. This 
includes Type, Severity, Owner, Urgency, Customer, Account, and Summary.

5. Select the check boxes corresponding to the information you wish to copy into 
the new service request.

6. If you wish the new request to reference the original, then select the Create 
Reference Link.

This option creates a link of type Refers to in the original and Reference for in 
the copy. 

7. If you do not wish to create a link, then select the No Link radio button.

8. If you wish to designate the original as a duplicate of the new service request, 
then select the Create Duplicate radio button. 

The application creates a Duplicate of link in the original and a link of type 
Original for in the copy. 

9. Click Copy. 
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The application creates and displays the new service request.

9.7 Selecting a Customer for a Service Request 
Use this procedure to select a customer in the Service Request window using a 
unique identifier. The list of these entry points includes the customer’s name, 
account number, contract number, and the serial number of a piece of equipment 
recorded in the customer’s installed base.

Prerequisites
The customer record must already exist in the database. If it does not then create it 
in the Contact Center according to the procedure outlined in Creating a New 
Customer on page 3-14.

To select a customer for a service request:
1. Navigate to Create Service Requests.

The Service Request window appears.

2. Select a customer type using the Customer Type drop-down list: 

■ Organization: if your customer is a business or organization

■ Person: your customer is a consumer.

Your selection restricts the lists of values. 

3. Search for and select the customer using the list of values in any of the 
following entry points located in the Service Request window header:

Note: If you with to search for a customer using a contact, you 
cannot search by employee contacts.

Entry Point Description

Account Any customer account

Contact Email Any customer contact e-mail address

Contact Last Name Customer contact’s last name
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9.8 Viewing a Profile of Your Customer
Use this procedure to view key information about a customer, such as the numbers 
of high priority and escalated service requests or the number of expiring contracts. 
A customer profile provides you with a summary of key customer indicators set up 
by your application administrator.You can view a list of the individual items that 
make up each indicator and to access any of the listed items. 

Contact Number Customer contact’s identifying 
number in the Oracle E-Business 
Suite

Contact Phone Any customer contact phone

Contract Any contract with the customer

Customer Email Any customer e-mail

Customer Name Customer name

Customer Number Customer’s identifying number in the 
Oracle E-Business Suite

Customer Phone Any customer phone number

Instance Oracle Install Base instance number

Serial Number Serial number of an item in Oracle 
Install Base.

System Number of a system in Oracle Install 
Base.

Contact Address Customer contact’s address

Customer Address Customer address

Tag Oracle Install Base tag

Note: Fields in the service request header may be hidden from 
view. If the field you are looking for is not visible, click the 
Maximize or Minimize the Header button located at the top right of 
the window. This is the right-arrow button to the right of the Profile 
button.

Entry Point Description
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Prerequisites
Your organization must define customer profiles before they can be viewed in a 
service request. For information, please refer to Setting Up Customer Profiles in the 
Oracle TeleService Implementation Guide.

To view a customer profile:
1. Navigate to the Service Request window. 

2. Create or display a service request.

3. Click Profile. 

The Profile window displays the predefined key indicators for this customer.

4. The profile information was last refreshed at the time and date listed in the 
window. If you wish to update the information, then click Refresh.

5. To view a list of any of the summarized items, double-click on any of the 
indicators. For example, double-clicking on "Escalated SRs", displays the a list 
showing all escalated service requests for the selected customer.
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6. To view the details of an individual item on the list, double-click on it. The item 
opens in an application window. For example, clicking on a service request 
opens that service request in the Service Request window. 

9.9 Viewing Item Details and Entering the Item in the Service Request
Use this procedure to view details of an item in inventory or installed base and to 
enter it into the service request.

To view product details:
1. Navigate to the Service Request window. 

2. Display the customer. See Selecting a Customer for a Service Request on 
page 9-15.

3. To enter an inventory item, use the Item or Desc lists of values (LOV) in the 
header. The Item LOV permits you to search by inventory number; the Desc 
LOV by the item description.

4. To enter an item registered in the Oracle Install Base, use the lists of values in 
the serial number, the instance number, or the system number fields in the 
Service Request window header. You can also search for an installed base item 
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by clicking Find to the right of the Item field. This is the button with a flashlight 
icon. See Searching for and Displaying Installed Base Items on page 9-21.

Information about the item displays on the Product Coverage tab.

5. If you wish to view or change a product’s configuration using Oracle Install 
Base, click Product Configuration. 

The product details display in the Product Configuration page in your browser 
window.

6. Click Save on the toolbar if you wish to enter this item into the service request.

9.10 Checking a Customer’s Contract Coverage
Use this procedure check a customer’s entitlements. 

Prerequisites
Your organization must have all of the customer products, contracts, and coverages 
defined before they can be viewed in a service request.

To view customer’s contract coverage:
1. Navigate to the Service Request window. 

2. Display the customer. See Selecting a Customer for a Service Request on 
page 9-15.

3. If you wish to check coverage for an item in inventory, then use the Item or 
Desc lists of values (LOV) in the header to enter it. The Item LOV makes it 
possible for you to search by inventory number; the Desc LOV by description.

4. If you wish to view the customer’s coverage for an item in the installed base, 
then enter the serial number, the instance number, or the system number of the 
item in the Service Request window header. If you wish to search for the item 
instead, then click Find to the right of the Item. This is the button with a 
flashlight icon. See Searching for and Displaying Installed Base Items on 
page 9-21.

5. If a customer has multiple accounts, then enter the account number in the Acct 
Num field in the Customer region of the Contact Center header. This entry is 
important if a customer chooses different contracts to cover different accounts.

6. Select the Product Coverage tab. 
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7. To search only contracts in effect, make sure the Active Contracts radio button 
is selected. If you wish to search all contracts, including those no longer in force, 
then select the All Contracts radio button.

8. Click Get Contracts.

The contracts are displayed in the Contracts region of the tab. 

Warranties display a check mark in the Warranty check box.

The window displays only two contracts at a time. You can scroll to view 
additional contracts using the scroll bar to the right.

9. If you wish to view coverage details for any contract, then select the contract 
and click View Details (the button with the eyeglasses icon to the right of the 
Coverage column).

Details of the contract appear in the Service Contracts Coverage window. These 
include the hours of coverage, the resolution times, and billing rates. 

10. If you wish to apply one of the contracts to the service request, then select it 
using the check box on the left of the desired row. 
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Selecting a contract populates the service request with information designed to 
help your organization meet its contractual obligations. This may include the 
required time by which your organization must resolve the issue (displayed in 
the Resolution By field), and the preferred resources who are to help the 
customer.

9.11 Searching for and Displaying Installed Base Items
Use this procedure to search for and display an item in the customer’s or 
employee’s installed base. The application searches through items tracked by both 
the Oracle Install Base and Oracle Enterprise Install Base.

To search for and display installed base items:
1. Navigate to the Service Request window. 

2. If you wish to narrow down the search by customer, then display the customer. 
See Selecting a Customer for a Service Request on page 9-15.

3. Click Find to the right of the Item field in the service request header. This is the 
button with a flashlight icon.

The Search Installed Base window appears.
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4. If you wish to search using one or more search terms, then select the Basic tab 
and enter one or more search terms in the Product Information region.

5. If you wish to search for an installed base item by range of values for order 
number, revision, serial number, or serviced status, then:

a. Select the Advanced tab.

b. Define one or more logical condition for the search by entering a term, a 
logical operator, and a value. For example: Order Number > 2001.

6. Click Search.

The installed base items display at the bottom of the window. 

7. Select an item you wish to enter in the Service Request window, and click OK 
or repeat the search with different criteria.

Note: The AND operator is used in the background to create a 
complex argument if you define more than one condition. All the 
conditions must be satisfied.
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9.12 Assigning Ownership of Service Requests
This topic outlines the various methods you can use to assign ownership of a 
service request. 

It covers.

■ Ownership Overview on page 9-23.

■ Assigning Service Request Ownership Manually on page 9-24

■ Assigning Ownership Assisted by Oracle Assignment Manager on page 9-24

■ Assigning Service Request Ownership Automatically on page 9-25

9.12.1 Ownership Overview
A service request owner coordinates the satisfactory resolution of a customer’s 
service request. Service request ownership is unrelated to task ownership, so 
assigning a service request does not assign any of the related tasks. 

You can assign service request ownership to any group or individual defined in the 
Oracle Resource Manager. Which ownership you decide to assign depends on your 
organization’s business practices. Some organizations may prefer to assign work to 
the group and permit individual agents to take ownership themselves based on 
their work load and availability; other organizations may prefer to assign service 
requests to individuals directly. 

Assigning a service request to a group or an individual lists that service request in 
that individual’s and group’s work queue in the Oracle Universal Work Queue 
under the Service Request heading:

■ All members of a group see a service request assigned to that group under the 
Group Owned heading regardless whether that service request has also been 
assigned to an individual in that group.

■ An individual who has been assigned a service request, sees the service request 
both under My Service Request and Group Owned headings. 

■ Unassigned service requests do not appear in the Universal Work Queue at all. 

Your organization can set up automatic notifications to alert agents when a service 
request has been added to their work queue. For more information see Setting Up 
Notifications in the Oracle TeleService Implementation Guide.

You can assign service request ownership either to groups or to individuals within 
your organization in one of three ways:
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■ Manually, using the lists of values on the Service Request window 

■ Assisted by Oracle Assignment Manager

This method makes it possible for you to search for resources based on 
individual resource skills, availability and service territories.

■ Automatically, using the automatic assignment and work-load balancing 
feature of Oracle TeleService. 

9.12.2 Assigning Service Request Ownership Manually:
You can assign service request ownership to a group or an individual using the 
Group and Owner lists of values located in the right-hand column of the service 
request header. A manual entry prevents the automatic assignment process for 
assigning ownership.

Selecting a group owner first restricts the list of values of individual owners to the 
members of that group.

Prerequisites
Owners must be set up resources in the Oracle Resource Manager. 

To assign a service request using the lists of values:
1. Display the service request you wish to assign in the Service Request window.

2. Use the Group list of values (LOV) to assign the group.

3. If you wish to assign the service request to a particular individual in the group, 
then use the Owner LOV. 

9.12.3 Assigning Ownership Assisted by Oracle Assignment Manager
You can use the Oracle Assignment Manager to suggest appropriate resources by 
displaying:

■ Preferred Resources in Oracle Service Contracts and Oracle Install Base

■ Individuals assigned to appropriate service territories.

To assign service requests using the Oracle Assignment Manager:
1. Display the service request you wish to assign in the Service Request window.

2. If you wish to assign the group owner, then click Group Owner. This is the 
button immediately to the right of the Group field.
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3. If you wish to assign the individual and group owner, then click Assign Owner. 
This is the button immediately to the right of the Owner field.

The Assignment Manger window appears.

4. On the left side of he window, select the check boxes for the criteria you wish 
the Oracle Assignment Manager to use to suggest possible owners. If you select 
to use service territories, then select which criteria you wish to use.

5. Click Search.

The application returns the list of qualified resources in the grid on the right 
side of the window. If no resources are suggested, then repeat the search with 
different search criteria.

6. Select a resource from the list.

7. Click OK.

9.12.4 Assigning Service Request Ownership Automatically
If your organization has implemented automatic assignment of service requests, 
you can have the application assign service request ownership to groups and 
individuals automatically.

The automatic assignment process starts immediately after a service request is 
created. Service requests that have been updated are assigned by a concurrent 
program your application administrator must set to run on a regular basis. 

Automatic assignment takes the skills and work load of each individual resource 
into account when identifying the optimal owner. For more information see Setting 
Up Service Request Autoassignment and Load Balancing in Oracle TeleService 
Implementation Guide.

To assign ownership automatically:
1. Display the service request you wish to assign in the Service Request window.

2. If you wish the application to automatically assign ownership to a group and an 
individual, then delete any entries in the Owner and Group fields.

Note: If the Assign Owner or Assign Group buttons are disabled, 
then click in the Group or Owner fields first to enable them.
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3. If you wish the application to assign the service request to an individual within 
a group, then enter the Group and leave the Owner field blank.

9.13 Using Notes in Service Requests
This topic describes how to view and create notes for service requests. It covers:

■ About Notes in Service Requests on page 9-26

■ Creating a Note for a Service Request on page 9-27

■ Viewing a Log of Notes for a Service Request on page 9-28

■ Searching for Notes by Text on page 9-29

9.13.1 About Notes in Service Requests
You can use notes to:

■ Keep notes that can be viewed by all agents working to resolve the customer 
problem.

■ Keep personal notes. 

■ Enter additional search terms for knowledge base searches.

■ Communicate with customers who use Oracle iSupport to review their service 
requests. See Communicating Through the Web on page 8-16 for details.

After you save a note you cannot edit or delete it, but you can change its type and 
status. All notes you create in a service request are automatically linked to the 
service request, so they are not visible to agents viewing the customer record in the 
contact center.

Who gets to view notes in a service request is controlled by the note’s status: 

■ Private - Only the agent who created the note can view it.

■ Public - All agents with access to the service request can view the note.

■ Publish - All agents with access to the service request can view the note as well 
as customers who review the service request using Oracle iSupport.

If you print a service request, you have the option of selecting which note status 
should be included on the printout. 
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9.13.2 Creating a Note for a Service Request
Use this procedure to create a note for a service request. 

To create a note:
1. Navigate to the Service Request window.

2. Create a service request or display an existing service request.

3. Select the Workbench tab.

4. Click New.

5. Select a note type using the Type list of values (LOV). If you wish to use the 
note you enter to search for possible solutions, then make sure you select a note 
type that is mapped to an Oracle Knowledge Base Type. By default the mapped 
types are: Symptom, Cause, Action, Changes, and Objective.

Using notes as extra search terms makes it possible for you to make your 
knowledge base search more specific. For example, when you create a note of 
type Symptom, the application uses that note to search only knowledge base 
statements of the same type.
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6. Select a status for the note from the Status drop-down list:

■ Private: Keeps the note private

■ Public: Makes the note available for viewing to others in your organization

■ Publish: Makes the note available for viewing to your organization and to 
customers

7. Enter a short text in the Note field.

8. If you want to enter additional note text, then:

a. Click Details.

The Note Details window appears. 

b. Enter text of up to 32,000 characters in length. 

c. Click Save on the toolbar.

d. Click OK to return to the Notes tab. 

9. Click Save on the toolbar.

The note you created appears in the in the Notes and Knowledge region.

9.13.3 Viewing a Log of Notes for a Service Request
Use this procedure to view a log of all the notes for a service request. If you wish to 
search for a specific note then follow the procedure outlined in Searching for Notes 
by Text on page 9-29.

Note: You can also enter a short note while viewing notes in the 
Log Notes window which is available from the Workbench tab by 
clicking View Log. To create a note in the Log Notes window, click 
New in the toolbar.

Note: The additional text you enter in the Note Details window is 
not visible in the notes log or notes summaries, and is not used by 
the application for knowledge base solution searches. You cannot 
search on this text.
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To view service request notes:
1. Display the service request in the Service Request window.

2. If you wish to view the notes in a service request, then:

a. Select the Log tab.

b. Select the Notes check box and clear all of the other check boxes.

c. Click Refresh. 

The notes related to the service request are displayed in the tab. 

d. If you wish to display them in a browser window ready for printing, then 
click Print Friendly Format.

9.13.4 Searching for Notes by Text
Use this procedure to search for a note by text.

To search for notes by text:
1. If you are searching for a specific note in a service request displayed in the 

Service Request window, then:

a. Select the Workbench tab.

All notes are listed in the Note and Knowledge region on the left of the tab. 

b. Right-click in the Description field and select Find from the pop-up menu.

c. Enter the term you are searching for in the Find What field of the find 
window, select any options, and click Find.

2. If you wish to search notes in all service requests, then:

a. Navigate to Service Requests > View Service Requests or click Find in the 
toolbar.

The Search Service Request window appears. 

Note: You can also view notes in the Log Notes window which 
you can display by clicking Details in the Workbench tab.

Note: You cannot search for text entered in the Note Detail 
window.
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b. In the Text Search region of the Basic tab, select the search method using the 
Options drop-down list. Available options are: 

* Any Word: Returns service requests with notes containing any of the 
terms you enter

* All Words: Returns service requests with notes containing all of the 
terms you enter.

* Phrase: Returns service requests with notes containing the exact phrase 
you enter.

c. Select the Notes check box.

d. Enter the search term(s) in the Keywords field.

e. Click Search.

f. The list of service requests that contain a note of 

g. Enter the term you are searching for in the Find What field of the find 
window, select any options, and click Find.

9.14 Searching the Knowledge Base and Suggesting Solutions
This topic explains how you can search your organization’s knowledge base for a 
solution to the problem you have described in a service request and suggest 
possible solutions to other agents and customers. 

This topic covers:

■ About Searching the Knowledge Base from a Service Request on page 9-30

■ Searching the Knowledge Base on page 9-31

■ Viewing Suggested Solutions for a Service Request on page 9-32

■ Removing Suggested Solutions on page 9-33

9.14.1 About Searching the Knowledge Base from a Service Request 
When you initiate a knowledge base search from the Workbench tab of the Service 
Request window, the application uses the following information you have entered 
as search criteria:

■ Keywords and phrases you enter as the problem summary

■ Item or installed base item you have entered in the service request
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■ Any notes of types that are mapped to Oracle Knowledge Management. By 
default these note types are: Symptom, Cause, Action, Changes, and Objective. 

Your search lists all potential solutions in a browser window. You can view each 
solution and indicate whether it is useful, not useful, or potentially useful by 
answering the question "Can this solve your problem?". 

Answering Yes, No, or Maybe, automatically links the solution to the service 
request. It appears in the table of notes and knowledge base items in the Notes and 
Knowledge region of the tab.

If your organization has implemented notifications, your customer can be 
automatically notified by e-mail whenever an agent links a solution to the service 
request.

The answer you give translates into a value in the Outcome field as follows:

If you answer Maybe, the solution is also automatically listed as a potential solution 
to a customer reviewing the service request on their Oracle iSupport Web portal. For 
additional information on searching and searching options see the Oracle Knowledge 
Management User Guide.

9.14.2 Searching the Knowledge Base
Use this procedure to search the knowledge base for solutions to the service request 
problem.

Prerequisites
■ Oracle Knowledge Management must be implemented.

■ You must create a service request first. 

To search the knowledge base and suggest a solution:
1. Display the service request in the Service Request window. 

2. Select the Workbench tab.

Knowledge Base Answer Oracle TeleService Outcome

No Not Useful

Maybe Possibly Useful

Yes Useful
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3. Enter any additional information that may help you find the solution:

■ Item or installed base item

■ Additional search terms in the Problem Summary field

■ Additional notes.

4. Click Knowledge Base. (This is the button located to the right of the Problem 
Summary field).

The Oracle Knowledge Base’s Solution Advanced Search page opens in a 
browser window displaying the possible solutions to the problem in the Results 
region at the bottom.

5. To view any solution:

a. Click View (the glasses icon to the right of the solution).

The solution displays in the Solution Detail page.

b. If you are troubleshooting the problem with the customer, then indicate the 
usefulness of the solution by clicking one of the buttons below the question 
"Can this solve your problem?" at the bottom of the page. Any answer links 
the solution to the service request and lists it in the Notes and Knowledge 
listing on the left side of the Workbench tab:

* Yes: Indicates the solution helped you to solve the problem. This 
selection increases the ranking of a solution on subsequent searches.

* No: The solution did not help you. This decreases the ranking of this 
solution on subsequent searches. 

* Maybe: You or the customer has not tried the solution, but you want to 
suggest it as a potential solution. 

Clicking this button makes the solution visible to the customer on the 
Oracle iSupport Web portal. 

If your organization has set up the appropriate automatic e-mail notifi-
cations, the customer contacts for the service request will receive 
e-mails alerting them of the suggestion.

9.14.3 Viewing Suggested Solutions for a Service Request
Use this procedure to view suggested knowledge base items linked to service 
requests.
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To view suggested solutions for a service request:
1. Display the service request in the Service Request window. 

2. Select the Workbench tab.

The Notes and Knowledge region lists both notes and knowledge base solutions 
attached to the service request.

3. Click Refresh to make sure that you are viewing the latest items.

4. To view a list of all linked knowledge base solutions, click on the Solution 
Number column heading to sort all of the knowledge base items together. You 
may have to scroll to the right to see this column. Knowledge Base solutions 
carry identifying solution numbers; the Notes do not. 

5. Select a solution you wish to view in the list. 

The Outcome field tells you if the solution has been tried and proven useful to 
agents. The possible values are:

■ Not Useful: Tried and not useful.

■ Possibly Useful: Not tried yet, but possibly useful.

■ Useful: Tried and useful

6. If you wish to view the knowledge base solution, then click Details.

The solution displays in a browser window.

9.14.4 Removing Suggested Solutions
Use this procedure to remove suggested solutions from a service request.

Prerequisites
Solutions must already be linked to the service request.

To view suggested solutions for a service request:
1. Display the service request in the Service Request window. 

2. Select the Workbench tab.

The Notes and Knowledge region lists both notes and knowledge base solutions 
attached to the service request.

3. Click Refresh to make sure that you are viewing the latest items.
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4. To view a list of all linked knowledge base solutions, click on the Solution 
Number column heading to sort all of the knowledge base items together. You 
may have to scroll to the right to see this column. Knowledge Base solutions 
carry identifying solution numbers; the Notes do not. 

5. Select a solution you wish to remove in the list. 

6. Click Delete. 

The solution is removed from the list of solutions linked to the service request 
and from suggested solutions for the customer in Oracle iSupport. This does not 
delete it from the knowledge base.

9.15 Viewing the Service Request Log
Use this procedure to view a chronological list of all activities, tasks, and notes for a 
service request, as well as all changes to the audited fields, and all linked 
knowledge solutions. 

Prerequisites
You must save the service request before you can view the log.

To view the customer service request log:
1. Navigate to the Service Request window and display an existing service 

request. 

2. Select the Log tab. This tab displays the history associated with the service 
request in a scrollable window.
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3. Select one of the following check boxes to display the type of information you 
want to view:

■ All - displays all activities.

■ Audit - displays changes to the Type, Severity, Status, Summary, Group 
Type, Group, Individual Type, Individual and Product fields.

■ Notes - displays all notes.

■ Knowledge - displays knowledge documents linked to this service request.

■ Activity - displays all interactions 

■ Task - displays all tasks.

■ Latest First - reverses the chronological order.

4. Click Refresh to view the selected items. 

5. If you want to print the activity shown in the log, click Print Friendly Format to 
display the in a browser window.
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9.16 Adding Service Request Contacts
Use this procedure to select contacts for a service request. Service request contacts 
can be either customer contacts or employees of your own organization. If your 
implementation has implemented automatic notification via e-mail the contacts you 
list here can be automatically kept informed about the progress of the service 
request toward resolution. The contact you designate as primary displays in the 
Service Request window header.

Prerequisites
Contacts must be defined before they can be associated with service requests. For 
information about adding customer contacts see Creating a New Contact on 
page 4-10.

To add a contact to a service request:
1. Navigate to the Service Request window and create a service request or display 

an existing service request.

2. Select the Contacts tab. 
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3. Select a contact type: either Customer or Employee (for employees of your 
organization).

4. Select a contact either using the last or first name list of values.

5. You can indicate if the contact is the primary contact by selecting the Primary 
check box. The primary contact information is what is displayed in the Service 
Request header. 

6. Click Save on the toolbar.

9.17 Selecting Billing, Shipping, and Installed At Parties and Addresses 
Use this procedure to select the parties and addresses for installation, billing, and 
shipping. You can enter different parties for billing, shipping, and installation. 

The entries you make here are automatically defaulted for the charge lines for this 
service request. You can select individual addresses for each charge line in the Bill 
To and Ship To address subtabs of the Charges tab. See Creating a Charge Line on 
page 11-7.

Prerequisites
You cannot enter new addresses in the Service Request window, so you must create 
them first in the Contact Center as described in Adding a New Address and Site for 
a Customer on page 3-8.

To select a customer address:
1. Display a service request in the Service Request window. 

2. Select the Addresses tab.

3. Go to the appropriate region in the Addresses tab: Bill To, Ship To or Installed 
At. 

If the service request is logged against a customer product in Oracle Install 
Base, the Installed At address defaults from that record.
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4. To select a different party or address for installation, billing, and shipping:

a. Select the appropriate party from the Party list of values. The Party list of 
values displays all related parties, filtered by the customer type selected in 
the service request header. 

b. Select an address from the list of values.

5. Click Save in the toolbar.

9.18 Managing Service Request Tasks
This group of topics describes how to create and manage service request tasks, the 
units of work required to fulfill the customer request. For example, you can create a 
task to call back a customer about the service request or a task for a service engineer 
to make a repair at a customer site. 

The task functionality in Oracle TeleService is provided by the Tasks module which 
is a part of the Oracle E-Business Suite foundation. The Tasks tab is designed to 
simplify the process of creating a task for service requests.

You can find more detailed information about managing tasks in the Oracle Common 
Application Components User’s Guide.
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The task-related topics include:

■ Creating a Task for a Service Request Manually on page 9-39

■ Creating a Task Using Task Template on page 9-43

■ Entering Task Details on page 9-44

9.18.1 Creating a Task for a Service Request Manually
Use this procedure to create a task manually.

Prerequisites
You can only launch Oracle Workflow processes for task types set up with them.

To create a task manually:
1. Display the service request. 

2. Select the Tasks tab.

3. Use the Type list of values, to select a task type. 
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If you are creating a field service task, a task that will require the dispatch of an 
agent to the customer site, then make sure you select a dispatch task type. Task 
types are set up by your application’s administrator.

The task type determines how the task is assigned and can be set up to launch 
an Oracle workflow process.

4. Select a task status using the Status LOV. If you are planning to assign a field 
service task, then select a status that indicates the task is in progress. 

5. Enter a name for the task in the Subject field.

6. In the Desc. field, enter a brief description of the task.

7. If you wish to display the task for the customer to see on their Oracle iSupport 
Web portal, then select the Publish check box.

8. If needed, in the Parent field, select a task to which this task is to be linked. 
Normally, you would select a parent task if the task you are creating is a follow 
up on another task.

9. If you wish to prevent the service request task from being closed until this task 
is closed, then select the Restrict Closure flag. 

10. Assign task ownership to a group or an individual who will be responsible for 
the completion of the task, such as a dispatcher, (Owner Type and Owner fields) 
and to the individuals or teams who will complete the tasks (Assignee Type and 
Assignee). See Assigning Tasks on page 9-41 for details.

11. Select the Planned Start and End Dates.

12. Click Save on the toolbar. A system generated task number is displayed in the 
Num field.

13. If an Oracle Workflow process is available with this task type, then you can 
launch it by clicking Launch Workflow. The application displays a confirmation 
message. 

14. Click More to open the Task Details window to enter additional assignees and 
other details such as dependencies, references, and contacts. See Entering Task 
Details  on page 9-44 and the Tasks section of the Oracle Common Application 
Components User’s Guide for more information.
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9.18.2 Assigning Tasks
This topic explains how to assign tasks to an owner, the individual or group 
responsible for its completion, and one or more assignees, the individuals or teams 
that carry out the work. It covers: 

■ Task Assignment Concepts on page 9-41

■ Selecting Task Owners and Assignees on page 9-42

9.18.2.1 Task Assignment Concepts
You can assign a task to an owner and one or more assignees. An owner can be an 
individual employee, such as a dispatcher, or a group that is responsible for 
ensuring the task is completed. An assignee can be either an individual employee or 
a team of employees who complete the task. In many cases the owner and assignee 
will be the same person. 

You can either use the lists of values to select the owner and assignee or have the 
software to assist you.

To assign group or individual owners, the Assignment Manager can suggest owners 
based on service territories, availability, and other factors.

For individual assignees, you can get the assistance of either the Assignment 
Manager or, for field service tasks, the Oracle Advanced Scheduler.

The Oracle Advanced Scheduler is an Oracle Field Service module that permits you 
to optimize schedules based on such factors as travel time, work load, and cost. 

The application automatically determines when to display the Assignment Manager 
or the Advanced Scheduler based on the task type you select.

Selecting an assignee or owner puts that task into that individual’s and group’s 
work queue in the Oracle Universal Work Queue under the Tasks heading.

For task ownership:

■ All members of a group see a task assigned to that group under the Group 
Owned heading regardless whether that task has also been assigned to an 
individual in that group or not.

■ An individual who has been assigned the ownership of the task, sees task both 
under My Owner and Group Owned headings. 

For task assignees:
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■ All members of a team that has been assigned the task see the task in the Group 
Assigned heading regardless whether that task has also been assigned to an 
individual in that group or not.

■ An individual who has been assigned the task, sees task both under My 
Assigned and Group Assigned headings. 

9.18.2.2 Selecting Task Owners and Assignees
Use this procedure to assign a task to owners and assignees. 

To select owners and assignees for a task:
1. Display the task you wish to assign in the Tasks tab of the service request.

2. If you wish to assign ownership to a group then select Group Resource from the 
Owner Type list of values (LOV). 

3. If you wish to assign ownership to an individual employee, then instead select 
Employee Resource from the Owner Type LOV.

4. Use the Owner LOV to select the group or individual or click Assignment 
Manager to assist you. This is the icon to the right of the field.

5. If you clicked Assignment Manager, then the Assignment Manager window 
appears:

a. On the left side of the window, select the check boxes for the criteria you 
wish for selecting possible owners. If you select to use service territories, 
then select which criteria you wish to use.

b. Click Search.

The application returns the list of qualified owners in the grid on the right 
side of the window. If no resources are suggested, then repeat the search 
with different search criteria.

c. Select a resource from the list.

d. Click OK.

6. If you wish to assign the task to a team for execution, then select Team Resource 
from the Assignee Type LOV.

Note: See the Assignment Manager chapter of the Oracle Common 
Application Components User’s Guide for more information.
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7. If you wish to assign the task to an individual employee for execution, then 
select Employee Resource.

8. Use the Assignee LOV to select the team or employee assignee or click 
Assignment Manager to get assistance either from Assignment Manager or 
Oracle Advanced Scheduler modules. Which module appears depends on the 
task type you selected:

9. If the task you are assigning is of a field service Type (for example, Dispatch) 
and of a schedulable status (for example, In Process) then the Oracle Advanced 
Scheduler window appears. See the Oracle Advanced Scheduler User Guide for 
information on scheduling resources. 

10. If the task is not of a field service Type, then you can use the Assignment 
Manager to assign a resource in the same manner as the owner.

11. If you wish to assign the task to multiple individuals, then you can add 
additional assignees by clicking More and following the procedure outlined in 
Defining Resource Requirements on page 9-45.

9.18.3 Creating Tasks Using a Template
Use this procedure to automatically create the set of tasks required to take care of 
the customer problem. 

The application creates the tasks by using a set of task templates, called a Template 
Group, which are set up by the application administrator.

Prerequisites
Template groups must be set up first according to instructions found in the Oracle 
Common Application Components Implementation Guide.

To create tasks using a task template:
1. Open the Task tab in the Service Request window.

2. Click Use Template in the Task tab.

Note: To schedule a task using Oracle Advanced Scheduler, the 
task must be of a task type and status that is set up as schedulable. 
Contact your application administrator for a list of appropriate 
field service task types.
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3. The Create Tasks from Template Group window opens.

 

4. In the Template Group field, select the template group based for the tasks you 
want created. 

The Source Document field displays Service Request as the tasks are being 
created for a service request.

Source Value populates with the service request number. You can select a 
different service request number if you wish to create the tasks for a different 
service request.

5. Owner Type and Owner fields are defaulted from profile options Task Manager: 
Owner Type for Task and Task Manager: Default Task Owner. You may change 
these values, if needed. Owners are responsible for ensuring the tasks are 
completed.

6. Click Create Tasks.

The Tasks tab displays the different tasks that have been created. You can assign 
them to the assignees that will carry them out.

9.19 Entering Task Details
This topic covers the entering of task details such as resource assignments, 
dependencies, references, and contacts.

It covers:

■ Defining Resource Requirements on page 9-45

■ Setting Task Dependencies on page 9-46
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■ Linking Tasks to Source Documents on page 9-46

■ Setting Recurrence Schedules on page 9-47

■ Viewing Task Audit History on page 9-47

For information on the other tabs of the Task Detail window, please refer to the 
Oracle Common Application Components User’s Guide.

9.19.1 Defining Resource Requirements
Use this procedure to assign a task to multiple assignees and to specify resources 
such as the tools needed to complete a task. 

To define resource requirements:
1. Open the Task Detail window by clicking More in the Task tab.

2. Select the Resource tab.

3. In the Resource Type field, select the resource type needed to solve the customer 
issue.

4. In the Unit field, enter a unit of measure for the resource, for example, three 
hours. 

5. Select the Enabled check box if it is not already checked by default.

6. In the Assignments region, select from the list of values in the Type and Name 
fields.

7. Select the status of the task in the Status field.

8. If you want to schedule a resource, select the Schedule check box. To complete 
scheduling:

a. Enter scheduled distance and duration values, and select a unit of measure.

b. If you want to update actual schedule information, enter the actual Start 
and End dates.

c. You may use the Assignment Manager to select and schedule the resource. 
To open the Assignment Manager, click the Assignment Manager icon in 
the toolbar.

9. Click OK to save your work.
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9.19.2 Setting Task Dependencies
Task dependencies store the desired order among tasks. 

Prerequisites
You must create a task before you can set dependencies for it. 

To set task dependencies:
1. From the Task Detail window, select the Dependencies tab.

2. Select the dependent task number from the list of values in the Task Number 
field. The task name is automatically displayed.

3. Enter a numerical value in the Offset field. This value determines the time that 
separates the action of initial tasks from subsequent tasks. Use this feature to 
organize tasks with time sensitive restrictions.

4. Select a unit of measure in the UOM field.

5. Click OK.

9.19.3 Linking Tasks to Source Documentation
Creating references to a source document allows you to reference pertinent 
background information. Source documentation could be the original service 
request that resulted in the creation of a task.

To link a task to its reference document:
1. From the Task Detail window, open the References tab.

2. Select from the list of values in the Document Type field. 

3. Enter the identification number of the source document in the Number field.

4. Optionally, enter a reference type in the Type field.

5. Click OK.

Note: The task dependencies you enter here are not enforced by 
Oracle E-Business Suite applications. You must supply your own 
customization to use this feature.
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9.19.4 Setting Recurrence Schedules
If the task is to be performed on a regular basis, you may specify a daily, weekly, 
monthly, or yearly schedule.

To set a recurrence schedule for a task:
1. From the Task Detail window, select the Recurrences tab.

2. Select the frequency for the recurrence of the task by selecting the Daily, Weekly, 
Monthly, or Yearly button. Your selection determines the fields available in the 
Recurrences tab.

3. In the Start field, select the date after which the task is to be repeated.

4. Optionally, in the End field, select the date after which the task will not be 
performed.

5. Set the recurrence schedule.

6. Click OK.

9.19.5 Viewing Audit History for the Task

Select the Audit tab of the Task Detail window to view a log of changes that have 
been made to the task.

9.20 Viewing Interactions and Activities
Use this procedure to view the interactions and activities related to the service 
request.

An interaction comprises all the activities between the time agents receive a call or 
start an interaction until they end the interaction or wrap up the call. An interaction 
can have multiple activities. Some activities, including service request updates, the 
creation of associated tasks, and the sending of e-mails, are automatically recorded 
by the application. Agents can add information on other activities, such as customer 
meetings and visits, in the Call Wrapup window. 

To view customer interactions and activities:
1. Navigate to the Service Request window and display an existing service 

request.
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2. Select the Interactions tab. The Interaction tab lists the interactions your 
organization has had with the customer regarding the service request.

3. To view the activities for an interaction, select it in the upper half of the tab. 

4. If an activity involved the sending of an e-mail, then you can view the e-mail 
sent by double clicking on the activity of type "Composed a new outbound 
e-mail." See Viewing E-mails Sent Regarding Specific Service Requests on 
page 8-11 for a description of how to find and view sent e-mails.

9.21 Specifying Relationships to Other Service Requests and Objects
This group of topics describes how you can record the relationship of the service 
request you are working on to another service requests or to other Oracle 
E-Business Suite objects, such as equipment maintenance plans. Recording a 
relationship makes it possible for other agents to view the related information with 
the click of a mouse.

This topic covers:

■ About Service Request Relationships on page 9-49

■ Specifying a Relationship to Another Service Request or Object on page 9-52
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■ Specifying One Service Request is a Duplicate of Another on page 9-53 

■ Viewing Linked Service Requests and Other Objects  on page 9-54

9.21.1 About Service Request Relationships
You can use relationships to indicate, for example, that one service request is a 
duplicate of the other, that one is the cause of another, or that it contains relevant 
information for the resolution of another. For each service request, you can indicate 
multiple relationships to other service requests and Oracle E-Business Suite objects, 
such as maintenance plans, invoices, orders, and the like. 

You can specify six types of relationship types of one service request to another: 

■ Caused by

■ Root cause of

■ Duplicate of

■ Original for

■ Reference for

■ Refers to

You can only use the last two relationship types to link service requests to other 
E-Business Suite objects:

■ Reference for

■ Refers to

Because a relationship between two objects is reciprocal, the relationships come in 
pairs. When you specify a relationship, the application automatically supplies the 
reciprocal relationship on the object you are linking to:

■ Caused by /Root cause of

■ Duplicate of /Original for

■ Reference for / Refers to

Note: All Oracle E-Business Suite object types other than service 
requests must be enabled by your application administrator. 
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For example, if you specify that service request A refers to service request B, then 
the application supplies the "Reference for" link for B. An agent viewing B can see 
the link to A and can open A with a couple of clicks of the mouse.

In addition to supplying the reciprocal link, two of the relationship pairs also affect 
the status of one or both of the service requests:

■ Caused by/Root cause of

■ Duplicate of/Original for

For example, if you specify that requests A and B are caused by service request C, 
then closing C closes A and B as well. 

The breakdown of a major system can sometimes cause multiple customer contacts 
to report the same problem. The status propagation permits the service organization 
to deal with all the duplicate service requests all at the same time.

The following table explains the three most frequently used relationship types. The 
Action column explains the relationship and describes the actions the application 
takes, including changes in service request status and any reciprocal links created 
automatically. The Example column gives examples of how these relationships can 
be used in practice.

Note: Status propagation is available only for linked service 
requests, not to other E-Business Suite objects.
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Relationship Action Example 

Caused by Linking service request A to service 
request B using a “Caused by” 
relationship indicates that A is caused 
by B. 

The application:

■ Sets the status of A to “Waiting”.

■ Creates the reciprocal link “Root 
Cause of” for B.

When B is set to the status of 
“Closed”, then the status of A is 
automatically set to “Clear”.

If multiple service requests are 
“Caused by” B, then all are set to 
“Clear”.

Problem:

A customer contact calls to say his e-mail is not 
working. The support agent discovers that the system 
administrator has already logged a service request to 
track this problem. The contact's e-mail is not working 
because the e-mail server is down.   

Resolution:

The agent creates a “Caused by” link between the 
contact’s service request and the service request 
already logged for the e-mail server problem. The 
application automatically sets the status of the 
contact’s service request to “Waiting”.

When the system administrator resolves the e-mail 
server failure and closes the server problem service 
request, then the application automatically updates the 
contact’s service request status to “Clear”. 

Duplicate of Linking service request A to service 
request B with the “Duplicate of” 
relationship indicates that A is a 
duplicate of B.

The application automatically:

■ Creates an “Original for” link 
from B to A.

■ Changes the status of A to 
”Closed” with the resolution 
code “Closed as Duplicate”.

All call center agents have been notified of the e-mail 
outage. Subsequently, an employee logs a ticket to 
report the e-mail outage. 

The agent who is assigned to work on the service 
request identifies it as a duplicate and enters the 
“Duplicate of” link.

The application automatically closes the employee’s 
service request with the resolution code of “Closed as 
Duplicate” and a reference to the service request 
already logged for the e-mail outage.

Refers to If service request A “Refers to” 
service request or document B, this 
means that B has information relevant 
to A.

The application automatically creates 
the reciprocal “Reference for” 
relationship from B to A provided 
both documents are service requests. 

You can use this type of relationship 
for linking a service request to 
another object, such as a maintenance 
plan.

An agent working on a service request remembers that 
he created a similar service request for another 
customer. By creating a link to that old service request, 
he makes it possible for others to refer to it. 
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For a detailed explanation of the service request relationships, please see Setting Up 
Service Request Linking Through Relationships in the Oracle TeleService 
Implementation Guide.

9.21.2 Specifying a Relationship to Another Service Request or Object
Use this procedure to specify a relationship between a service request and another 
service request or another Oracle E-Business Suite object. If you wish to indicate 
that one service request is a duplicate of another, then instead follow the procedure 
described in Specifying One Service Request is a Duplicate of Another on page 9-53.

Prerequisites
You must know the identifying number for the object you are linking to. If you wish 
to specify a relationship to another service request, for example, then you must 
know the service request number. See Searching For a Service Request on page 9-9 
for information on searching for service requests.

Examples of other identifying numbers include a purchase order number or an 
invoice number.

To specify a relationship link to another object:
1. Navigate to the Service Request window and display a service request.

2. Select the Related Objects tab.
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3. If you wish to record a relationship to another service request, then in the 
Related Service requests region:

a. Select the relationship from the Relationship list of values (LOV).

b. Select the service request number using the Number LOV.

4. If you wish to record a relationship with another Oracle E-Business Suite object, 
then in the Other Related Objects region:

a. Select the relationship from the Relationship list of values (LOV).

b. Select the identifying number using the Number LOV.

5. Click Save in the toolbar.

9.21.3 Specifying One Service Request is a Duplicate of Another
Use this procedure to specify that one service request is a duplicate of another. 
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Prerequisites
You must know the service request number of the second service request. See 
Searching For a Service Request on page 9-9 for information on searching for service 
requests.

To specify a service request is a duplicate of another:
1. Navigate to the Service Request window and display a service request.

2. Select the Related Objects tab.

3. In the Service Request region, select "Duplicate of" from the Relationship list of 
values (LOV).

4. Select the service request number using the Number LOV.

5. Click Save on the toolbar.

Specifying that service request A is a duplicate of B, automatically creates an 
“Original for” link from B to A and changes the status of A to ”Closed” with the 
resolution code “Closed as Duplicate”.

9.21.4 Viewing Linked Service Requests and Other Objects
Use this procedure to view service requests and other objects with a relationship to 
a service request.

To view linked service requests and other objects:
1. Navigate to the Service Request window and display a service request.

2. Select the Related Objects tab.

Note: You can specify that service request A is a duplicate of 
service request B only if service request A has no existing 
relationship links of type "Duplicate of", "Original for", "Root Cause 
of", and "Caused by". 

This is because:

■ A service request can be a duplicate of only one original.

■ Service requests that are originals for others cannot be chained.

■ Service requests that are the cause of or caused by others will 
cause logical errors in the status propagation.
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3. Click View. This is the button with the glasses icon located on the right.

The selected object opens in a new window. 

9.22 Viewing a List of Service Requests by Customer or by Item
Use this procedure to view a list of service requests for a customer filtered by 
different criteria such as an inventory item or an installed base item. 

To view a list of service requests by customer or by item:
1. Navigate to the Service Request window.

2. Create a service request or display an existing one.

3. Select the Service History tab.

4. Select one of the following filters in the View By drop down list:

Note: If you are viewing a related service request, then that 
service request opens in a new window on top of the existing 
service request.
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■ Instance

Displays all service requests logged against the Oracle Install Base or Oracle 
Enterprise Install Base instance displayed in the service request header. This 
includes all service requests logged by any previous product owners.

■ Instance Component

Displays all service requests logged against the instance component 
displayed in the header. This includes all service requests logged by any 
previous product owners.

■ Instance Sub-Component

Displays all service requests logged against the instance sub-component 
displayed in the header. This includes all service requests logged by any 
previous product owners.

■ Item

Displays a list of service requests for the item and customer specified in the 
header region.

■ Item Component

Displays a list of service requests for the item component and customer 
specified in the header region.

■ Item Sub-Component

Displays a list of service requests for the item sub-component and customer 
specified in the header region.

5. Click Refresh to display the list.

9.23 Printing a Service Request
You can display a service request with all notes and complete audit trail in a 
browser window so it is ready to print by clicking the Print Friendly Format button 
which is available in two places:

■ The Log tab of the Service Request window

■ The Log Notes window

You can also display a summary of the service request, without notes or audit trail, 
by selecting Print Request from the Tools menu regardless which tab of the Service 
Request window you are working on.
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To print a service request:
1. Display a service request you wish to print in the Service Request window.

2. Select the Log tab.

3. Click Print Friendly Format.

The service request displays in a browser window formatted for printing.

9.24 Closing a Service Request
This topic explains how you can close a service request. All actions are optional and 
depend on your organization’s business practices. 

To close a service request:
1. Display the service request in the Service Request window.

2. Select the Workbench tab.

3. If your organization uses resolution codes, then select one using the Resolution 
Code list of values. 

4. If you wish to document how the issue was resolved, then enter a note. See 
Creating a Note for a Service Request on page 9-27

5. If you wish to bill the customer, then complete the charges for the service 
request on the Charge tab. See Creating a Charge Line on page 11-7.

6. Use the Status field LOV to select a status indicating that the service request is 
closed. 

7. Click Save on the toolbar. 

9.25 Indicating You are Not Available to Receive Work
Use this procedure to indicate you are not available to receive new service request 
or task assignments. You must do so whenever you take a long break or go on 
vacation otherwise work may continue to be assigned to you through the automatic 
service request assignment process or by other agents using Oracle Assignment 
Manager. 

Indicating you are not available using this procedure does not affect incoming calls 
when you are working with Oracle Inbound. For incoming calls, you are available 
to take a call whenever you log into a specific work queue and you are not on the 
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phone with a customer. See the Universal Work Queue User Guide for more details on 
how you indicate you are not available to take calls.

To indicate you are not available to receive work:
1. Navigate to any Oracle TeleService window such as the Service Request, 

Contact Center.

2. Select Web Availability from the Tools1 menu.

The Resource Availability window appears.

3. Deselect the Available check box.

4. Click Save on the toolbar.

9.26 Setting Default Values to Speed Up Service Request Creation
Use this procedure to set up system profiles that automatically fill in information 
for you and speed up the process of creating a service request. You can always 
change the default values at the time you create the service request. 

To set up service request defaults:
1. Navigate to Others > Profile System Values

The Find System Profiles window appears.

Note: You must remember to make yourself available again or 
you will not receive any new task or service request assignments.
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2. Select the User and "Profiles with No Values" check boxes.

3. Use the User list of values to enter your user name.

4. To view a subset of the user-definable system profile options, enter a partial 
name in the Profile field. You can use the percent sign (%) to indicate partial 
names. For example, Service% displays all the profile options starting with the 
word Service. For a list of profiles you can set, refer to Profile Options You Can 
Set to Default Information in Service Requests on page 9-60.

5. Click Find.

The System Profile Value window appears listing the results of your search. The 
profiles you can modify are the ones with enabled fields in the User column. 
Profiles that cannot be set at the user level appear gray.

Note: The profile options are not necessarily listed in alphabetical 
order because of varying punctuation.
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6. If you wish to select a default value for a profile, then select a value from the list 
of values in the User field.

7. Click Save.

9.26.1 Profile Options You Can Set to Default Information in Service Requests
The table below lists some of the profile options you can use to automatically fill in 
information into new service requests. The Service Request Field column gives you 
the field you can default and its location. The Profile Option column lists the profile 
option name. The Description column includes information on valid values.

Service Request 
Field Profile Option Description

Assignee 

(Tasks tab)

Service: Default Task Assignee 
on the Service Request Tasks 
Tab

Default for the Assignee, the 
person assigned to complete 
the task.

Assignee Type

(Tasks tab)

Service: Default Assignee Type 
on the Service Request Tasks 
Tab

Default for the Assignee type.

Valid Values: Employee 
Resource, Group Resource, 
Team Resource, Supplier 
Contact

Group

(Service request 
group owner)

Service: Default Group Owner 
for Service Requests

Default for the group owner of 
a service request. This is the 
group responsible for ensuring 
the service request is resolved.
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Item 

(List of values in 
the Item field of 
the Service 
Request window 
header)

Service: Service Request 
Creation Product List Filter

Determines whether the list of 
items in the Item list of values 
includes both items in 
inventory and installed base.

Valid Values: Inventory, 
Instance, All

Make Public

(Service Request 
window header 
check box)

Service: Default Make Public 
Flag

Defaults the check box on the 
service request header and 
determines whether a service 
request is visible to customers 
on their Oracle iSupport Web 
portal. 

Valid Values: Yes, No

Owner Type

(Tasks tab)

Service: Default Owner Type 
on the Service Request Tasks 
Tab

Default for the Owner Type 
field.

Valid values: Employee 
Resource, Group Resource, 
Team Resource, Supplier 
Contact

Owner

(Service request 
owner)

Service: Default Service 
Request Owner

Default value for the service 
request owner.

Owner

(Tasks tab)

Task Manager: Default Task 
Owner

Default task owner.

Valid values: Any valid 
resource from the selected 
Owner Type.

Priority

(Tasks tab)

Task Manager: Default Task 
Priority

Default for task priority.

Severity

(Service Request 
window header)

Service: Default Service 
Request Severity

Default for the service request 
Severity field.

Status

(Service request 
status)

Service: Default Service 
Request Status

Default value for the service 
request Status field.

Status

(Tasks tab)

Task Manager: Default Task 
Status

Default task status.

Service Request 
Field Profile Option Description
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Status

(Workbench tab)

Notes: Default Note Status Sets the default status of new 
notes. Public makes it possible 
for Oracle iSupport users to 
view the note.

Valid values: Private, Public, 
Publish

Default value: None

Type 

(Service request 
type)

Service: Default Service 
Request Type

This profile option provides a 
default value for the Service 
Request Type field.

Type

(Tasks tab)

Task Manager: Default Task 
Type

Default task type.

Type

(Workbench tab)

Service: Default New Note 
Type in Workbench Tab

Default value for note type.

Urgency

(Service Request 
window header)

Service: Default Service 
Request Urgency

Default for the service request 
Urgency field.

Service Request 
Field Profile Option Description
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 Useful Utilities

This section explains the use of utilities available from the Tools and Tools1 menus. 

Topics covered include:

■ Entering Results into an Oracle Quality Plan on page 10-1

■ Sending a Service Request by E-Mail or Fax  on page 10-2

■ Managing Service Request Workflows on page 10-3

■ Viewing an Audit of Changes Made in a Service Request on page 10-4

■ Messaging Using Oracle Workflow on page 10-5

■ Recording Counter Readings on page 10-9

■ Escalating a Service Request on page 10-9

■ Escalating a Service Request Task on page 10-11

■ Speeding Up Access to Other Applications Using the Quick Menu on 
page 10-12

10.1 Entering Results into an Oracle Quality Plan
You can enter results into a Quality Plan directly from a service request.

Prerequisites
You must define a quality plan. 

To enter Oracle Quality results:
1. Navigate to the Service Request window.
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2. Display a service request.

3. From the Tools menu, select Enter Quality Results. 

For additional information please refer to Oracle Quality User’s Guide.

10.2 Faxing or E-Mailing a Service Request
You can send a service request by e-mail or fax using Oracle One-to-One 
Fulfillment. 

Prerequisites
Oracle One-to-One Fulfillment must be implemented. 

To fax or e-mail a copy of a service request:
1. Navigate to the Service Request window. 

2. Create a service request or query an existing service request.

3. From the Tools menu, select Fulfillment Request. 

The Fulfillment Requests window opens.

4. Select either the Email or Fax delivery method. 

5. Enter the e-mail address or fax number.
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6. Click Submit to send the service request to the fulfillment server. 

7. Select the View tab to see the status of your submission. 

10.3 Managing Service Request Workflows
Your application administrator can set up a service request type to automatically 
launch an Oracle Workflow process whenever the service request is created or to 
permit agents to do so manually.

You can tell if a workflow process is running for a service request by checking the 
status of the Active Workflow check box located near the bottom right of the service 
request header. 

If this check box is not visible, you can view the entire header by clicking Maximize 
or Minimize the Header (the right-arrow button on the top right corner of the 
Service Request window).

You can manually launch workflows for service request types that are set up for 
manual launching of workflow processes. See Manually Launching a Service 
Request Workflow on page 10-3.

You can abort any Workflow process already running. See Aborting a Workflow on 
page 10-4.

10.3.1 Manually Launching a Service Request Workflow
You can manually launch or abort an Oracle Workflow process from within a 
service request. 

Prerequisites
The service request type must be set up to permit manual launching.

To launch a Workflow process:
1. Navigate to the Service Request window. 

2. Create a service request or query an existing service request.

3. From Tools menu, select Launch Workflow.

The Caution dialog box appears. 

4. Click OK to start the workflow.
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10.3.2 Aborting an Oracle Workflow Process
Use this procedure to abort a workflow process launched from a service request. 
Application administrators can set up service request types to automatically launch 
Oracle Workflow processes whenever service requests of that type are created or 
permit agents to start them manually.

Prerequisites
The workflow process must be running as indicated by a checked Active Workflow 
check box located near the bottom right of the service request header

To abort a workflow:
1. Navigate to the Service Request window. 

2. Open a service request or create a new service request.

3. From the Tools menu, select Abort Workflow.

4. Click Yes to stop the workflow.

10.4 Viewing the History of Changes Made in a Service Request
You can view the history of changes made to the following service request fields:

■ Owner

■ Type

■ Urgency

■ Severity

The history includes the name of the person who made the change, the date and 
time when it was made, and the value both before and after the change.

To view an audit of changes in a service request:
1. Navigate to the Service Request window.

2. Display an existing service request.

3. From the Tools menu, select Request Audit. 

The Audit History window appears.
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4. Enter the beginning and ending date for the audit in the Duration fields.

5. Select the service request field you want to audit from the Audit field list of 
values.

The window displays the history of changes made to the field. 

10.5 Messaging Using Oracle Workflow
You can send and receive messages regarding a service request using Oracle 
Workflow. For example, you can request a recipient to take an action and require 
him or her to indicate whether the action is accepted, rejected, or completed. You 
can choose to have a confirmation sent to you after the recipient has responded.

This topic overs:

■ Sending a Message on page 10-5

■ Viewing and Responding to Messages on page 10-7 

■ Viewing Message History for a Service Request on page 10-8

10.5.1 Sending a Message
Use this procedure to send a message using Oracle Workflow.
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Prerequisites
Oracle Workflow must be configured before you can send messages.

To send a message:
1. Navigate to the Service Request window.

2. Create a service request or display an existing service request.

3. From the Tools menu, select Send Message. 

The Send Message window appears.

4. Enter the sender’s name in the From field using the list of values.

You can select from all roles defined for use with Oracle Workflow. The default 
value is the Workflow display name of the current user; if the user’s Workflow 
role cannot be determined, the FND user name defaults.

5. Select a priority from the list of values: High, Medium, or Low. Medium is the 
default value. These Priorities are not user-definable and are not related to 
Oracle Workflow notification priorities.

6. Optionally, select an Action from the list of values.

7. Enter the recipient’s name in the To field. The recipient’s name must be defined 
in Oracle Workflow roles.
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8. Check Expand Roles if you plan to send this message to a Workflow role that 
includes several individuals and if you want each person to receive a copy of 
the message.

■ By default (if this box is not checked), one message is sent to the role as a 
whole. If one individual responds to or closes the message, the message is 
removed from the inbox of all other individuals in that role.

■ If you check Confirmation, you will not be able to check Expand Roles.

■ If you entered an Action, you will not be able to check Expand Roles. The 
reason for disabling the Expand Roles function is because you may not 
want all of the recipients to perform the same action. 

9. Optionally, check Confirmation if you want to receive a confirmation message 
once the recipient has responded to your message.

■ If you check Confirmation, the From field is validated to ensure that the 
sender is a valid Workflow role. 

■ If you check Expand Roles, you will not be able to check Confirmation.

10. Enter your message text.

11. Click Send to pass the message to Oracle Workflow for delivery and processing.

The application displays a dialog box informing you that the message was sent 
successfully.

10.5.2 Viewing and Responding to Messages
These messages will also appear in the Universal Work Queue along with other 
Oracle Workflow notifications. They may also appear in your e-mail application, a 
Web page or Oracle Workflow Notification Summary window, based upon your 
Oracle Workflow configuration.

To view and respond to messages:
1. Navigate to Service Requests > Workflow Notifications.

The Worklist page opens in a browse window.

2. Select the message you wish to view.

If the message does not include an action request, you must respond with 
Acknowledge. Otherwise, choose one of the following responses:

■ Accept if you accept the responsibility of performing the requested action.
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■ Reject if you reject the responsibility of performing the requested action.

■ Done if you have completed the action.

3. Optionally enter additional comments, such as your reason for rejecting the 
request.

4. Select OK. A confirmation message will be sent to the original message’s sender 
if and only if the sender checked Confirmation.

10.5.3 Viewing Message History for a Service Request
Use this procedure to view the messages sent about a service request in the message 
history.

To view message history for a service request:
1. Navigate to the Service Request window.

2. Open a service request.

3. From the Tools menu, select View Message.

The Message History window appears, displaying sender, recipient, and response 
information for all messages that were sent concerning the service request.
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10.6 Recording Counter Readings
From within service requests you can update any counters associated with an 
installed base item. You may wish to use this procedure, for example, if your 
organization is servicing a copy machine and you charge the customer based on the 
number of copies that have been made.

Prerequisites
The service request must be for an installed base item that has a counter defined.

To record counter readings:
1. Navigate to the Service Request window.

2. Create a service request or display an existing service request for the installed 
base item.

3. From the Tools menu, select Counter Capture. The Counter Capture window 
opens.

4. Enter the New counter value, miscellaneous reading information or reset the 
counter.

5. Click Save on the toolbar.

10.7 Escalating Service Requests and Tasks
This topic explains how to escalate service requests and tasks. It covers:

■ About Escalations on page 10-9

■ Escalating a Service Request on page 10-10

■ Escalating a Service Request Task on page 10-11

10.7.1 About Escalations
Using the escalation functionality of the Oracle E-Business Suite, you can create an 
escalation document for critical situations involving one or more service requests 
and tasks. The escalation document raises awareness and enables swift action to 
manage and resolve the situation. 

You can assign the document to an owner, and use it to track information related to 
the escalation including additional contacts and all actions taken toward resolution.
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The current escalation level of a service request is displayed in the Escalation field 
on the Service Request window. You must scroll down on the header region of this 
window to view this field. By default, each service request is given the default of 
Not Escalated. Different escalation levels can be color-coded for visibility by your 
application administrator.

When you create or modify an escalation, the application can send notifications to 
different individuals depending on your implementation. The application uses 
Oracle Workflow to process and deliver the notifications. Notifications can be sent 
for the following reasons:

■ Escalation creation

■ Escalation status changes

■ Escalation owner assignment and changes

■ Escalation level changes

Notifications can be sent to a variety of recipients, depending on the system profile 
options set. Typical recipients include:

■ Owner of the service request

■ HR manager of the service request owner

■ Escalation territory member or the primary contact

For more detailed information about using escalation management, see the Oracle 
Common Application Components User’s Guide. For setup information, please see the 
Oracle Common Application Components User’s Guide and the Oracle TeleService 
Implementation Guide.

10.7.2 Escalating a Service Request
Use this procedure to escalate a service request.

To escalate a service request:
1. Create a service request or display an existing service request in the Service 

Request window.

2. From the Tools menu, select Request Escalation. 

The Escalations window opens.

3. The customer and service request information defaults.

4. Select a status code that fits the status of the escalation. 
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5. Select a reason code that describes the reason for the escalation.

6. Date Opened is automatically populated with the current date.

7. Date Closed is automatically populated when the escalation is closed.

8. Optionally, enter a date in Target Date for closing the escalation.

9.  Select the Escalation Level from the list of values.

10. The Escalation Owner is the party responsible for managing the escalation. 
Assign the escalation to a resource using one of these two methods:

■ Select a resource from the list of values.

■ Click Assign to select an escalation owner using the Oracle Assignment 
Manager.

11. Summarize the reason for the escalation in the Escalation Summary field.

12. In the Contacts tab, enter the customer or employee contact who is requesting 
the escalation and check the Requester box. 

13. Optionally enter additional contact points.

14. Optionally add more reference documents to the escalation.

15. Optionally click Notes to create a note about the escalation.

16. Optionally click Tasks to create a task related to managing the escalation.

17. Click Save to assign an escalation number. Notifications are sent based upon 
the escalation management setup and system profile options.

10.7.3 Escalating a Service Request Task
Using the escalation functionality you can create an escalation document for critical 
situations involving one or more tasks in a service request. The escalation document 
raises awareness and enables swift action to manage and resolve the situation. The 
escalation document is assigned to an owner, tracks the business situation 
information, requester, additional contacts, and all actions taken toward resolving 
the situation. The escalation document can also identify or escalate related service 
requests, defects and tasks, as required.

To escalate a service request task:
1. Navigate to the Service Request window.

2. Create a service request or query an existing service request.
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3. Select the Tasks tab.

4. Select the task to escalate.

5. From the Tools menu, select Task Escalation. The Escalations window opens.

The customer and service request information defaults.

6. Select a status code that fits the status of the escalation. 

7. Select a reason code that describes the reason for the escalation.

8. Date Opened is automatically populated with the current date.

9. Date Closed is automatically populated when the escalation is closed.

10. Optionally enter a date in the Target Date field for closing the escalation.

11.  Select the Escalation Level from the list of values.

12. The Escalation Owner is the party responsible for managing the escalation. 
Assign the escalation to a resource using one of these two methods:

■ Select a resource from the list of values.

■ Click Assign to choose an escalation owner using Oracle Assignment 
Manager. 

13. Enter a reason for the escalation in the Escalation Summary field.

14. In the Contacts tab, enter the customer or employee contact who is requesting 
the escalation and select the Requester box. 

15. Optionally enter additional contact points.

16. Optionally add more reference documents to the escalation.

17. Optionally, click Notes to create a note about the escalation.

18. Optionally, click Tasks to create additional tasks related to managing the 
escalation.

10.8 Speeding Up Access to Other Applications Using the Quick Menu
You can use the Quick Menu to navigate to quickly navigate to windows in other 
applications and pass on customer and other information from the current window. 
This saves you from having to change responsibilities and performing queries again 
to display the same information.
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For example, if you are working in a service request for a product a customer owns, 
you can display information about that product from Oracle Install Base with two 
clicks of the mouse.

Only certain Quick Menu-enabled applications preserve the context in the new 
window. Contact your application administrator for more information.

Prerequisites
Your responsibility must enable you to access the application you wish to open.

To access other applications using the Quick Menu:
1. Display a customer in the Contact Center or a service request in the Service 

Request window.

2. From the Tools menu, select Quick Menu.

The Quick Menu window appears.

3. Double-click the desired menu option. A new window opens and, where 
available, defaults in specific information from the customer record or service 
request. 
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Using Charges

This topic group provides process-oriented, task-based procedures for using the 
Charges module of Oracle TeleService to perform essential business tasks. Main 
topics covered include:

■ Overview of Charges on page 11-1

■ Process Overview on page 11-2

■ Charges Functions on page 11-4

■ Creating a Charge Line on page 11-7

■ Viewing the Status of Submitted Orders and Invoices on page 11-16

■ Creating a Return on page 11-16

■ Reviewing and Submitting Field Service Charges for Billing on page 11-27

■ Viewing Pending Charges for Field Service Tasks on page 11-28

■ Viewing the Source of a Charge Line on page 11-29

■ Viewing a Report of Charges for a Service Request on page 11-30

11.1 Overview of Charges
Service organizations that use Oracle Order Management can use Charges to create 
orders, ship products, and bill customers for services provided in response to 
support service requests, field service requests, and depot repairs.

Agents can also use Charges to process customer returns of defective products for 
repair, credit, or replacement. With Charges you can manage customer expectations 
while controlling inventory receipts and processing customer credit.
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Suppose, for example, that a customer logs a service request for a malfunctioning 
computer system. After trying to correct the problem remotely, a technician is 
dispatched to fix the problem on site. The technician replaces some components, 
and finally ascertains that the problem lies with a major subcomponent that cannot 
be fixed in the field. The technician ships the subcomponent back to the repair 
depot for in-house repair, and the subcomponent is repaired and shipped back to 
the customer. At that point, a field engineer is dispatched again to install the 
subcomponent. 

With Charges you can consolidate all labor, material, and expenses incurred during 
remote support, field service, and depot repair into a single order with multiple 
lines. Customers can be billed for labor, materials, and expenses either while a 
service request is being addressed or after one is resolved.

Before you bill customers for services rendered, Charges takes into account and 
correctly applies contractual terms such as discounts and labor rates to arrive at 
final charges for a customer. For example, field engineers enter the start and end 
times for a task and Charges automatically uses the appropriate contract or the 
default time and material labor schedule to calculate how much the customer owes. 
In doing so, Charges takes into account different labor rates, for example, regular 
time, overtime, and double time.

Charges uses Service business processes and Service activity codes to determine the 
impact of each charge line. Examples of such codes include repair, return, material 
transaction, labor transaction, expense transaction, and expense travel. Your 
organization can define an unlimited number of service activity codes.

11.2 Process Overview
The following diagram provides an overview of the Charges process and describes 
the integration of Charges with other modules.
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Charges integrates with Oracle Order Management for returns, shipments, and 
billing through APIs provided by Oracle Quoting - Forms. When you submit an 
order to Oracle Order Management, the application uses the Oracle Quoting - 
Forms APIs to create the order in Oracle Order Management. Oracle Quoting - 
Forms APIs then give you a confirmation number that is displayed in the Order 
Number field of the Order Status subtab. After the invoice cycle is complete, the 
invoice number and the invoice date are also displayed on the Order Status subtab 
in the Invoice Number and Invoice Date fields respectively. If an order line is split in 
Oracle Order Management, then Charges displays the status of the first line only.

Oracle TeleService, Oracle Service Contracts, Oracle Inventory, and Oracle Install 
Base integrate directly with Charges, whereas Oracle Field Service debrief, Oracle 
Advanced Pricing, and Oracle Depot Repair communicate with Charges through 
Charges APIs. Oracle Advanced Pricing communicates with Charges through 
Quoting - Forms APIs.
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11.3 Charges Functions
This section provides an overview of the subtabs and important charges fields and 
functions.

The following table describes the subtabs and various functions in the Charges tab, 
through which you can enter and view charges.

Subtab Name Function

Action View, edit, and enter the activity type and specify quantity for the 
charge line. Activities include, for example, labor, expenses, and 
returns.

Pricing View and adjust pricing information derived from the pricing rules.

Item Instance View and edit information for charge lines related to installed base 
items.

Bill To View and modify billing information. This is defaulted from the 
service request’s Address tab.

Ship To View and modify shipping information. This is defaulted from the 
service request’s Address tab.

Pricing Rules View and edit the information that controls the way an item is 
priced.

Submit Order View and edit additional information for creating an order.

Order Status View information about an order submitted to Oracle Order 
Management.

Source If a charge line originates from an Oracle Field Service debrief or 
from an Oracle Depot Repair repair order, you can view the original 
documents from this tab.
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The following table describes the functions of buttons and check boxes in the 
Charges tab.

The following table describes defaults for items in the Charges tab.

Name of Button or 
Checkbox Function

Auto Generate Pulls in-progress lines from Field Service Debrief. The button 
allows a billing clerk to determine the charges incurred thus far 
on a task that has not yet been completed. The charge lines 
created when this button is selected have a charge line type of 
In-Progress and are only temporary. When the task has been 
completed, these lines are overwritten by the actual charges 
incurred by the customer.

Charges Report Displays a simple Charges report that contains basic 
information about charge lines related to a specific service 
request.

Coverage For the currently selected charge line, allows you to look at the 
coverage that a customer has under a contract that you selected 
for the currently selected charge line using the Contracts 
Coverage window.

OM Interface checkbox Selected by default and causes the charge line to be eligible for 
an order in Order Management. If this box is cleared, then the 
charge will not be created in Order Management as an order. 
when the Submit button is selected.

Rollup checkbox Using this check box agents can group charge lines under the 
generic headings of time, material, or expenses. This way the 
different charge lines for pens and for stationery appear on the 
invoice as expenses and the charge lines for straight time, 
overtime, and time and half appear under the simple heading 
of time. Selecting the Rollup checkbox, substitutes the generic 
inventory item on the customer invoice. The application 
administrator must set this substitution up in the Billing Type 
Attributes setup window. 

Source Opens the current source document shown in the Source 
tabbed page.

Submit Submits to Oracle Order Management all charge lines of type 
Actual that have not yet been submitted and have the OM 
Interface checkbox selected.

Creates orders and order lines and records changes in the 
Oracle Install Base installation details.
 Using Charges 11-5



Charges Functions
Field Default

Billing Currency The Charges API uses the currency derived from the default 
price list to convert the Service Debrief transaction currency 
into the charge line billing currency. This conversion is based 
on the standard conversion rate for the two currencies 
involved.

Business Process This Service business process defaults from the value defined 
in the Service Request Incident Type setup if the Service: 
Charges - Default Business Process from the SR profile is set to 
yes.

Contract Defaults from the contract selected on the service request if the 
Service business process selected on the charge line is covered 
by that contract.

Current Source Document 
and Number

Default from the parent document from which the charge line 
was created: the service request, the repair line, or the field 
service report. They are updatable if the source is not Field 
Service.

Operating Unit Defaults using the rules defined in the Operating Unit Default 
window. The rules are described in the Oracle Service 
Implementation Guide. If the associated editability profile option, 
Service: Allow Charge Operating Unit Update, is selected, then 
you can edit the operating unit in the Charges window.

Original Source Document 
and Number 

Default from the parent document from which the charge line 
was created: the service request, the repair line, or the field 
service report. They are not updatable.

Price List Defaults from the selected contract. If the contract does not 
define a price list, then it is defaulted from the profile Service: 
Charges - Default Price list. If this profile is not set, then the 
price list is not defaulted.

Service Request Type, 
Status, Severity, and Date

Default from the parent service request and are display-only.

Ship To and Bill To 
accounts

Default from the accounts selected on the parent service 
request.

Ship To and Bill To 
addresses 

Default from the addresses selected on the parent service 
request.

Ship To and Bill To 
contacts

Default from the contacts selected on the parent service 
request.

UOM (unit of measure) Defaults from the primary unit of measure for the Inventory 
item selected in the charge line.
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The following table describes the codes used in Charges and other Service 
applications.

11.4 Creating a Charge Line
Use this general procedure to create a charge line in a service request. 

All of the steps required to complete returns for credit, replacement, and repair are 
outlined in Creating a Return  on page 11-16.

Code Description

Billing Type Oracle Inventory item attribute that indicates the type of item, 
including, material, labor, expense, and other user-defined 
types.

Service Business Process Used to group service activity codes to be used for charge and 
contract purposes. On a charge line, after the Service business 
process has been selected, the Service Activity Codes LOV is 
limited to those types that are associated with the selected 
Service business process. On a contract, a coverage is created 
for a specific Service business process. In this way, you can 
control which service activity codes are covered by a contract. 
The contract LOV on the charge line is limited to those 
contracts that cover the selected Service business process. 
Examples of Service business processes are Field Service, 
Depot Repair, and Customer Support.

Order Management 
Mapping

Each service activity billing type maps to a specific type of 
Order Management order header and order line type. Because 
Order Management header and line types are not used across 
operating units, the Charges setup process allows a unique 
header and line type to be associated with a Service activity 
billing type for each operating unit. These are retrieved and 
used when orders are created in Oracle Order Management.

Service Activity Indicates what the charge line is for. For example, return, 
installation, removal, or preventative maintenance.

Note: Different entries are required for creating a charge line for a 
physical item, such as return or a replacement, or for the billing of a 
customer for time, material, and expenses.
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Prerequisites
You must create a service request before you can create a charge against it. 

To create a charge:
1. Display the service request in the service request window.

The Service Request window appears.

2. Select the Charges tab.

3. Select the Action subtab.
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4. View or edit the following fields:

■ Line

Read-only charge line number

■ Charge Line Type

Defaulted to Actual. Do not change this setting unless you are preparing an 
estimate that requires customer approval. (Any charge line you set to 
Estimate is not submitted to Oracle Order Management and does not 
appear on the customer’s invoice.)

■ Operating Unit

Defaulted to the organization which recognizes the debit or credit from this 
charge line. The organizations you can select from are specified by the 
application administrator.

■ Business Process

Defaulted by the service request type. The business process determines 
which contracts apply and the level of coverage a customer may receive. 
For example, a customer may have a service agreement that covers labor for 
customer support, but not field service labor. The selection you make here 
determines the list of values (LOV) in the Service Activity field.

■ Service Activity

Enter the purpose of this charge line, for example, Return, Labor, and 
Expenses. The selections are specified by your application administrator.

■ Item Number
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Inventory number of the labor, material, or expenses item. You must make 
an entry in this field even if you are entering a charge line for an installed 
base item a customer is returning. 

■ Revision

Revision code for the inventory item. This field is enabled automatically 
when you enter an inventory item number that is revision controlled.

■ Billing Type

Read-only field that displays an Oracle Inventory item attribute. The type 
can be material, labor, expense, and other user-defined types.

■ UOM

Unit of measure. The value defaulted in this field depends on the item you 
selected.

■ Quantity 

If you are entering a return the quantity must be negative. If the return is 
for an installed base item, the quantity must be -1.

■ Return Reason

This field is enabled only if this line is for a return. Use it to select an 
appropriate return reason code.

5. Select the Item Instance subtab.

6. If you are creating a charge line for an install base item, then you can view or 
enter the item by making a selection using one of the following LOVs:

■ Tag Number

Customer’s own installed base identification number. 
11-10 Oracle TeleService User Guide 



Creating a Charge Line
■ Instance Number

Oracle Install Base or Oracle Enterprise Install Base instance number.

■ Serial Number

Item’s serial number.

The following fields are view-only:

■ Item number

■ Revision

■ Description

7. If you are creating a return, then enter a date by which the customer is 
supposed to return the item in the Return By Date field.

8. Select the Pricing Rules subtab. 

9. View and edit the following:

■ Contract number

Number of the contract which applies to this line. This is defaulted from the 
contract applied to the service request as a whole. You can view the details 
of the contract by clicking Coverage.

■ Coverage

Read-only field detailing what the contract covers.

■ Price list

The price list used to determine the pricing of the item. The value defaults 
from the selected contract. If the contract does not define a price list, then it 
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is defaulted from the profile Service: Charges - Default Price list. If this 
profile is not set, then the price list is not defaulted.

■ Billing Currency

Price list currency.

■ Customer Purchase Order 

Number of the customer purchase order. This number will appear on the 
invoice.

■ Rate Type 

You can choose a rate type for labor items. The Rate Type field is enabled if 
the combination of service activity code and billing type chosen is Labor.

10. Select the Pricing subtab.

Here you can view the list price for the item and modify it. If you do not want 
to charge the customer for this line, then select the No Charge checkbox.

The Line, UOM, Qty, and Billing Currency are defaulted from other tabs.

■ List Price

The price of the item price on the price list entered on the Pricing Rules 
subtab or, for expenses, the currency amount you entered in the Action tab.

■ Override Unit Price

You can use this field to adjust the unit price.

■ Extended Price 

Read-only field that displays the Override Unit Price times the quantity.

■ Contract Discount Amount
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Read-only field that displays the discount from any applicable contract.

■ Net Price

The extended price minus any contract discount. You can adjust this price 
which will be the price to appear on the customer invoice.

11. The billing address for the customer invoice is defaulted from the service 
request Address tab. If you wish to modify the billing address then, select the 
Bill To subtab.

View and edit the following:

■ Bill To Party

Party that is to receive the invoice.

■ Bill To Account

Account that will be debited or credited for the transaction.

■ Bill To Address

Address where the invoice will be sent.

■ Bill To Contact

You can enter a contact here for information only. The contact does not get 
passed to Oracle Order Management.

12. Shipping information for the charge line is defaulted into the Ship To subtab 
from the service request Addresses tab. If you are shipping an item in this 
charge line and wish to view it or select a different address, then select the Ship 
To subtab.
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■ Ship To Party

Party that is to receive the shipment.

■ Ship To Account

Oracle Order Management requires an account number entered in this field 
to recognize the shipping address. The customer is not charged on this 
account.

■ Ship To Address

Address where the item will be sent.

■ Ship To Contact

You can enter a contact here for information only. The contact does not get 
passed to Oracle Order Management.

13. Select the Submit Order subtab.

14. Optionally, select the shipping or receiving warehouse for the charge line. 
Leaving this field blank leaves it up to Oracle Order Management to determine 
the warehouse.
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15. Verify that the OM Interface checkbox is selected if you want this charge line to 
be passed to Oracle Order Management. 

This checkbox is selected by default. If it is not selected, then the charge line will 
be saved as an estimate.

16. Optionally, you can:

■ Simplify customer invoices by grouping all charge lines under the generic 
headings of time, material, or expenses by selecting the Rollup check box. 
This way the different charge lines for pens and for stationery appear on the 
invoice as expenses, for example, and the charge lines for straight time, 
overtime, and time and half appear under the simple heading of time. 
Selecting the Rollup checkbox, substitutes the generic inventory item on the 
customer invoice. Your application administrator must set this substitution 
up in the Billing Type Attributes setup window. See the Oracle TeleService 
Implementation Guide for details.

■ Add the charge line to an existing order by selecting Add to Order 
checkbox and entering the order number in the Order Number field.

If you leave this checkbox unselected, then Charges automatically creates 
one or more orders for the charge lines in this service request. The 
application attempts to create a single order, but this may not be possible if 
you have entered charge lines with different currencies, bill to parties, and 
accounts, for example. 

17. After you have completed adding all of the charge lines for the service request, 
click Submit to submit the order to Oracle Order Management. 

18. In the Order Status subtab, you can view information about the order. This 
includes the order numbers where the different charge lines have been added 
and the status of each order.

Note: You cannot update or resubmit charge lines after they have 
been submitted. Submitted charge lines appear as read-only.

Note: You must use Oracle Order Management to book the order 
as described by Oracle Order Management Users Guide.
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11.5 Viewing the Status of Submitted Orders and Invoices
Use this procedure to view the progress of an order for charge lines that have been 
submitted to Oracle Order Management.

Prerequisites
Orders must be booked within Oracle Order Management before they are 
processed.

To view the status of orders and invoices:
1. Display the service request in the Service Request window.

2. Select the Charges tab.

3. Select the Order Status subtab.

■ The confirmation number is displayed in the Order Number field.

■ The Order Status field displays the status of the order. If an Oracle Order 
Management order line is split, when a part of the order is put on back-order, 
for example, then Charges displays the status of the first line.

■ The invoice number and the invoice date display in the Invoice Number and 
Invoice Date fields respectively. 

11.6 Creating a Return
Oracle TeleService makes it possible for you to create three types of returns:

■ Return for Credit
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A customer wants to return an item and receive credit to their account. See 
Creating a Return for Credit on page 11-17.

■ Return for Replacement:

A customer wants to receive a replacement. See Creating a Return for 
Replacement on page 11-21.

■ Return for Repair:

The item is to be repaired. See Creating a Return for Repair on page 11-27.

11.6.1 Creating a Return for Credit
Use this procedure to create a return for credit. This type of return requires you to 
create just one charge line.

To create a return for credit:
1. Navigate to Service Requests > Create Service Requests. 

2. If you are creating a return for an inventory item, then:

a. Select a customer. You can select a customer by name or by entering a single 
piece of identifying information such as the serial number of an installed 
base item, the customer’s contract number, or the phone number. For 
details on the different service request entry points, see Selecting a 
Customer for a Service Request on page 9-15.

b. Enter the inventory item using the Item or Desc field lists of values. The 
Item LOV lets you search by inventory number; the Desc field by item 
description.

Note: Charges is designed for service-related returns, not as a 
quoting or sales application. It uses the company’s current price list 
rather than the original invoice or sales receipt for calculating 
customer credit. 

Note: If you know of a similar service request, you can speed up 
the creation process by instead making a copy following the 
procedure described in Copying a Service Request  on page 9-13
 Using Charges 11-17



Creating a Return
.

3. If you are creating a return for an item in the customer’s installed base, then:

a. If you know the serial number or the installed base instance number, then 
enter them in the Serial or Instance fields using the LOVs provided. 

b. If you do not know the number you can search for it by clicking the Find 
icon to the right of the item field. For details, see Searching for and 
Displaying Installed Base Items on page 9-21.

4. In the Service Request window header, check to see if the Type, Status, and 
Severity fields display the correct values for the return in your service 
organization. If not, use the lists of values (LOVs) to select them. Contact your 
application administrator for more information about the correct settings for 
your organization.

5. Select the Workbench tab and enter a summary of the customer problem in the 
Problem Summary field.

6. Save the service request by clicking Save in the toolbar.

7. Optionally, check to see if the product is still covered under a contract and the 
customer can return it. See Checking a Customer’s Contract Coverage on 
page 9-19 for details.

8. Select the Charges tab.

9. Select the Action subtab.

10. Optionally, change any of the following defaulted fields:

■ Charge Line Type

Do not change the default Actual setting unless you are preparing an 
estimate that requires customer approval. (Any charge line you set to 
Estimate does not appear on the customer invoice.)

■ Operating Unit

The organization which recognizes the debit from this transaction.

■ Business Process

Defaulted by the service request type. The business process determines 
which contracts apply and the level of coverage a customer may receive. 

Note: You must re-enter the item number again on the Charges 
tab later in this procedure.
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For example, a customer may have a service agreement that covers labor for 
customer support, but not field service labor. The selection you make here 
determines the list of values (LOV) in the Service Activity field.

11. Using the Service Activity LOV, specify what the purpose of the charge line (for 
example: Return for Credit). The values in this LOV are determined by the 
application administrator.

12. In Item Number, enter the inventory item number for the item being returned. 
You must do so even if you are creating the return for an item in the customer’s 
installed base.

Rev (Revision), Billing Type, and UOM (Unit of Measure) fields are populated 
automatically.

13. Enter the quantity of the item being returned as a negative number. If the item 
is tracked by the installed base then this quantity must be -1.

14. Select the Pricing subtab.

The UOM and Quantity fields are carried over from the Activity tab.

The currency displayed in the Billing Currency field is defaulted from the price 
list and may not represent the currency the customer actually paid in.

The List Price reflects the price as listed on the price list; not necessarily what 
the customer paid for the item.

15. If you wish to adjust the unit price, you can do so by modifying the Override 
Unit Price. 

The Extended Price is the Override Unit Price multiplied by the quantity.

If a contract applies, the contract discount appears in the Contract Discount 
Amount.

The Net Price is the extended price minus the contract discount amount.

16. If you wish to adjust the total amount of credit the customer receives, you can 
do so by modifying the amount in the Net Price field.

17. If the item the customer is returning is registered in Oracle Install Base or Oracle 
Enterprise Install Base, then select the Item Instance tab and enter the item 
using the Instance Number or Tag Number LOVs. 

Note: Entering an install base item does not automatically 
populate the item number in the Action tab.
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18. On the Item Instance subtab, enter a date by which the customer is supposed to 
return the item in the Return By Date field.

19. The application automatically applies the billing address and other billing 
information you entered in the service request’s Address tab. If you wish to 
change it or review it, then select the Bill To subtab. You can make alternate 
selections using the lists of values provided:

■ Bill to Party: this field is defaulted to the customer as it is normally the 
customer who receives credit for the return, but you can select a different 
party using the LOV.

■ Bill to Address: the address where the customer will receive a confirmation.

■ Bill to Contact: an optional contact. Any entry you make here is for 
information only and does not get passed to Oracle Order Management.

20. Select the Submit Order subtab.

21. If you know the warehouse that will receive the return, then use the 
Shipping/Receiving Warehouse LOV to select it.

22. Do not select the Rollup check box as it does not apply to returns.

23. Oracle Order Management automatically adds the charge line to an open order, 
but if you wish to specify a specific order to add this transaction to, then:

a. Select the Add to Order check box.

b. Enter an order number using the Order Number LOV.

24. Make sure the OM Interface check box is selected. This charge line is not sent to 
Oracle Order Management unless this check box is selected.

25. Save your entries by clicking Save on the toolbar. 

26. Enter any additional return items as described above.

27. When you are done entering information about the items the customer wishes 
to return, then click Submit.

28. Select the Order Status subtab.

Note: You can only use Oracle Order Management to modify the 
charge line after you submit it. 
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29. The Order Number field displays the RMA number you can give to the 
customer to use for their equipment return.

30. Use Oracle Order Management to book the order as described by Oracle Order 
Management Users Guide. Booking the order notifies the receiving warehouse to 
expect the return.

31. You can monitor the progress of the return by viewing the status displayed in 
the Line Status field on the Order Status subtab.

11.6.2 Creating a Return for Replacement
Use this procedure to create a return for replacement. This type of return requires 
you to create two charge lines: one for the item being returned and one for the 
replacement item to be shipped. 

Submit only after you have entered both lines. The procedure for creating the first 
charge line is very similar to the procedure for creating a return for credit.

To create a return for replacement:
1. Navigate to Service Requests > Create Service Requests. 

2. If you are creating a return for an inventory item, then:

a. Select a customer in the Service Request window header. You can select a 
customer by name or by entering a single piece of identifying information 
such as the serial number of an installed base item, the customer’s contract 
number, or the phone number. For details on the different service request 
entry points, see Selecting a Customer for a Service Request on page 9-15.

b. Enter the inventory item using the Item or Desc field lists of values. The 
Item LOV lets you search by inventory number; the Desc field by item 
description.

Note: If you know of a similar service request, you can speed up 
the creation process by instead making a copy following the 
procedure described in Copying a Service Request  on page 9-13

Note: You must re-enter the item number again on the Charges 
tab later in this procedure.
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3. If you are creating a return for an item in the customer’s installed base, then:

a. If you know the serial number or the installed base instance number, then 
enter them in the Serial or Instance fields using the LOVs provided. 

b. If you do not know the number you can search for it by clicking the Find 
icon to the right of the item field. For details, see Searching for and 
Displaying Installed Base Items on page 9-21.

4. In the Service Request window header, check to see if the Type, Status, and 
Severity fields display the correct values for the return in your service 
organization. If not, use the lists of values (LOVs) to select them. Contact your 
application administrator for more information about the correct settings for 
your organization.

5. Select the Workbench tab and enter a summary of the customer problem in the 
Problem Summary field.

6. Save the service request by clicking Save in the toolbar.

7. Optionally, check to see if the product is still covered under a warranty or 
contract and the customer can return it. See Checking a Customer’s Contract 
Coverage on page 9-19 for details.

8. Select the Charges tab.

9. Create the first charge line for the return as described in Creating a Charge Line 
for the Return  on page 11-23.

10. Create the second charge line for the replacement as described in Creating the 
Charge Line for a Replacement on page 11-25.

11. When you are done entering information about the items the customer wishes 
to return, then click Submit.

12. Select the Order Status subtab.

13. The Order Number field displays the RMA number you can give to the 
customer to use for their equipment return.

14. Use Oracle Order Management to book the order as described by Oracle Order 
Management Users Guide. Booking the order notifies the receiving warehouse to 
expect the return and the shipping warehouse to send out the replacement.

Note: You can only use Oracle Order Management to modify the 
charge line after you submit it. 
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15. You can monitor the progress of the return by viewing the status displayed in 
the Line Status field on the Order Status subtab.

11.6.2.1 Creating a Charge Line for the Return
Use this procedure to create the charge line for the equipment the customer is 
returning.

To create a charge line for the return:
1. Select the Action subtab.

2. Optionally, change any of the following defaulted fields:

■ Charge Line Type

Defaulted to Actual. Do not change this setting unless you are preparing an 
estimate that requires customer approval. (Any charge line you set to 
Estimate does not appear on the customer invoice.)

■ Operating Unit

Defaulted to the organization which recognizes the debit from this 
transaction. This values is specified by the application administrator.

■ Business Process

Defaulted by the service request type. The business process determines 
which contracts apply and the level of coverage a customer may receive. 
For example, a customer may have a service agreement that covers labor for 
customer support, but not field service labor. The selection you make here 
determines the list of values (LOV) in the Service Activity field.

3. Using the Service Activity LOV, specify what the purpose of the charge (for 
example: Return for Replacement). The values in this LOV are determined by 
the application administrator.

4. Enter the inventory item number for the item being returned. You must do so 
even if you are creating the charge line for an item in the customer’s installed 
base.

Rev (Revision), Billing Type, and UOM (Unit of Measure) fields are populated 
automatically.

5. Enter the quantity of the item being returned as a negative number. If the item 
is tracked by the installed base or serialized then this quantity must be -1.

6. Select the Pricing subtab.
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The UOM and Quantity fields are carried over from the Activity tab.

The currency displayed in the Billing Currency field is defaulted from the price 
list and may not be the same as the currency the customer used in payment.

The List Price reflects the price as listed on the price list; not necessarily what 
the customer paid for the item.

7. If you wish to adjust the unit price, you can do so by modifying the Override 
Unit Price. 

The Extended Price is the Override Unit Price multiplied by the quantity.

If a contract applies, the contract discount appears in the Contract Discount 
Amount.

The Net Price is the extended price minus the contract discount amount.

8. If you wish to adjust the total price or the amount of credit the customer 
receives, you can do so by modifying the amount in the Net Price field.

9. If the item the customer is returning is registered in Oracle Install Base or Oracle 
Enterprise Install Base, then select the Item Instance tab and enter the item 
using the Instance Number or Tag Number LOVs. 

10. On the Item Instance subtab, enter a date by which the customer is supposed to 
return the item in the Return By Date field.

11. The application automatically applies the billing address and other billing 
information you entered in the service request’s Address tab. If you wish to 
change it or review it, then select the Bill To subtab. You can make alternate 
selections using the lists of values provided:

■ Bill to Party: this field is defaulted to the customer as it is normally the 
customer who is responsible for payment or receives credit for the return, 
but you can select a different party.

■ Bill to Address: The billing address.

■ Bill to Contact: An optional contact. Any entry you make here is for 
information only and does not get passed to Oracle Order Management.

12. Select the Submit Order subtab.

Note: Entering an install base item does not automatically 
populate the item number in the Action tab.
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13. If you know the warehouse that will receive the return, then use the 
Shipping/Receiving Warehouse LOV to select it.

14. Do not select the Rollup check box as it does not apply to returns.

15. The application automatically adds the charge line to an open order, but if you 
wish to specify an order to add this transaction to, then:

a. Select the Add to Order check box.

b. Enter an order number using the Order Number LOV.

16. Make sure the OM Interface check box is selected. The charge line is not sent to 
Oracle Order Management unless it is.

17. Save your entries by clicking Save on the toolbar. 

18. You are now ready to enter the item you are sending out as a replacement. See 
Creating the Charge Line for a Replacement on page 11-25.

11.6.2.2 Creating the Charge Line for the Replacement
Use this procedure to create the charge line for the replacement unit the customer is 
to receive.

To create the charge line for the replacement:
1. Select the Action subtab.

2. Optionally, change any of the following defaulted fields:

■ Charge Line Type

Defaulted to Actual. Do not change this setting unless you are preparing an 
estimate that requires customer approval. (Any charge line you set to 
Estimate does not appear on the customer invoice.)

■ Operating Unit

Defaulted to the organization which recognizes the debit or credit from this 
transaction. The available values are specified by the application 
administrator.

■ Business Process

Defaulted by the service request type. The business process determines 
which contracts apply and the level of coverage a customer may receive. 
For example, a customer may have a service agreement that covers labor for 
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customer support, but not field service labor. The selection you make here 
determines the list of values (LOV) in the Service Activity field.

3. Using the Service Activity LOV, specify what the purpose of the charge line (for 
example: Replacement). The values in this LOV are determined by the 
application administrator.

4. Enter the inventory item number for the item being shipped out as a 
replacement.

Rev (Revision), Billing Type, and UOM (Unit of Measure) fields are populated 
automatically.

5. Enter the quantity of the item being shipped as a positive number.

6. Select the Pricing subtab.

The UOM and Quantity fields are carried over from the Activity tab.

The currency displayed in the Billing Currency field is defaulted from the price 
list.

The List Price reflects the price as listed on the price list.

7. If you wish to adjust the unit price, you can do so by modifying the Override 
Unit Price. 

The Extended Price is the Override Unit Price multiplied by the quantity.

If a contract applies, the contract discount appears in the Contract Discount 
Amount.

The Net Price is the extended price minus the contract discount amount.

8. If you wish to adjust the total price, you can do so by modifying the amount in 
the Net Price field.

9. The application automatically applies the billing address and other billing 
information you entered in the service request’s Address tab. If you wish to 
change it or review it, then select the Bill To subtab. You can make alternate 
selections using the lists of values provided:

■ Bill To Party: normally it is the customer who is responsible for payment or 
receives credit for the return, but you can select a different party.

■ Bill To Address: The billing address.

■ Bill To Contact: An optional contact. Any entry you make here is for 
information only and does not get passed to Oracle Order Management.
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10. The application automatically copies the shipping address and other shipping 
information you entered in the service request’s Address tab. If you wish to 
change it or review it, then select the Ship To subtab and use the LOVs provided 
for updates:

■ Ship To Party: Normally it is the customer who is responsible for paying the 
shipping, but you can select a different party.

■ Ship To Address: The shipping address.

■ Ship To Contact: An optional contact. Any entry you make here is for 
information only and does not get passed to Oracle Order Management.

11. Select the Submit Order subtab.

12. If you know the warehouse that will do the shipping, then use the 
Shipping/Receiving Warehouse LOV to select it. Leaving this field blank lets 
Oracle Order Management choose the warehouse for you.

13. Do not select the Rollup check box as it does not apply to returns.

14. Oracle Order Management automatically adds the charge line to an open order, 
but if you wish to specify an order to add this transaction to, then:

a. Select the Add to Order check box.

b. Enter an order number using the Order Number LOV.

15. Make sure the OM Interface check box is selected. The charge line is not sent to 
Oracle Order Management unless it is.

16. You are now ready to complete the return as described in Creating a Return for 
Replacement on page 11-21.

11.6.3 Creating a Return for Repair 
To create a return for repair follow the procedure described in Creating a Return for 
Credit on page 11-17, but on the Pricing tab, select the No Charge check box. This 
sets the price to zero as the customer does not want credit for the return. The rest of 
the return for repair procedure is carried out in Oracle Depot Repair. See the Oracle 
Depot Repair User Guide for details.

11.7 Reviewing and Submitting Field Service Charges for Billing
Use this procedure to charge customers for field service tasks that have been 
debriefed and closed. This is a required step for customers to get billed for work 
 Using Charges 11-27



Viewing Pending Charges for Field Service Tasks
completed in the field. Depot charges do not require you to submit them as they are 
submitted automatically.

You cannot update or resubmit charge lines after they have been submitted. 
Submitted charge lines appear as read-only.

Prerequisites
Field service engineers must complete the debrief and close the tasks.

To review and submit field service charges for billing:
1. Display the service request in the Service Request window. See Displaying a 

Service Request for You to Work On on page 9-5 for details.

2. Select the Charges tab.

3. Review the charge lines displayed on the subtabs. If you wish to view the 
original debrief document for any charge line, then

4. Click Submit.

5. Select the Order Status subtab.

6. The Order Number field displays the reference number you can give to your 
customer.

7. Use Oracle Order Management to bill the customer as described by Oracle Order 
Management Users Guide. 

11.8 Viewing Pending Charges for Field Service Tasks
Use this procedure to view pending charges for service request tasks that have been 
entered by field service agents but not yet closed.

Prerequisites
Field service engineers must complete the debrief for the tasks.

To view pending charges:
1. Display the service request in the Service Request window. See Displaying a 

Service Request for You to Work On on page 9-5 for details.

2. Select the Charges tab.

3. Click Auto Generate.
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The application displays information on pending charges for all tasks with an in 
progress status. These are tasks that have been debriefed but not yet closed.

11.9 Viewing the Source of a Charge Line
If a charge line originates form a Oracle Field Service debrief or from an Oracle 
Depot Repair repair order, you can use this procedure to view the original 
documents.

Prerequisites
You must be logged in under a responsibility that permits you to view the source 
documents.

To view the source of a charge line:
1. Display the service request in the service request window.

2. Select the Charges tab and the Source subtab. 

3. Select the charge line.

4. If the charge line is for a repair, then the Original Source Doc field displays 
Service Request or Depot Repair, depending on where application the charge 
line was created.

If the RMA or shipment line was created in Depot Repair, then click Source to 
display the depot repair order.

If the RMA or shipment line was created in Charges, then:

a. Select Depot Repair using the Current Source Doc list of values (LOV).

b. Select the depot repair number using the Current Source Number LOV.
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c. Click Source to display the depot repair order.

5. If the charge line was created through an Oracle Field Service debrief, then click 
Source to display the debrief.

The Original Source Doc displays Service Request and Current Source Doc 
displays Service Debrief. The number of the debrief document appears in the 
Current Source Number field.

11.10 Viewing a Report of Charges for a Service Request
Use this procedure to view a report of charges for a service request in a browser 
window.

To view a charges report:
1. Display the service request in the Service Request window. See Displaying a 

Service Request for You to Work On on page 9-5 for details.

2. Select the Charges tab.

3. Click Charges Report.

The application displays a report of all the current charges for a service request 
in a browser window.
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Useful Interface Tools

This appendix briefly describes a couple of useful Oracle Forms interface features 
designed to help you improve the efficiency of your work. For complete 
information on using the Oracle Forms interface please see the Oracle Applications 
User’s Guide. 

This appendix covers:

■ Manipulating Data in Your Work Queue and Other Dynamic Tables on 
page A-1

■ About Customizing the Presentation of Data Using Folders on page A-5

A.1 Manipulating Data in Your Work Queue and Other Dynamic Tables
Dynamic tables provide flexibility in displaying and handling data. Use them to 
track, sort, search, copy, and export data, and customize your display.

You can perform the following tasks in your Work Queue and other dynamic tables:

■ Section A.1.1, "Sorting Information in Dynamic Tables"

■ Section A.1.2, "Finding Information in Dynamic Tables"

■ Section A.1.3, "Copying Data from Dynamic Tables"

■ Section A.1.4, "Refreshing Data in Dynamic Tables"

■ Section A.1.5, "Customizing the Layout of Your Work Queue and Other 
Dynamic Tables"
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A.1.1 Sorting Information in Dynamic Tables
Use this procedure to sort work in your work queue and other tables within Oracle 
TeleService.

Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

Steps
1. If you want to sort on a field in the table, click the grey dot in the column 

header.

The blue arrow that replaces the grey dot indicates a direction of order, for 
example, ascending, descending, alphabetical, or chronological order.

2. You can sort in the opposite direction by clicking the header arrow again.

A.1.2 Finding Information in Dynamic Tables
Use this procedure to find information in your Work Queue and other dynamic 
tables in Oracle TeleService.

Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

To find information in dynamic tables:
1. Right-click any cell in the table.

2. Select Find in Table from the pop-up menu.

3. Type the characters want to search on into the text field. 

4. Indicate whether to match case, and select the direction of the search, backward 
or forward.

5. Click Find.

6. You can click Cancel to stop a long running search.
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A.1.3 Copying Data from Dynamic Tables
Use this procedure to copy a cell, selected rows, or all rows of data displayed in a 
dynamic table to the clipboard. You can then paste the data as tab-delimited text 
into a desktop application.

 Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

To copy information:
1. Select the data you want to copy.

2. Right-click any cell in the table.

3. From the pop-up menu, choose the appropriate option.

When you insert the copied selection into a spreadsheet application, such as 
Microsoft Excel, the appropriate headers automatically migrate with the 
selection and appear as its first row. Rows are copied in a tab-delimited format.

Guidelines
Cells that display values as check marks or an X, display differently when copied 
and exported. Positive values are expressed as asterisks (*) and negative values do 
not display.

If you have customized your table to hide columns of data, these are not copied or 
exported. 

A.1.4 Refreshing Data in Dynamic Tables
Use this procedure to refresh the data in a table. You will need to do this if you 
think new entries were created in a different window while you have the table 
open.

Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

To refresh table data:
1. Right-click in the table.
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The table refreshes to reflect the latest information.

A.1.5 Customizing the Layout of Your Work Queue and Other Dynamic Tables
Use this procedure to adjust the layout of your Work Queue and other tables to 
accommodate your needs.

Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

To customize table layout:
1. You can resize any column or row by placing your cursor at the edge of the 

header. When the double arrow appears, you can drag the column or row to the 
desired size.

2. If you want to change the order the columns, then:

a. In a header, left-click and hold the mouse key down until a black box 
appears around the header. 

b. Move the header to the selected position. Allow for a delay before making 
the move.

3. If you want to hide a column from view, then:

a. Right-click the header of the column you want to hide.

b. Select Hide Column on the pop-up menu.

4. If you want to display columns which are hidden, then:

a. Right-click any column header.

b. Choose Show Column from the pop-up menu.

A list of all currently hidden columns appears. 

c. Select all or only those columns you want to display.

5. To preserve changes you make to the table layout:

a.  Right-click a column header. 

Note: Hidden information is not copied to the clipboard.
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b. From the pop-up menu, choose Customizations.

c. From the submenu, choose Save.

6. If you want to restore default settings:

a. Right-click a column header. 

b. From the pop-up menu, choose Customizations

c. From the submenu, choose Clear.

A.2 About Customizing the Presentation of Data Using Folders
You can customize the presentation of data in any window displaying a folder icon 
such as the Contact Center using standard Oracle Forms folder tools. 

For example: 

■ To hide a field: Click with the right button of your mouse in the field and 
choose Folder > Hide Field from the pop-up menu. 

■ To show a hidden field: Click the right mouse button in the field directly above 
the place where you wish to display the extra field and choose Folder > Show 
Field.

■ To move a field: Click the right mouse button in the field you wish to move and 
choose one of the following commands: Folder > Move Right, Folder > Move 
Left, Folder > Move Up, or Folder > Move Down.

You can save the custom layouts you create.

See the Customizing the Presentation of Data chapter in the Oracle Applications 
User’s Guide for detailed instructions on how to use folder tools.

Note: The Show Field command places the new field directly 
below the cursor. You must therefore ensure there is enough blank 
space for the new field to display so it does not overlap and hide 
any fields which may appear below. You can do this by moving the 
other fields using one of the move commands. 
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